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Warranty

Tektronix warrants that the media on which this software product is furnished and the encoding of the programs on
the media will be free from defects in materials and workmanship for a period of three (3) months from the date of
shipment. If any such medium or encoding proves defective during the warranty period, Tektronix will provide
a replacement in exchange for the defective medium. Except as to the media on which this software product is
furnished, this software product is provided “as is” without warranty of any kind, either express or implied.
Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements
or that the operation of the programs will be uninterrupted or error-free.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration
of the warranty period. If Tektronix is unable to provide a replacement that is free from defects in materials and
workmanship within a reasonable time thereafter, Customer may terminate the license for this software product
and return this software product and any associated materials for credit or refund.

THIS WARRANTY IS GIVEN BY TEKTRONIX WITH RESPECT TO THE PRODUCT IN LIEU OF ANY
OTHER WARRANTIES, EXPRESS OR IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
TEKTRONIX’ RESPONSIBILITY TO REPLACE DEFECTIVE MEDIA OR REFUND CUSTOMER’S
PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR BREACH
OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY INDIRECT,
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER TEKTRONIX
OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to
this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system.
Read the safety sections of the other component manuals for warnings and
cautions related to operating the system.

To Avoid Fire or Personal
Injury

Use Proper Power Cord. Use only the power cord specified for this product and
certified for the country of use.

Connect and Disconnect Properly. Do not connect or disconnect probes or test
leads while they are connected to a voltage source.

Ground the Product. This product is grounded through the grounding conductor
of the power cord. To avoid electric shock, the grounding conductor must be
connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings
and markings on the product. Consult the product manual for further ratings
information before making connections to the product.

Do not apply a potential to any terminal, including the common terminal, that
exceeds the maximum rating of that terminal.

Power Disconnect. The power cord disconnects the product from the power source.
Do not block the power cord; it must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels
removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this
product, have it inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components
when power is present.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Wear Eye Protection. Wear eye protection if exposure to high-intensity rays or
laser radiation exists.
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General Safety Summary

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.

Provide Proper Ventilation. Refer to the manual’s installation instructions for
details on installing the product so it has proper ventilation.

Terms in this Manual These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result
in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in
damage to this product or other property.
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Preface
The MTS400 Series MPEG systems applications are described in three user
manuals. The full list of applications can be found in the MTS400 Series Quick
Start User Manual. This manual describes the analysis related applications. All
applications are available on the following MTS400 Series products:

MTS415

MTS430

MTS4SA

MTS400P

MTX100B (where installed)

Table i: Overview of MTS400 Series analyzer applications
Application Desktop Icon
Transport Stream Compliance Analyzer (TSCA) Real-time and deferred transport stream analysis with
user-selectable MPEG-2, DVB, ATSC and ISDB conformance tests. Shows transport structure, header
contents, hexadecimal packet contents, PCR timing /transport rate graphs and error message logs.

Packetized Elementary Stream (PES) Analyzer PES analysis with selectable test options. Shows PES
program structure, header contents, packet contents, PTS/DTS timing graphs and analysis reports.

Transport Stream - System Target Decoder (T-STD) Buffer Analyzer Analyzes program streams modeling
their behavior in, and their conformance to, the MPEG-2 T-STD Buffer Model. Includes a trace facility.

Elementary Stream Analyzer Elementary Stream analysis at video picture and audio level. This includes
vector graphs and macroblock picture quality.
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Preface

Related Documentation
The following table lists the documentation available for your MTS400 Series
instrument:

Table ii: MTS400 Series related documentation
Title Tektronix part number Location
MTS400 Series Quick Start User
Manual English and Japanese

071-2607-xx
071-2608-xx

MTS400 Series Analyzer
Application User Manual (This
manual)

077-0205-xx

MTS400 Series Generator
Applications User Manual

077-0204-xx

MTS400 Series Carousel
Applications User Manual

077-0203-xx

MTS400 Series Programmer
Manual

077-0206-xx

MTS400 Series Release Notes 077-0200-xx

MTS4EA Compressed Video
Elementary Stream Analyzer User
Manual

071-1641-xx

MTS4CC Elementary Stream
Compliance Checker User Manual

071-2075-xx

MTS400P Quick Start User Manual
English Japanese

071-2610-xx
071-2611-xx
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Transport Stream Compliance Analyzer - Getting Started
The MTS400 Series MPEG Transport Stream Compliance Analyzer (TSCA)
enables you to monitor and interpret the contents of real-time, previously
recorded, or synthesized transport streams using the latest MPEG, DVB, ATSC,
and ISDB standards.

The TSCA is specifically designed to enable you to quickly locate and identify
problems within a transport stream using a minimum number of clicks. By
quickly identifying the problem areas, the TSCA software helps you save time
during the development and test of equipment, networks, and services. You can
configure the TSCA software to display stream information in user-selected fonts.
This feature enables you to view stream information in your local language or to
use custom fonts.

The TSCA software will run stand-alone on computers with Microsoft Windows
2000 or Windows XP operating systems.

Figure 1-1: TSCA Program view - Deferred analysis

MTS400 Series Analyzer Applications User Manual 1–1



Transport Stream Compliance Analyzer - Getting Started

TSCA Features
Industry’s fastest analysis engine enables reduced analysis time, rapid
development, evaluation, deployment, and diagnostics of next generation
DTV and IPTV systems and services

Support for a wide range of DTV standards, including MPEG, DVB, ATSC,
including A78 and SCTE 142, ISDB, and ISDB-TB (Brazil). Specific service
information (SI) for terrestrial, cable, and satellite, plus regional variations of
these standards are also supported

A range of interfaces and analysis capabilities provide the necessary
connectivity to diagnose problems anywhere in the network environment,
whether that is in transmission links (RF or IP layer) or content processing
(TS layer)

Connection to both IP version 4 and 6 networks, including those using IGMP
and MLD multicast protocols respectively (IP version 6 is only available with
the IP Video Gigabit Ethernet interface)

Constant and variable bit rate stream analysis (CBR and VBR)

CaptureVu technology captures and analyzes system events in real time and
deferred time to debug the intermittent and complex problems that traditional
analyzers miss

Innovative program-centric user interface brings expert power to the novice
user

File Analysis and Real-Time Modes
The TSCA can be run in offline (or deferred) File Analysis or Real-Time Analysis
mode.

The offline File Analysis mode is available on any recommended platform
(including the your own PC). In offline File Analysis mode, a static stream can be
analyzed and displayed; the content can then be inspected at leisure.

The Real-time Analysis mode, with which a live stream can be analyzed, is
available when the TSCA is installed on a Tektronix MTS400 Series instrument or
an MTX100B with an Option 7 interface card. Real-time streams can be paused
for detailed offline analysis and then when the issue has been found, real-time
analysis can be resumed. Real-time monitoring of Video over IP (internet
protocol) is also available as a standalone application on a your own PC.
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Transport Stream Compliance Analyzer - Getting Started

Technical Background
The analyzer has a client-server architecture. Every time the analyzer opens, it
starts two processes: tsca.exe, which is the client, and MpegCore.exe, which is the
MPEG analysis engine. Additionally, when the analyzer opens for the first time,
another single process, CoreManager.exe, is started. CoreManager.exe forms an
intermediary between TSCA clients and MPEG cores.

The tsca.exe, MpegCore.exe, and CoreManager.exe processes use SNMP (Simple
Network Management Protocol) and HTTP (Hypertext Transfer Protocol) to
communicate. The port numbers used for communication are read from a
configuration file, CoreInfo.xml. In a default installation, the path to the file is
C:\program files\tektronix\mpeg\mts400\apps\tsca\xml\. The
default port range is 15700-15800. You can change these values if they conflict
with other applications.

On the MTS400 platform, another process, mint.exe, runs from system startup.
This process controls shared access to the MTS400 Series hardware by the
analyzer and player.

You must have local administrator rights to be able to use IP analysis. If you need
to change your rights, please consult your system administrator.

User Interface
The TSCA software displays two primary views selected using tabs: FlexVuPlus
and Analysis.

Using the FlexVuPlus window, you can assemble up to four views that you select
from the Analysis window. This allows you to customize the view by selecting
the views that are most relevant to the analysis task. The FlexVuPlus window is
described in detail in the MTS400 Series Quick Start User Manual.

The Analysis window uses a single main program summary window with different
context sensitive views contained within tabbed frames. This provides the
maximum amount of useful information, while keeping the screen from appearing
cluttered. From the main window, you can access the following views: Program,
Tests, Tables,PID, Packets, and Interface.

Program View The Program view provides a fast overview of the transport stream contents
in terms of program content, bit rate use by each program, and TR 101 290
test results. Red, amber, and green LEDs highlight errors associated with each
program, or element of a program, within the transport stream. Red LEDs indicate
that there are current errors in the stream, amber LEDs indicate that errors have
occurred but are now clear, and green LEDs indicate that no errors have been
detected.
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Errors that are detected at lower levels in the program stream hierarchy propagate
up to the highest level. This allows you to monitor all of the programs in the
stream at a high level and then quickly go to lower levels as necessary to locate a
problem.

Tests View The Tests view enables you to isolate errors to the specific tests that have been
applied to the transport stream. The error log is automatically filtered by the
selected test, and can also be filtered by Packet Identifier (PID). In addition to the
standard first, second, and third priority tests included in TR 101 290 standard,
tests are available for Program Clock Reference (PCR) jitter and program/PID bit
rate. A variability test enables you to test the changes in the bit rate of a specific
PID, and there are many tests that are specific to ISDB-T and ISDB-S streams.

SI/PSI (Tables) View The SI/PSI (Tables) view displays the service information tables that have
occurred in the analyzed stream that comply with the selected digital video
standard. This includes MPEG-specific program information, DVB service
information, and ATSC, ISDB program, and system protocol information. The
tables are grouped together by function and hyperlinks enable you to quickly
access related information within other tables.

PID View The PID view displays information about all of the PIDs found in the transport
stream. When you select the transport stream, the associated summary view
provides a PID-oriented overview of the transport stream, displaying the relative
data rates of all of the PIDs contained within the stream. The information can be
displayed as either a bar chart or as a pie chart. Pop-up menus enable fast limit
selection and links.

Each PID is associated with a number of tests. When one or more tests fail, each
failed test will be listed under the relevant PID. Select a specific PID to display
a summary of all the associated tests. Select a specific test to display the Event
Log and Parameters for only that test.

Packets View The Packets view displays information about all of the packets found in the
transport stream grouped according to content. These groups include PID value,
SFN mega-initialization packets (MIPs) (DVB only), and ISDB-T and ISDB-TB
information packets (IIPs). When you select a specific PID or MIP, only packets
carrying that particular PID or MIP are displayed. A section view is also available.
Deferred analysis of PCAP files allows you to see the ethernet packets.

The Packets view is not available in real-time mode. However, you can examine
packets in a real-time stream by using the CaptureVu feature.
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Interface View The Interface view provides a central location for information related to the RF
and IP interface cards (where installed).

Test results

Graphical representation of specific RF and IP readings

RF and IP readings and control settings

The graphical views display a selection of graphs of instantaneous measurements
and measurement trends. Also available are an Event Log and a Parameter view.

The Interface tab is displayed only when an interface is installed.

CaptureVu Feature
The CaptureVu feature captures a snapshot of system events in real and deferred
time, and allows you to debug the intermittent and complex problems that
traditional analyzers miss. You can initiate CaptureVu either manually or
automatically by associating a CaptureVu Breakpoint with any test event. When a
breakpoint is detected, either manual or automatic, the stream is paused and an
in-depth deferred time analysis can be performed on stored data. This powerful
debug mode enables fast debugging of troublesome intermittent problems.

Triggered Recording
During real-time analysis, stream information can only be held for a finite time
- eventually it will be overwritten by more up-to-date information. Triggered
recording allows a portion of a stream to be recorded and subsequently analyzed
in detail.

The following trigger sources and conditions apply:

Any test event

External input; (TTL) edge specifiable

Date and time

Recorded file size can be specified

Pretrigger buffer size can be specified as a percentage of the overall file size
range from 0 - 100%
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Starting the TSCA Software
The TSCA can analyze transport streams in either real-time or file analysis mode.

Opening the TSCA From the Windows Desktop, select Start > Programs > Tektronix MTS400 >
Analyzers > TS Compliance Analyzer.

The TSCA is opened, initially overlaid with either the Open File Analysis or the
Select Real-time Interface dialog box as shown in the following figures. The
application opens the dialog box that was last opened.

Figure 1-2: TSCA Start-up - Offline File Analysis
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Figure 1-3: TSCA Start-up - Real-Time Analysis
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The opening dialog boxes allow you to:

Select the interpretation standard to be used for analysis. See step 2 in the
Interpreting a Stream section. You should always set the stream interpretation
standard before starting analysis.

and

Identify a stream file for off-line analysis. See step 1 in the Off-Line File
Analysis section. Files can be selected either directly from the disk drive or
using shortcuts that you have defined.

or

Identify an input (IP, RF, ASI, SMPTE, or DVB Parallel) receiving a stream
and start real-time analysis See step in the Real Time Analysis section.

Interpreting a Stream You can set up the stream interpretation standard in the following way:

1. Click Change in the opening dialog box to open the Standard dialog box.

NOTE. The TSCA software analyzes streams in strict accordance with the
standards defined by the digital television authorities: DVB (Digital Video
Broadcasting), ATSC (Advanced Television Systems Committee), and ISDB
(Integrated Services Digital Broadcasting).

The TSCA software uses preloaded scripts that establish the expected content and
syntax of the analyzed stream. The analyzer is supplied with a comprehensive
range of scripts, which, in different combinations, can interpret the full range
of digital television standards.

2. Select the Base Standards and then (if available) select the Region. The
analysis scripts that will be used are displayed in the Script Files pane.
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Figure 1-4: Stream Interpretation dialog box

3. Select OK.

4. The stream interpretation is now set. Select OK to close the Standard dialog
box and return to the opening dialog box. (See page 1-148, Script Files.)

NOTE. The selected stream interpretation standard is not implemented until
stream analysis is started. If the Open Transport Stream dialog box is closed
without starting analysis, the stream interpretation settings are lost; they revert to
the settings that were in effect when the application was last closed.

Off-Line File Analysis Perform the following steps to start analyzing a transport stream file:

1. In the Open File Analysis dialog box, browse to a transport stream file.

If necessary, select a file type from the Files of type drop-down list. Currently,
two types are available: MPEG Transport Stream files and PCAP files.

MPEG transport stream files contain interlinked tables and coded
identifiers, which separate the programs and the elementary streams
within the programs.

PCAP files contain raw packets of network data. A PCAP may contain
more than one session. You will need to select a session using the Browse
dialog box.

2. When you select a stream, the stream name appears in the File Name field at
the bottom of the window.
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Figure 1-5: TSCA Open File Analysis (Offline) dialog box

3. Calculating the Stream Bit Rate: To analyze a transport stream correctly,
you must do one of the following:

Calculate the bit rate from PCRs (Program Clock Reference) carried in
the stream

NOTE. When the TSCA software analyzes a transport stream, it compares the
bit rate of the stream to the expected rate. Errors are reported based on the
expected rate of the stream. To analyze a stream correctly, it is necessary to
know the original bit rate of the stream or to calculate the bit rate from PCRs
(Program Clock Reference) carried in the stream. PCRs are generated as a
stable clock reference and are added to the stream during its generation.
During analysis, the PCRs are extracted and synchronized with a local clock
reference.

Know the original bit rate and enter it manually

Use timestamps included with the stream
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4. After you select the desired stream, select one of the following methods for
calculating the rate of the transport stream:

Prescan first nnn PCRs. The TSCA software calculates the rate of the
stream by prescanning the stream for embedded PCRs. The entry box lists
the number of PCRs that the TSCA software recommends are necessary
to determine the stream rate. You can use the entry box to enter a different
number.

Prescan all PCRs in a file. The TSCA software calculates the rate of the
stream by prescanning the stream for all of the embedded PCRs.

Manually set nnnn Mbps. The TSCA software uses the absolute value (in
Mbps) that you enter as the expected stream rate.

NOTE. Timestamps, which may be added when the stream is generated, will be
used, if present, and if either of the Use Timestamps check boxes are enabled.
Using timestamps will override the PCR options (Prescan PCRs and Scan entire
file). The manual bit rate setting will override both PCRs and timestamps.

5. If the TSCA software cannot calculate the bit rate from the embedded PCRs,
or timestamps, a message box is displayed. You must enter an estimated bit
rate before the TSCA software can analyze the stream.
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6. If the CaptureVu feature is to be used, the whole file can be captured or
analysis can be paused either by a previously set CaptureVu breakpoint or at a
specific packet.

7. To pause analysis at a specific packet, enable Pause Analysis at Packet
Index and enter a packet number.

With a file selected and the transport rate calculation set up, you can start the
analysis. (See page 1-29, Starting Analysis.)

Real Time Analysis To start analyzing a transport stream received through an IP or a hardware (RF)
interface, select Real-time from the toolbar and, in the Select Real-time Interface
dialog box, select an interface from the Interfaces drop-down list

Only installed interfaces will be shown in the drop-down list. For stand-alone
installations, only the IP interface is available.

Figure 1-6: TSCA Real-time Interface dialog box
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Real-time analysis will not be available if the appropriate software key
permissions are not found. A warning message is displayed when real-time
analysis is not available.

Make any necessary interface settings. Either select and apply a preset (a
predefined set of interface settings) or modify the individual interface settings.
During analysis, the interface selected will be shown in the status bar. (See
page 1-15, Setting Up the IP Interface.)

Interface Card Overview
This section describes the configuration and interpretation of results of the RF
and IP Video interface cards that you can install in MTS400 Series MPEG test
systems. The cards all use a common interface protocol for data handling and
firmware upgrading.

The interface settings described are as follows:

QAM (Quadrature Amplitude Modulation) (Annex B II) (See page 1-78, RF
Interface - QAM (Annex B).)

COFDM (Coded Orthogonal Frequency Division Multiplexing) (See
page 1-81, RF Interface - COFDM.)

QPSK/8PSK (Phase Shift Keying) (See page 1-86, RF Interface -
QPSK/8PSK.)

8VSB (Vestigial Side Band) (See page 1-84, RF Interface - 8VSB.)

IP Video Gigabit Ethernet (See page 1-88, IP Video Gigabit Ethernet
Interface.)

Refer to the MTS400 Series Specification and Performance Verification Technical
Reference, 077-0207-xx for the interface technical specifications.

Only one of these interface cards can be installed in the MTS400. All RF interface
measurements and graphs include a constellation diagram with MER rings, EVM,
SNR, and BER measurements. The installed interface can be used simultaneously
with a GbE interface and the internal NIC (network interface card) input. All
interfaces have dual-level warning and failure alarms, and graphs for long term
trend monitoring.

The input card screen and configuration of the card will depend on which interface
card is installed. (See the following pages.)

Interface Card Set Up The interface card configuration is set up when analysis is started using the Open
Transport Stream dialog box. The settings can subsequently be changed during
analysis from the Interface View.

MTS400 Series Analyzer Applications User Manual 1–13



Transport Stream Compliance Analyzer - Getting Started

When real-time analysis is selected and an interface is selected from the Interfaces
drop-down list. The Firmware Version and the current Interface Settings of the
card are displayed.

Figure 1-7: Open Transport Stream dialog box

If the firmware version is incorrect, the Update Firmware button is enabled, and
you will not be able to proceed with the setup and analysis until the firmware is
updated. (See page 1-14, Interface Card Firmware Update.)

1. In the Open Transport Stream dialog box, select Real-time Analysis.

2. Select the interface from the Interfaces drop-down list.

3. Enter the interface settings required. for Descriptions of the settings for each
interface card. (See page 1-78, RF Interface Views.)

4. Select OK to start the analysis.

The name of the selected interface is displayed in the TSCA status bar.

Interface Card Firmware
Update

If the interface card firmware needs to be updated, a message will be displayed
when real-time analysis is selected. The Update Firmware button will also be
enabled.

Update the interface card firmware as follows:

1. Select Update Firmware.

2. In the Update Firmware dialog box, select Start.
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Figure 1-8: Firmware update

3. The dialog box will display progress of the update. The box will close when
the update is complete.

CAUTION. Removing power from the MTS400 while the firmware upgrade is in
progress can cause fatal corruption of the firmware files.

Setting Up the IP Interface
Two Ethernet interfaces are standard on the network interface cards installed in
MTS400 Series systems; one 10/100 Base-T and one 10/100/1000 Base-T GigE.

Two high performance Gigabit Ethernet interfaces can be acquired as options;
only one can be installed at a time.

The following table lists important comparisons between the IP interfaces.

Table 1-1: MTS400 Series IP interface comparisons

Feature
GigE video over IP
interface: (GbE Interface)

IP video Gigabit Ethernet
interface: (IP Video
Interface)

Network interface
card (NIC)
MTS415/MTS430/MTS4SA

Bitrate 1 Gbps (maximum) 1 Gbps (maximum) 1Mbps (total)
Interface type 1000 Base-T, -SX, -LX, -ZX 10/100/1000 Base-T; 1000

Base-T, -SX, -LX, -ZX
10/100 Base-T 10/100/1000
Base-T GigE

Number of ports (SFP - small
format pluggable)

4 x optical or electrical SFP 1 x optical SFP; 1 x RJ45 2 x RJ45

Supported IP version Version 4 Version 4 and 6 Version 4
Communications protocols IGMP v2 & v3 IGMP v2 & v3 and MLD v2 IGMP v2 & v3
Sessions (maximum) 1 500 1
Variable bit rate (VBR) Yes Yes Yes
PIT histograms and instantaneous
PIT measurements

Yes Yes No
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Table 1-1: MTS400 Series IP interface comparisons (cont.)

Feature
GigE video over IP
interface: (GbE Interface)

IP video Gigabit Ethernet
interface: (IP Video
Interface)

Network interface
card (NIC)
MTS415/MTS430/MTS4SA

PIT measurement (average) Yes Yes Yes
MDI Yes Yes No
IP packet inspection view Yes - linked for error log No Yes - linked for error log
Recording TS and PCAP (single

session only)
TS TS

PCR_OJ, _DR, _FO Yes Yes - selected session only No
PCR_AC Yes Yes - selected session only Yes
TR 101 290 Yes Yes - selected session only Yes
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IP Video Interface Setup In the Select Real-time Interface dialog box with GigE selected in the Interfaces
drop-down menu, the current settings for the selected configuration are shown.

Figure 1-9: GbE Configure Interface dialog box

The following configuration settings are available for the IP Video interface card.
(See Figure 1-9.)

Preset Name The name allocated to a preset interface configuration setup.
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Interface Card
Configuration

These settings deal with the physical and network settings.

Connection Type: Select the line speed and type of the physical connection
from the drop-down list: Force 10 (Copper), Force 100 (Copper), Force 1000
(Copper), Force 1000 (Optical), Force 1000 (Optical Rx), Auto 10/100/1000
(Copper), and Auto 1000 (Optical).

The term Force means that the IP Video interface card will not negotiate a line
speed; the linked device will have to be set in the specified forced speed mode for
this to work. For the Auto 10/100/1000 (Copper) mode, the IP Video interface
card will attempt to negotiate with the linked device for the fastest available speed
denoted by the number following the word Auto.

NOTE. The GbE interface card does not support hubs under any speed setting;
connecting to a hub can cause undesired effects.

Two types of interface are available on the IP Video interface card: copper and
optical. The copper interface supports speed settings at 10 Mbps, 100 Mbps, and
1000 Mbps. The optical interface supports 1000 Mbps only.
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The Force 1000 (Optical Rx) mode is a special mode that can work in conjunction
with a network splitter. In this mode, the receive laser needs to be connected into a
valid optical link between two other devices using an optical splitter. This enables
the IP Video interface card to monitor the communication between other devices.

MAC Address: Enter the MAC address of the IP Video interface card, for
example, 01-0a-02-0b-03-0c-04. The card is set with a unique MAC address
in the factory; do not change this. The MAC address of your instrument can
be found on a label affixed to the cover of the instrument.

Network Interaction: Select the way that the instrument interacts with
the connected network: Passive is equivalent to listening, where no
interaction with the network is required. If you require interaction with the
network to receive traffic, such as identifying specific sources or pinging
other instrument, select Active. Selecting IPv4 and/or IPv6 in active mode
will depend on your intended data sources.

The following selections are available:

Passive (IPv4 and IPv6) - If you select this option, IPv6 Addressing fields
are not used.

Active IPv4 only - If you select this option, complete only the
IPv4 Address field.

Active IPv6 only - If you select this option, complete only the
IPv6 Addressing fields.

Active (IPv4 and IPv6) - If you select this option, complete all of the
IPv4 Address and IPv6 Addressing fields.

IPv4 Address: Enter the IP address of the IP Video interface card. This
address will be allocated by your network administrator. The null value is
0.0.0.0.

IPv4 addresses are normally written as four octets in decimal separated by periods,
for example, 192.0.2.235.

IPv6 Addressing: If you have selected the active IPv6 network
administration, use this field to select the means by which the IP address of
the instrument can be discovered by the network.

Stateless only - The interface card will use its MAC address and an address
prefix used in periodic advertisement messages generated by the local router
to automatically calculate an IPv6 address (RFC 4862).

Manual - Enter an address that has been assigned by your network
administrator in the IPv6 Address field.

DHCPv6 (Dynamic Host Configuration Protocol version 6) - The interface
card will attempt to contact a DHCPv6 server on the network, which will
supply an IPv6 address for the card (RFC 3315).
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If you selected manual IPv6 addressing, enter the address in the IPv6 Address
field.

IPv6 addresses are normally written as eight groups of four hexadecimal
digits, where each group is separated by a colon (:). For example,
2001:0db8:85a3:0000:0000:8a2e:0370:7334. To shorten the writing and
presentation of addresses, several simplifications to the notation are permitted.
Your network administrator will be able to advise you.

A Link Local address is automatically assigned to allow your instrument to
communicate with the nearest network router or switch.

ASI Output - Set the output format:

As Received - The IP data is supplied in bursts as they are received directly
to the ASI output port. The data can then be looped to the processor card
for analysis.

Smoothed - The incoming IP data is buffered in an attempt to smooth the bit
rate before supplying it to the ASI output port.

VBR to CBR (Variable bit rate to Constant bit rate) - The incoming IP data
is received at a varying bit rate. Null packets are inserted into the stream to
achieve a constant bit rate output. The result can be recorded and played
back with the timing preserved.

VBR Detection - Enhances VBR detection.

Session Selection Criteria These settings target which stream is sent for analysis. Typically these settings are
extracted from the session that is selected in the IP traffic screen. Not all fields
need be completed; just enough to uniquely identify a session.

VLAN Selection: (Virtual Local Area Network) A logical grouping of two
or more network nodes, which are not necessarily on the same physical
network segment, but which share the same network number. With the VLAN
Selection turned on, if the packet carrying the transport stream contains a
VLAN identity, the system will attempt to extract the transport stream from
the first IP stream that fits the current control settings.

Tag: The desired VLAN ID in hex number format.

NOTE. There may be more than one network session on the monitored networks.
Using the following MAC, IP, and Port selections, a single session can be
identified. If all selections are set to Off, no stream will be received.

MAC Selection: Select the MAC Selection filter: None, Source, Destination,
or All. When a value other than None is selected, the system will extract the
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transport stream from the first IP stream that fits the Source and/or Destination
settings.

Source: Enter the source MAC address to filter.

Destination: Enter the destination MAC address to filter.

Example MAC address: 01-0a-02-0b-03-0c-04.

IP Selection:

Source: Enter the source IP address to filter.

Destination: Enter the destination IP address to filter.

Example IP address: 128.181.39.3.

Port Selection:

Source: Enter the source port address to filter.

Destination: Enter the destination port address to filter.

Input port number in integers between 0 and 65535.

Protocol: Select the session protocol: Don’t Care, UDP (User Datagram
Protocol), or RTP (Real-time Transport Protocol).

Multicast Configuration Multicasting allows you to subscribe to and monitor single or multiple streams on
the network. To configure the use of multicasting, click the Configure Multicast
button on the Configure Interface dialog box. The content and layout of the
Configure Multicast dialog box will depend on the multicast subscription mode
selected. The subscription mode also affects the layout of the IP Tables tab of the
interface analysis view. The three modes are Off, Single, and Multicast Database:

Subscription Mode - Off No subscription information will be used for the
current preset.

Subscription Mode - Single The single subscription mode allows you to
enter a single subscription for the current preset. The subscription’s multicast
address and optional source address is displayed along with an Edit button.
Clicking the edit button will display the Edit Current Subscription dialog.

Subscription Mode - Multicast Database The multicast subscription mode
allows entry and management of multiple subscriptions. The subscriptions
are displayed in the form of a table - the Multicast Database. This allows
you to add, remove, join and leave multicasts as well as import and export
subscriptions. This database is common to all presets but each preset can
choose whether to use it for GigE traffic or use Single or Off.

MTS400 Series Analyzer Applications User Manual 1–21



Transport Stream Compliance Analyzer - Getting Started

In all modes the IP Traffic table will be displayed showing all the traffic that
is visible to the network card.

Figure 1-10: Single subscription mode

Selecting the single subscription option, displays the Edit Current Subscription
edit button. Use the settings in the Edit Current Subscription dialog box to identify
the multicast protocol to be used, IGMP (IPv4) (Internet Group Management
Protocol) or MLD (IPv6) (Multicast Listener Discovery), and the specific
multicast source address required.

Use the Set Supported Protocols button to select the multicast protocol version
that is to be supported. The version labeled as auto-fallback allows the card to
automatically switch to the version actually detected on the network.
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Subscription Mode - Multicast.

The multicast subscription mode displays all of the multicast subscriptions that
are currently added to the multicast database and allows you to add, remove,
join and leave multicasts.

Figure 1-11: Multicast subscription mode

If the multicast database subscription mode is selected, two tables are displayed:
Multicast Database and IP Traffic.

The multicast database lists the sources of traffic sessions that are available on
the network.

The IP traffic table lists the sessions available from the sources that have been
joined.

Edit Current Subscription The Edit Current Subscription dialog box allows you to edit the subscription that
is used in Single Subscription mode. The parameters for a subscription are its
multicast protocol (IGMP or MLD), its multicast address, and its optional source
specific address if you are using Source Specific Mode. To automatically join
the subscription upon closure of the dialog box, enable the Join this multicast
checkbox. Also accessible on this dialog box is the Set Supported Protocols
button, which allows you to change the supported protocol version for either MLD
or IGMP. Usually these can be left at the default setting, but there may be times
when you want to force the use of a particular version.
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Multicast Database Table. The Multicast Database Table displays the contents of
the multicast database stored in the MTM400A. The entries in the database are
color-coded according to the state of the subscription; the states are as follows:

Not Joined No request to join this subscription has been sent, or a Leave
request has been sent for a previously joined subscription.

Processing The Join or Leave request is currently being sent to the network.
Join Requested A Join request has been sent out on the network but no matching

traffic has been detected.
Joined Traffic matching the subscription has been detected on the

network. A session will only cause a match if the destination IP
address is the same as the subscription’s multicast address. If
the subscription also specifies a Source Specific address, this
must match the session’s source IP address.

The Actions button on the right of the Multicast Database table, lists all the
available actions. These include joining, leaving, subscription management,
and setting the supported protocols. It is also possible to populate the database
automatically according to the detected traffic using the Mimic Current Sessions
option; this will not overwrite the current subscriptions but will add to them.
Additionally, the context menu for the table includes the option to copy the table
or selected row contents in CSV format to the clipboard. Double-clicking a row in
the table is equivalent to clicking its Join/Leave button. Double-clicking on the
empty space at the bottom of the table will open the Add Subscription dialog box.

The current Network Interaction setting is displayed above the table. This setting
dictates whether the network card will send outgoing traffic, for example, IGMP
Join messages. Consequently if IPv4 (or IPv6) is set to passive, no IGMP (or
MLD) or Ping messages will be sent by the interface card, and actions that would
produce outgoing traffic will be disabled on the context menus.

In Multicast Database mode, editing an existing subscription is not supported. The
Add Current Subscription dialog box must be used to create a new subscription;
this can then be edited. The Add dialog box is identical in contents to the Edit
Current Subscription dialog box.

IP Traffic Table. This table shows the sessions or "flows" detected by the network
card

The number of sessions and the total bitrate are displayed above the table. The
currently selected session being routed for deeper analysis is shown highlighted
(and is marked in the Active column, if visible). Additionally, the context menu
for the traffic table includes the option to copy the table or row contents in CSV
format to the clipboard.

Double clicking on a row in the table is the equivalent of selecting that session
for deeper analysis. Double clicking on the empty space at the bottom of the
table will open the Add/Update Session Alias dialog box. Note that selecting a
session will automatically set the Session Selection Criteria parameters on the
Configure Interface dialog box.
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Aliases. To better distinguish the sessions in the traffic table, it is possible to
create a list of "aliases", which are names up to 32 characters in length

An alias will be assigned to a session if it matches the specified destination
address, the optional destination port, and the optional source address. Aliases
will be displayed in the Session Alias column. For adding multiple aliases, it is
recommended to download the Session Aliases list for manual editing in a text or
XML editor. This list can then be uploaded to overwrite the previous list.

GigE Video over IP
Interface Setup

In the Select Real-time Interface dialog box with IP selected in the Interfaces
drop-down menu, the current settings for the selected configuration are shown.

Figure 1-12: Setting up the IP interface

The following configuration settings are available:

Preset Name The name allocated to a preset interface configuration setup.
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Device Settings IP Device Name: Select the input device from the drop-down list.

Passive Mode: Select true (passive mode) or false (active mode). In passive
mode, the device monitors traffic on the network. In active mode, traffic is
requested from a specified source.

IP Address: (Active mode only) Enter the IP address of the device. If
necessary, obtain the subnet mask and gateway addresses from your network
administrator.

Stream Settings The Source Address, Destination Address and Port, and Use RTP settings are
automatically filled when a traffic flow is selected in the Browse for UDP flow
dialog box.

In active mode

IGMP Protocol Version: (Active mode only) Select the required IGMP
protocol.

IGMP SSM Mode: (Active mode only) Select the required source-specific
multicast mode.

Creating a New IP
Configuration

In the Select Real-time Interface dialog box, select the plus button to duplicate the
existing configuration.

A default configuration name is allocated and displayed in the Presets Name field.
You can enter a more meaningful name. New values can be entered as required.
This name and the settings associated with it will remain available for recall.

Alternatively, the streams available can be viewed and a new one selected.
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Select Browse for the Browse for UDP flow dialog box to be displayed. (See
Figure 1-13.)

Figure 1-13: UDP flow selection dialog box

The names of any installed network devices in the instrument are displayed in the
Browse Device field. Select the required network device from the drop-down list.
The traffic that is present on the selected interface is displayed in the bottom half
of the dialog box. A summary of the detected UDP flows is displayed in the table
header. The bit rates given are UDP bit rates, not transport stream bit rates.

The settings (Source and Destination addresses) can be set up in two ways:

In the Open Transport Stream, Real-time Analysis, Selected Configuration
area, you can enter data into the Stream Settings fields.

Multicast sessions can be identified by entering the appropriate address in the
IP Destination Address field.

In the Browse for UDP Flow dialog box, highlight a session in the current
traffic area; the values are entered automatically in the Selected Configuration,
Stream Settings fields. Traffic carrying transport streams will have a check
mark in the Has TS column.

The TSCA should detect whether traffic is transmitted over UDP or RTP; this will
be indicated in the Transport column. The Use RTP check box will be updated
to match the protocol indicated for the selected session; this setting can be
overridden by selecting or clearing the Use RTP setting if it is believed that the
indicated protocol is incorrect.
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When the settings are correct, select OK to confirm the configuration. The dialog
box closes and the new configuration is immediately available in the Select
Real-time Interface dialog box.

Real-Time Interface Presets
You can save individual real-time interface configurations as presets; they can be
recalled when required. Up to 128 configurations can be specified.

The Select Real-time Interface dialog box shows the settings associated with
the currently selected configuration.

Different settings can be entered on this screen; the new settings will be used
when OK is selected. The new settings can also be saved as a new configuration
for future use if required.
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Starting Analysis
To start the analysis, follow these steps:

1. After you have selected the file for analysis or set up the real-time interface,
click OK to continue.

The TSCA software starts analyzing the selected stream. During deferred
analysis, a progress bar is displayed. The TSCA starts reporting analysis
results. (See Figure 1-14.)

Figure 1-14: TSCA window showing analysis progress

2. When sufficient data has been gathered and the display has stabilized, you can
start using the TSCA to view the analysis.

3. To restart analysis of a stream, select Analysis > Restart Analysis.

4. To analyze another stream, open the Open File Analysis dialog box or to select
another real-time interface, open the Select Real-time Interface dialog box.
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Setting the Stream Content Font
You can configure the TSCA software to display stream content information in a
user-defined font style or language, such as Japanese or Chinese.

NOTE. How the TSCA displays the text strings carried in the stream itself is
dictated by the TSCA font setting and by the interpretation standard that is used
during the analysis.

How the TSCA displays entries in the Event Log is dictated by the TSCA font
setting and fonts that used by a your local computer. For example, if the default
language of the TSCA computer is Japanese, the event log will be displayed
in Japanese characters. You must choose a suitable font for the characters to
display correctly.

Selecting the Display Font Perform the following steps to set the font that will be used by the TSCA software
to display stream content. You can configure the TSCA software to display stream
content using any font that is installed on your computer.

1. Select Settings > Configuration to open the Configuration dialog box.

2. Select Preferences > Font in the configuration navigation tree to display the
Font pane. (See Figure 1-15.)

3. The dialog box lists the default font that is used by your computer for the Log
Entries and Stream Content displays on the TSCA UI. Use the Font Name and
Font Size drop-down boxes to select a desired font style and size.

4. Click OK to accept and save any changes.
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Figure 1-15: Selecting a display font from the Configuration dialog box

Installing Asian Language
Fonts

Computers that are using local versions of MS Windows 2000 (such as Japanese
or Chinese), or MS Windows XP, should have the Asian language fonts already
installed on their systems.

If your computer or MPEG test system does not have Asian fonts installed,
perform the following steps to install the Asian fonts:

1. Insert the MS Windows OS CD-ROM, which was supplied with your
computer or MPEG test system, into the CD-ROM drive.

2. Locate the LangPack directory on the CD-ROM. This directory contains a
number of *.inf files for various languages. For example, you may want to
install japanese.inf and tchinese.inf, for Japanese and Traditional Chinese
language fonts.

3. To install new fonts, right-click on each desired font file in the LangPack
directory and select Install.

4. The new fonts you installed should now appear as possible font selections
in the Configuration dialog box. You must select the new font in the
Configuration dialog box before the new font will be used to display stream
content.
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Loading a Custom
Extension Font

The ARIB specifications for the ISDB standards use private extensions to the
standard Unicode character set [0xE000-0xF8FF]. These extensions allow you to
add additional characters and nonstandard proprietary characters to an existing
font. The extension sets are provided as TrueType Extension files (*.tte). Any
extension sets should be installed using the Private Character Editor, supplied as
part of the standard MS Windows installation.

To install a font extension set on your computer:

1. Open the MS Windows Private Character Editor.

a. Select Run from the Start menu.

b. Enter eudcedit in the Run dialog box and click OK.

2. After the Private Character Editor opens, close the Select Code dialog box.

3. Select Font Links… from the File menu.

4. In the Font Links dialog box, select Link with Selected Fonts.

NOTE. If you select Link with All Fonts, the following actions will overwrite
any existing font extension sets.

5. In the Select Fonts box, find and highlight the font to which you are adding
the extension. This font should be the one you selected in the TSCA font
preferences dialog box.

6. After you select the font to which you are adding the extension, click Save As.

7. In the Modify Private Character Filename dialog box, browse to the TrueType
extension file that you are adding (*.tte) and click Save.

8. In the Font Links dialog box, click OK.

9. Close the Private Character Editor window.

10. To verify that the font extension has been successfully installed, open the
Character Map application.

a. Select Run from the Start menu.

b. Enter charmap in the Run dialog box and click OK.

11. Browse through the font list for the name of the font to which you added the
extension. The term "Private Characters" should follow the font name. When
you select the font name in the list, you can view the extended character set.

12. Close the Character Map application.

The new font extension you installed should now appear as a font selection in the
Configuration dialog box. You must select the new font in the Configuration
dialog box before the new font will be used to display stream content.

1–32 MTS400 Series Analyzer Applications User Manual



Understanding the TSCA Window

Understanding the TSCA Window
On start up, you can immediately open and analyze a transport stream. (See
page 1-6, Starting the TSCA Software.)

Figure 1-16: FlexVuPlus Window
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The analyzer window as shown in the following figure will be displayed when
the Analyzer tab is selected.

Figure 1-17: Analyzer window

TSCA Top Level Displays
The TSCA has two top level tabs: FlexVuPlus and Analysis.

The FlexVuPlus display enables the TSCA to perform like a 4-in-1 monitor on a
single incoming stream. The display allows you to select up to four concurrent
views of a monitored stream and provides the ability to configure each of the
four views independently. Setting up and configuring the FlexVuPlus display is
described in the MTS400 Series Quick Start User Manual.

The remainder of this section describes elements in the Analyzer window.

TSCA Window Components
The TSCA window contains the following components:

Menu Bar The Menu Bar provides access to a selection of system options using drop-down
menus. (See page 1-140, Menu Bar and Options.)
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Toolbar The buttons displayed on the toolbar provide shortcuts to often-used menu
options. Additional buttons displayed during real-time analysis are shown in
the following table:

Table 1-2: Toolbar icons
Deferred and Real-time Analysis

Opens the Open Transport Stream dialog box.

Restarts analysis.

User actions are recorded during a session. The forward and
back buttons allow you to step through the actions in order to
review or repeat them.

Opens the Preferences dialog box from which you can set your
preferences.

CaptureVu
View CaptureVu status.

Resume file analysis.

Stop and capture analysis.

Real-time analysis
View record setting.

Arm record feature.

Start recording.

Stop recording.

Progress bar The progress bar indicates the progress of processing during deferred analysis
of a stream.

To stop the analysis process, click the Stop button on the toolbar.

MTS400 Series Analyzer Applications User Manual 1–35



Understanding the TSCA Window

Navigation View The left side pane in the main window is the navigation view and provides
the main analysis information for the transport stream in a number of forms:
Programs, Tests, SI/PSI, PID, Packets and Interface. Views are selected using
the tabs at the top of the pane. The background of each view is color-coded to
aid identification.

Detail View/Panes(s) The right side pane in the main window is the detail view and provides details
related to the selection made in the current navigation view. The overall view
may be subdivided into one or more panes; you can access individual views in
multiple pane views using tabs.

Status Bar The status bar, when not hidden, is displayed at the bottom of the main window
and shows a summary of stream statistics.

Table 1-3: Field descriptions, from left to right
Field Description
TS Availability Indicates either that the stream bit rate has fallen below the

minimum value or that synchronization has been lost. (See
page 1-36.) The minimum stream bit rate is set using the "Min
stream bit rate for processing" parameter.
(See page 1-117, Parameter Edit.)

Sync Shows the status of the MPEG sync loss test. Loss of sync
during analysis of a stream may mean that analysis of the
complete stream was not possible.

Bit rate Total bit rate of the transport stream. The packet value (188 or
204) is set using the Preferences feature.
(See page 1-122, Bit Rates.)

Packet Size Packets in a stream can be either 188 or 204 bytes long. This is
detected automatically.

Stream Interpretation,
Base Standard

This is the set of tests that is being used to analyze the stream.

Stream Interpretation,
Region

This subset of tests modifies the base standard; it may add
tests or modify existing ones.

Physical Interface The current interface for real-time analysis.
(Available only for ISDB-T streams.) This icon indicates the
presence of partial reception data in the stream. The colors
indicate the status as follows:
Gray: Partial reception availability is unknown.
Green: Partial reception data is available.

Partial Reception

Availability

Gray + red cross: Partial reception data is not available.
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Table 1-3: Field descriptions, from left to right (cont.)

Field Description
This icon consists of three adjacent LED indicators which
show the status of the TSCA processing engine. The left
indicator shows the "strained" status (whether throttling is being
applied to cut down on the information being processed). The
central indicator shows the "overwhelmed" status (whether the
processing engine is able to cope with the amount of information
in the stream even after throttling). The right indicator shows
the status of the processing of SI tables even after throttling.
The colors indicate the status as follows:
(See page 1-38, Error Status LEDs.)
Green: OK
Amber: Processing was strained/overwhelmed,

but is currently OK
Red: Processing is currently

strained/overwhelmed
White: Processor state is unknown

Processing Throttle

Indicator

Gray: Test disabled
Shows the status of the system log, which records system-wide
events, for example, scripting errors. The color of the LED (in
the body of the icon) indicates the most serious event state in
the log. When the top surface of the icon is gray, it indicates
that all entries in the log have been viewed. Double-click the
icon to view the log.
Gray: The log is empty
Amber: There are entries in the log, but none

since the log was last viewed

System Log Status

Red: There are new entries in the log
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Analyzer Window - No
Stream Available

If you choose not to select and analyze a stream, the screen will appear as shown in
the following figure. The analysis structure is present, but with no stream content.

Figure 1-18: Analyzer window - no file

Error Status LEDs
Error status LEDs are used throughout the TSCA interface to represent the status
of the tests applied to associated items, such as programs, tests, and PIDs. Colors
used are as follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but has been seen
since last reset)
(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

(Light Blue) Transient warning (warning not current, but has been detected
since last reset) (Interface tab only)
(Gray): Test disabled

(White) Test not applicable or unknown state
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(Red) PID referenced but not found in the stream

(Green) PID referenced but not found in the stream. Applicable test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes), the color represents the worst case of all
of its tests and the worst case of all of the tests represented by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.

NOTE. The color scheme described here is used throughout the TSCA interface,
for example, the bit rate bars in the navigation views.

Test Management Context
Menu Options

Tests can be disabled and enabled as required using the context menu associated
with the LED icon. However, it is important to note that the extent of the action
depends on the hierarchical level of the icon chosen. For example, choosing
Disable from a program node context menu will disable all tests in the program
group.

NOTE. In offline file analysis, if any disabled events are reenabled at the end of
analysis, the LEDs will become green. You will have to restart the analysis if you
want to see the status of the test when the test is enabled.
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Context Menus
Context menus provide an important way of navigating around the TSCA
application. They are available on most displayed objects, for example, program
tree nodes. These menus provide options relevant to the selected object. For
example, after failure, all tests associated with a node can be reset, by selecting
the context menu option Reset All Tests. The context menu options provide both
actions (for example, enable and disable a function) and quick links to associated
objects in other views.

Figure 1-19: Context menu (example)

To view context menus, right-click an object. The menus are associated with node
types (for example, a PID node). Node types can be displayed in more than one
view; for example, PID nodes are displayed in the Program view and the PID
view. All context menus have a title bar that indicates the selected node.
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Using the Program View
The Program view is displayed when the Program tab is selected in the navigation
tabbed pane. The navigation view initially displays the top node of the program
tree, which represents the analyzed transport stream from a program perspective.

Figure 1-20: Program view

The detail view shows details of the node highlighted in the navigation view.
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With the tree expanded, the navigation view shows the makeup of the stream.
(See Figure 1-20.) The stream display consists of the nodes as shown in the
following figure.

Figure 1-21: Program view nodes

The following table shows which information is available for each node.

Table 1-4: Program view tabs

Tabs /
Node Summary

Now
Playing

IP
Graphs

MPE
Sessions

Summary
/
Associated
Tests

Graph -
Bit Rate

Graph -
Timing

Event
Log Parameters

Transport
Stream

- - -

Program - - -
Elementary
Stream

- - - -

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will be populated only when MPE data is present in the stream. (See page 1-132,
MPE Views.)

Pressing the F3 key on the keyboard (or selecting Go to the next red LED in
current tree from one of the shortcut menus) will highlight the next red LED in
the current view. Only the lowest level nodes will be considered and highlighted in
the search since the parent nodes simply reflect the state of the lowest level nodes.
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Program Navigation - Transport Stream Node
The transport stream node represents the entire transport stream in terms of the
programs that it contains. The adjacent LED icon represents the status of the entire
transport stream; any status error in the stream will be represented by this LED.
When this node is selected, the detail view displays the transport stream summary.

The associated detail view provides a program-orientated overview of the
transport stream, allowing you to see the relative data rates of all of the programs
contained within the transport. A summary of the overall stream is also displayed.
The information can be displayed as either a bar chart or as a pie chart.

The data rate of a program is the cumulative data rate of all the PIDs that are
associated with that particular program, including PCR and ECM PIDs.

NOTE. Components can be shared between programs, so the overall data rate
of all of the programs may appear to be greater than the total data rate of the
transport stream as shown in the status bar.
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Bar Chart You can display the transport stream bar chart by selecting the bar chart icon.

Each program identified in the stream is allocated one row of the table. Related
information includes the overall program status (icon), the program name,
program number, and the maximum, minimum and average bit rates.

In addition to the basic display, you can associate a maximum and minimum
threshold value with each program in the bar chart. (See page 1-123, Bar Charts.)
For deferred analysis, where these values are set after analysis, the stream must
be reanalyzed for the new values to be applied. In real-time analysis, the new
values will take effect immediately. The color of the bit rate bar indicates that the
program has stayed within the bit rate limits (green) or exceeded the limits (red).
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Pie Chart You can display the transport stream pie chart by selecting the pie chart icon.

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the legend on the right provides a list of the component programs. Each
program is color-coded. The overall program status (icon), the program name
and number, and the bit rate are also provided. The values given in the pie chart
labels are bit rates expressed as percentages of the overall bit rate. The Null PID
is shown in this view.

The color of the bit rate labels (and the bit rate values in the legend) reflects
the status of the bit rate measurement, for example, green indicates that the
program has stayed within the bit rate limits, and red indicates that the bit rate
has exceeded the limits.

Click and hold one of the pie chart segments to temporarily display an information
label. Double-click anywhere in the pie chart to toggle the display of all of the
segment labels.
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Historical Multiplex Graph The historical multiplex view is divided into two panes. The left pane shows
the historical multiplex graph, and the legend on the right provides a list of the
component programs. Each program is color-coded. Related information given
includes the overall program status, the program name and number.

Figure 1-22: Historical Multiplex Graph

The Time Period drop-down list allows you to select a range of X-axis time
periods.

Test Status Panes The lower view pane allows you to see a summary of the states of all the associated
tests as well as the event log for the entire transport stream (an unfiltered event
log). The test tabs that are available will depend on the interpretation standard that
you choose. For example, with the DVB interpretation standard, the available tabs
are TR 101 209 and Other. Other interpretation standards will generate different
tabs and different sets of tests. (See page 1-167, SI/PSI Nodes.)

When any test in the transport stream has failed (and has not been reset), you can
identify which individual tests have failed by observing the red LEDs.

You can use the shortcut menus to reset and disable tests, to set alarms, CaptureVu
Breakpoints and record flags, and to jump to associated tests.
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Event Log The Event Log screen displays the log entries as shown in the following figure
for the whole transport stream. In deferred mode, the packet generating the error
report can be inspected by highlighting the error and selecting Go to packet
from the shortcut menu. Similarly, in real-time analysis mode, and where an
event concerns a PID carrying a PCR, you can use the shortcut menu to jump to
the relevant PCR graph. Deferred PCAP file analysis enables a shortcut that
allows Ethernet packets to be viewed.

Figure 1-23: Event log

Three buttons are available in the Error Log toolbar: (See page 1-119, Event Log.)

Table 1-5: Event log buttons
Icon Description

/
Pin log / Log is pinned

Export log

Clear log

IP Graphs The IP graphs, where available, are as follows:

Packet Interarrival Time (PIT): Shows the mean interarrival time of IP packets.

PIT histogram: Shows the distribution of packet arrival intervals. The X
axis contains accumulators where interval times are collected. The Y axis
corresponds to number of intervals that collect in each accumulator.

Ethernet flow rate: Bit rate of the Ethernet flow being analyzed.

Delay factor: A measurement that characterizes IP packet cumulative jitter
and delay. (Delay factor is the amount of buffer, in milliseconds, that would
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be required to subtract IP packet arrival deviations from the rate determined
by the media payload.)

Media loss rate: Media packets lost per second.

The available graphs vary, depending on which IP interface options being used.
Unavailable graph names will be grayed out in the selection menu.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 1-103, Graph
Management.) (See page 1-109, Timing Graphs.)
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Program Navigation - Program Nodes
Each of the program nodes in the transport stream represents a single program
referenced within the stream. When a program node is selected in the navigation
view, the detail pane displays the details of the program. The LED adjacent to the
program node represents the status of its child nodes (elementary streams) and
the related tests.

The program detail view provides you with an overview of the selected program,
allowing you to see the relative data rates and stream types of all of the PIDs that
are associated with the program (including PCR and ECM PIDs). If the program
contains an MPEG2 or H.264 video stream, it is decoded to produce a thumbnail
picture of the content; this is updated during real time analysis. Similarly, where
EPG information is associated with the program, a summary (Now and Next
program) is displayed. PID content is indicated using icons. (See page 1-100,
Icons.) Bar chart and pie chart views are available.

PID related information is available under the Summary tab.

The Thumbnails tab displays thumbnails and details of the streams for each of the
programs (where available). (See page 1-115, Thumbnail Views.)

The Program Tests tab shows tests related to the program. Similarly, the Bit rate
Graphs tab displays the program bit rate in graph form.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 1-117, Parameter Edit.)
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The Event Log shows the errors for the highlighted test. When no tests are
selected, the event log will show the events related to all tests associated with the
elementary stream selected in the program tree.

VLC Media Player The VLC Media Player is a portable multimedia player for various audio and
video formats. The player allows program content displayed in the TSCA
thumbnails to be played in a larger window. The media player is automatically
accessed from the TSCA when you choose to view or listen to the video and audio
content of program streams.

NOTE. The VLC Media Player is not installed as part of the MTS400 Series
system. Installation of the player is described in the MTS400 Series Quick
Start User Manual (Tektronix part number: 071-2607-xx). You can find full
documentation of VLC on the Videolan Web site, http://www.videolan.org.

To start the media player, click the start button (below the thumbnail) in the
Program Summary view.

The VLC Media Player opens and the selected program content (video and/or
audio) plays. To close the player, click the stop button (below the thumbnail).

NOTE. The VLC Media Player may open "behind"the TSCA window. Use the
Windows controls to bring it forward. If the VLC Media Player is installed on
the MTX100B / RTX100B / MTX130B instrument, the audio feature in the media
player must be disabled.
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Elementary Stream
Analysis

The elementary streams in the selected program can be examined in more detail
using the MTS4CC Elementary Stream Compliance Checker or the MTS4EA
Elementary Stream Analyzer. Select the ES icon below each thumbnail picture.

Program Navigation - Elementary Stream Node
Each of the elementary stream nodes in the program tree represents a single
elementary stream referenced by the parent program. When this node is selected,
the view pane displays the Elementary Stream summary view.
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When you hold the cursor over the elementary stream node, a tooltip provides the
stream type and description.

An LED associated with each elementary stream node indicates the status of the
tests relating to the elementary stream.

When the selected elementary stream PID contains timing information, PCR
trend analysis views are also available, allowing you to display graphs of PCR
accuracy and PCR interval data. When the transport stream contains timestamped
data, the PCR overall jitter, PCR frequency offset, PCR arrival time, and PCR
drift rate graphs are also available.

NOTE. Graph management and timing graphs are described in more detail in the
Common User Interface Concepts section of this manual. (See page 1-103, Graph
Management.) (See page 1-109, Timing Graphs.)
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Figure 1-24: PCR Graphs view

The Associated Tests tab shows tests related to the elementary stream node.

Many tests have associated parameters; these parameters are set by the selected
standard, but you can modify the settings. (See page 1-117, Parameter Edit.)

Similarly, the Event Log shows the errors for the highlighted test. When no tests
are selected, the event log will show the events related to all tests associated with
the elementary stream that is selected in the program tree.
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Using the Tests View
The Tests view displays test information that is relevant to the transport stream
being analyzed. The view is displayed when the Tests tab is selected in the
Navigation tabbed pane. (See Figure 1-25.)

Figure 1-25: Tests Navigation view
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The view displays a test tree, which represents all the tests that have been applied
to the analyzed transport stream. The following figure shows the nodes available
in the navigation view.

Figure 1-26: Test view nodes

Test Structure The test tree structure represents all of the tests that can be applied to a transport
stream complying with a particular digital video standard: MPEG, DVB, ATSC,
and ISDB. The standard must be selected before beginning analysis. The test tree
contains nodes for each test that the analyzer can implement.
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An example of a tree structure for a selected standard is the TR 101 290 group of
tests for DVB transport streams. (See Figure 1-26.) The Group node is split into
priority groups: First Priority, Second Priority, and Third Priority. Each of these
priority groups contains a number of individual tests.

Test grouping differs between digital video standards. However, all of the
currently implemented standards contain a subset of the relevant TR 101 290 tests.
Note that in standards other than DVB, the tests are not numbered.

Where relevant, PIDs will be associated with a test in the test tree when the test
has either been disabled, or when it has failed.

The LED associated with each node indicates the status of the node and its child
node tests. (See page 1-38, Error Status LEDs.) Total entries in the Event Log
for each group of tests and for each test are indicated in parenthesis; resetting a
group of tests or a test restarts the count in parenthesis.
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Test Filtering Interpreting the display of tests can be made easier using the three filter buttons at
the top of the Tests navigation view.

Figure 1-27: Test filtering buttons

When a button is selected, it hides a category of tests in the test tree display, as
follows:

Grey - hides disabled tests

White - hides tests with unknown or not applicable status

Green - hides tests with OK status
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Tests Navigation - All Tests
The detail view when the All Tests node is selected. (See Figure 1-25.) In addition
to a summary of all tests, the event log shows the most recent 10000 events that
have occurred during analysis of the stream.

Test Failures View

Figure 1-28: Test Failures screen

The Test Failures view provides an overview of the tests that have failed during
stream analysis. The view is divided into two panes. The left panes shows those
tests that have failed in the last second. The right pane shows those tests that have
failed, not including those that have failed in the last second, and are displayed on
the left side.

If a test fails, it will be displayed on the left side. When it no longer fails, it will be
removed from the left side and listed on the right side as a test that has previously
failed. If the test fails again, it will be removed from the left side and redisplayed
on the right side until it no longer fails.

Additionally, tests that have been listed (in either pane) in the last second are
displayed at the top of the list and shaded.
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Test Navigation - Test Nodes
When you select a test node, the Associated PIDs pane displays a summary of
all of the PIDs and an event log listing all events that are associated with the
test. Where parameters are applicable to the test, you can modify them under
the Parameters tab.

MTS400 Series Analyzer Applications User Manual 1–59



Using the Tests View

Test Navigation - PID Nodes
Where tests have failed, the PIDs affected are listed under the test node in the Tests
navigation view. Selecting a PID will display the Event Log in the detail view.

NOTE. The screenshot also shows the Edit Parameters dialog box, which is
available from the PID node context menu. (See page 1-117, Parameter Edit.)

1–60 MTS400 Series Analyzer Applications User Manual



Using the Tables View

Using the Tables View
The Tables view (SI/PSI tab) displays service information in tree form, as in the
other navigation views. The tree represents the service information tables that
have occurred in the analyzed stream and which comply with the selected digital
video standard. This includes MPEG program specific information, DVB service
information, ATSC and ISDB program information, and system information
protocol. The tree contains nodes for each table that is found; tables/nodes are
grouped together by functionality. The following figure shows an example of the
Table navigation view with DVB stream interpretation selected.

Figure 1-29: Tables view

Every node within the service information tree has a corresponding summary
view. Nodes that represent tables will also provide you with access to the table
structure and hex data. (See page 1-63, Tables Detail View - Section View.) (See
page 1-65, Tables Detail View - SI Repetition Graphs.)

Some of the nodes that represent less common tables or table groups may not
have specific summary views available in the analyzer. In these cases, a generic
summary view is used.
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Table Summary Pane
The table summary view provides a summary of the table related information for
the analyzed transport stream. There is a table summary view for every node of
the service information. The content is dictated by the selected node.

All summary views for nodes that represent an individual table or subtable
will display the table identity and version number of the table from which the
information is extracted. Where relevant, links (underlined text) are provided to
associated objects, for example, in the programs summary, links are provided to
the individual program summary views. Similarly, arrow icons provide links to
the electronic program guide (EPG) tables. (See Figure 1-30.) Where the section
is carried on a PID, a link is also provided to the PID view.

The following shows an example of the summary pane with the PMT PIDs node
selected in the navigation view.

Figure 1-30: Tables view - Programs (example)

EPG Views A specific departure from the Table Summary view described previously is the
EPG view that is displayed when a section of the EPG table is highlighted. For
a description of the general presentation of the EPG view. (See page 1-127,
EPG View.)
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Tables Detail View - Section View
The detailed section view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. During
real-time analysis, the view is continually updated.

The subtable identity, version, and section are displayed at the top of the table
pane.

NOTE. In deferred mode, where two or more subtables, versions or sections are
found in the stream, the relevant field is active, and an alternative selection can be
made from the drop-down list.

In real-time mode, only the latest version and section can be viewed.

The table pane shows all fields that make up a section (for example, PMT). The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. The container
can be expanded or collapsed by clicking the + or - icon.
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Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected table, version, and section. When a node is selected in the table pane,
the bytes that make up the selected node (including the subordinate nodes) are
highlighted in the hexadecimal data pane as shown in the following figure.

Figure 1-31: Section payload

If the section is corrupt or empty, the hexadecimal view background is red instead
of blue.

The pause button in the detail window title bar allows real time section data to be
paused (or frozen), so that it can be examined in detail. The play button resumes
the real time display of section data.
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Tables Detail View - SI Repetition Graphs
The section graph view is available when the selected node in the service
information tree represents a table or subtable in the transport stream. You can
view graphs of the following data:

Section repetition interval: This graph displays the interval between two
sections of a table on a particular PID.

Subtable intersection gap: This graph displays the interval between sections
in a particular subtable.

Subtable repetition interval: This graph displays the time between receiving
one complete subtable and receiving the next complete subtable.

NOTE. Not all of the above graph types are relevant to all table types. (See
page 1-103, Graph Management.)

Export SI/PSI as XML
The export control in the top left corner of the SI/PSI navigation pane opens the
Export SI/PSI as XML dialog box. Enter an output file name (and path) and
select the required options.
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Using the PID View
The PID view displays information about all of the PIDs found in the transport
stream being analyzed. The navigation view contains the PID tree structure
representing all of the PIDs that have occurred within the transport stream.

In DVB analysis mode, the MPE tab is always present. However, the MPE view
will only be populated when MPE data is present in the stream. (See page 1-132,
MPE Views.)

PID View - All PIDs
In the navigation view, PIDs are grouped under the following subordinate nodes:

Reserved PIDs

Referenced PIDs

Unreferenced PIDs

SI/PSI PIDs

User PIDs

Obsolete PIDs (deferred analysis only)
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The number of PIDs in each group is shown adjacent to the node. The root node
label shows the total number of PIDs found and the Network Name.

When highlighted, the All PIDs node displays in the detail pane all of the PIDs
that are found in the analyzed stream.

Each of these subordinate nodes contains PIDs belonging to that group. PIDs are
allocated during analysis, and the number of PIDs is identified for each node. You
can also allocate PID numbers to the User PID node, although User PIDs may not
necessarily have been found in the stream. This feature allows you to compare the
properties of one or more PIDs more easily.

The associated summary view provides a PID-oriented overview of the transport
stream, allowing you to see the relative data rates of all of the PIDs contained
within the transport stream. The information can be displayed as either a bar chart,
or as a pie chart. Columns in the summary views can be sorted in ascending or
descending order by clicking on the column header. PID related information is
available under the PID Information tab.

Each PID is associated with a number of tests. If one or more tests fail, they will
be listed under the relevant PID node in the navigation view. Selecting the PID
node will display a summary, in the detail view, of all associated tests that have
been found. Selecting a specific test in the Associated Tests pane will display the
Event Log and Parameters for only that test.
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PID View - Detail View (All PID and PID Group)
The All PID and PID Group detail view provides you with a PID-oriented
overview of the transport stream. This view is displayed when any of the
main nodes is selected in the navigation pane: All PIDs, Referenced PIDs,
Unreferenced PIDs, or User PIDs.

The view shows the relative data rates of all of the PIDs contained within the
selected node. You can display the information in either a bar chart or a pie
format. The associated test states are shown in all views.

Figure 1-32: PID Summary view

The PID Information view provides PID related information, for example, PID
type stream type, scrambled status and the presence of PCRs. Layer information is
also shown when analyzing ISDB streams. (See Figure 1-33.) The icons provide
an indication of the PID content. (See page 1-100, Icons.)

Where a PID carries video or audio, thumbnails are displayed under the Now
Playing tab.
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In deferred mode (or during CaptureVu analysis), you can view the packets
carrying a PID by highlighting the PID, and selecting the Go To Packets view from
the shortcut menu. The packet will be added to the PIDs list (in the Packets view).

Figure 1-33: PID Information view

PID View - Detail View (PIDs)
The individual PID detail view provides you with information about the selected
PID. This view will be visible when you select an individual PID node in the
PID tree. If a PID has failed a test, one or more test nodes are displayed as child
nodes of the PID.

The combination and detail of the views vary depending on the selected PID
type and node.

During deferred or captured analysis, the packets carrying the PID can be
examined in more detail by highlighting a PID, and selecting the Go to Packets
view from the shortcut menu.

Ordinary PID Selected When a PID does not contain PCRs, the main view in the PID pane is the
Associated Tests view. This view lists the tests associated with the selected PID.
The status of the individual tests is indicated with LED icons. Also available are
Bit rate Graphs, which show the bit rate of the selected PID in graphical form.
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Also on the Associated Tests tab is an event log and a parameters pane. The
event log shows all PID related events. If a test is selected in the PID pane, only
the events associated with that test on that PID are shown. Similarly, when a
test is selected, the Parameters pane shows the parameters associated with that
test (when applicable).

PCR PID Selected When the selected PID contains PCR information, PCR inaccuracy and PCR
interval data graphs will be displayed in addition to a bit rate graph. When
the transport stream contains time stamped data, the PCR overall jitter, the
PCR frequency offset, and the PCR drift rate graphs will also be available. For
real-time IP analysis, the Packet Interval Timing (PIT) graph is also available.
(See page 1-113, PIT Graph.)

A Presentation Time Stamp (PTS) graph may also be available on PIDs carrying
audio and video information. And a PTS-PCR graph showing the variation
between the PTS and PCR values; this can help detect buffering issues.

(See page 1-103, Graph Management.) (See page 1-109, Timing Graphs.)
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Using the Packets View
NOTE. The Packets view is available only during deferred analysis and CaptureVu
analysis.

Data in the stream is carried in 188- or 204-byte packets. The Packets view allows
you to examine the contents of each packet in the analyzed stream.

The packet navigation view shows a tree structure which represents the packets
within a stream grouped according to content, including PID value, SFN
mega-initialization packets (MIPs) (DVB only), and ISDB-T information packets
(IIPs).

The All Packets, MIP and IIP nodes do not have any child nodes. The All Packets
node represents all of the packets in the transport stream. The MIP node represents
all of the DVB SFN MIPs in the transport stream. The IIP node represents all of
the ISDB-T information packets in the transport stream.

The PIDs node represents all of the PIDs that are of interest. You can add PIDs
in the transport stream to this node, and to PIDs that are contained within the
user PID list.

MTS400 Series Analyzer Applications User Manual 1–71



Using the Packets View

Selecting any leaf node in the packet tree will apply a packet filter to the associated
packets. For example, selecting a PID node will only allow packets carrying
that particular PID to be displayed in the associated summary view. Similarly,
selecting the MIP node will only allow MIP information to be displayed in the
associated summary view.

Double-clicking the Custom Packet Search node opens a dialog box in which
you can specify strings to search for.

Packet Navigation Bar
In the packet summary view, you can use the top bar to navigate the packets
in the stream.

The packet position bar shows the position of the selected packet in the stream.

The navigation bar functionality depends on the selection in the packet navigation
view. If you select All Packets, the controls will operate on all packets. If you
select a single PID, a filter is in operation, and the controls will work only for
those packets carrying that PID.

Selects the first available packet (in the stream or carrying the
selected PID)
Selects the previous available packet (in the stream or carrying
the selected PID)
Selects the next available packet (in the stream or carrying the
selected PID)
Selects the last available packet (in the stream or carrying the
selected PID)
Opens the Go To Packet dialog box

You can also use the packet position bar to navigate through the stream. To do so,
use the cursor to point to and click the next packet to be displayed. Double-click
the packet number in the bar to open the Go To Packet dialog box. Enter the
required packet number and select OK. For both methods, remember that the
destination packet is dependent on the node selected in the navigation view.
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Packet Navigation - Filter Nodes
The packet filters allow you to view packets carrying PID.

To inspect the sequence of packets carrying a particular PID, you must add the PID
to the PID Filters node in the Packet Navigation view. PIDs carrying sections can
also be viewed. You can add as many PIDs as are required. There are a number of
ways to add a PID to the node, as described in the following paragraphs.

Adding a PID in the Packet
View

1. In the Packet view, expand the PIDs node by doing one of the following:

Double-click the child node (double-click to add a PID).

Select Add PID... from the PIDs node shortcut menu.

2. In the Add PID... dialog box, expand the nodes, locate and select the required
PID.

3. Click OK.

The selected PID is added to the PIDs node, and the first occurrence of a packet
carrying the selected PID is displayed in the summary view.

Added PIDs will be stored when the application is closed. They will be reinstated
when the application is reopened. However, if a different stream is analyzed, the
stored PIDs may not be used.

Removing PIDs All PIDs previously added to the PID node can be removed by selecting Remove
All from the PIDs node shortcut menu.
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Packet Detail View
The detail view shows the fields and data that are contained in a packet. The
fields are arranged in a hierarchical order. The presence of subordinate fields is
indicated using { } bracket symbols adjacent to the container field. To expand or
collapse the container, click the + or - icon.

Below the table pane, the data source is displayed. The data pane shows the data
bytes (in both hexadecimal number format and ASCII character format) for the
selected packet. When you select a node in the table pane, the bytes that make
up the selected node (including the subordinate nodes) are highlighted in the
hexadecimal data pane.

The packet transport header bytes are displayed in red. Similarly, bytes greater
than 188 are displayed in gray. The adaptation field, where present, is displayed
in blue.

If the section is corrupted or empty, the background of the hex view is red instead
of blue.
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ISDB Streams The following figure shows an example of the packet detail view with an analyzed
ISDB-T stream. Note the IIP tab and the additional TMCC and IIP nodes.

Figure 1-34: Packet view - ISDB detail -IIP
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Using the Interface View
If real time analysis using an interface card is invoked, the Interface tab is
displayed in the Navigation view of the TSCA window.

NOTE. The Interface view is available only if an interface card is selected for
real-time analysis.

Figure 1-35: Interface View - Example

Two interface card test nodes are displayed in the navigation view: IF Error
Collection and IF Warning Collection. Each collection contains a range of tests.
(See Figure 1-35.)

The detail of the interface view is different for each interface type.

Detail View Tabs
The detail view contains four tabs: Instantaneous graphs, Trend graphs, Event
Log, and Parameters. This section describes the tabs in general terms. The
following sections describe in detail the tabs associated with each interface type.

Instantaneous Graphs The instantaneous graphs display instantaneous measurements in graphical form.
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Trend Graphs The trend graphs display trends in measurements in graphical form.

Event Log The event log displays a history of the events related to the item selected in the
navigation view.

Parameters The parameters tab display the parameters associated with the test highlighted in
the navigation view. Parameter editing is described in the Common User Interface
Concepts. (See page 1-117, Parameter Edit.)

Readings and Controls
The right panel contains Readings and Controls. The Readings area displays
values received from the card itself.

The RF Lock LED conveys different types of information. If full lock onto the
channel is acquired and it is receiving the signal correctly, the LED will light up
green. When a signal is present but no lock is achieved, the indicator is red. When
no signal is found, the indicator is gray.

In the Readings area, the LED colors are as follows:

Green On
Red Out of range or failed test
Gray Off or not applicable

The Readings background colors are as follows:

White In range
Red Out of range; for example, too much or too little power or out of

order packets per second being greater than zero
Yellow Not recently updated
Gray Not applicable; for example, out of order packets not being

available when the UDP protocol is selected

The Controls area contains user controls. Values entered here will be applied to
the card and will affect its performance. These controls correspond exactly with
those on the Open Transport Stream dialog box.
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RF Interface Views
This section describes the settings and displays associated with the RF interface
cards.

RF Interface - QAM (Annex
B)

The settings and displays of the QAM (Annex B) RF interface card are as follows:
QAM(B) Interface Settings, QAM(B) Instantaneous Graphs, and QAM(B) Trend
Graphs.

Figure 1-36: Interface View - RF - QAM (Annex B)
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The following QAM (Annex B) settings are available on the Open Transport
Stream - Real Time Analysis dialog box, and also in the Interface tab - Controls
area

Table 1-6: QAM(B) Settings
Field Description

Tuner
Frequency
(kHz)

This value, set in kHz units, is the center frequency of the channel to be received. Any
frequency can be entered. There is no need to follow a channel plan. The frequency resolution
is determined by the tuner step size of 62.5 kHz.

Modulation
Format

This drop down list allows 64 QAM or 256 QAM operation to be selected. Note that SCTE07
and ITU-Tj83 annex B specify exact symbol rates for the two modulation formats, so there is
no dialog box to enter the symbol rate separately.

Interleaving
Mode

Interleaving assists in the correction of burst noise induced errors. All interleaving modes
mentioned in SCTE 07 are supported, including all Level II modes up to I = 128 J = 6.

Carrier Lock This allows the carrier lock range to be increased from the normal ±150 kHz to approximately
±500 kHz. This is useful if you are attempting to lock on to badly mistuned or wandering
carriers.

Tuner Phase
Noise

This control modifies the carrier loop bandwidth to allow the acquisition of noisy carriers.
Normal mode is recommended for general use.

QAM(B) -
controls

Equalization
Range

The channel equalizer can be configured to give a long equalization range, at the expense of
equalizer resolution, or, in normal mode, optimized for typical cable environments. Normal
mode is recommended for general use.
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Table 1-6: QAM(B) Settings (cont.)

Field Description
RF
Constellation

I and Q data are collected from the QAM front end and displayed as a conventional
constellation of 256 points by 256 points. The samples collected are not real time, so there is
some dwell (delay) before a complete constellation is displayed. The persistence of the display
can be varied using the Persist slider control at the bottom of the graph.
MER (Modulation Error Ratio) and EVM (Error Vector Magnitude) calculations are performed
on the constellation data according to the formulas in TR 101 290.

SNR after
equalizer

This graph represents the signal-to-noise ratio over time, typically over 256 seconds. It is
useful for examining signal-to-noise trends, for example, if an alarm condition has been
breached, the graph can be used to examine trends in the signal-to-noise performance before
the alarm occurred.

MER This graph gives a time record of MER over the last 255 seconds.

QAM(B) -
Instantaneous
graphs

Equalizer This graph shows the status of the equalizer taps, and gives an estimate of the channel state.
If there are echoes or other time related distortions on the signal, the Equalizer display will
display the amplitude of the corresponding tap correction values versus time.

NOTE. The Equalizer graph amplitude values are approximate.
Trend Graphs. The trend graphs extend the principle of the instantaneous graphs by graphing measurements

over longer periods.
Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.
Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.
The following trend graphs are available for the QAM B interface card:

RF Lock

MER

EVM

Pre-RS BER

Input Level

SNR after Equalizer

Carrier Offset
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RF Interface - COFDM The settings and displays of the COFDM RF interface card are as follows:
COFDM Interface Settings, COFDM Instantaneous Graphs, and COFDM Trend
Graphs.

Figure 1-37: Interface View - RF - COFDM
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The following COFDM settings are available on the Open Transport Stream -
Real Time Analysis dialog box, and also in the Interface tab - Controls area.

Table 1-7: COFDM Settings
Field Description

Nominal Tuner
Frequency

This value, set in kHz units, is the center channel frequency of the DVB-T channel to be
received. For example, to receive channel E21, set this value to 474000 kHz. Any frequency
can be entered. There is no need to follow a channel plan. The frequency resolution is
determined by the tuner step size.

Channel
Bandwidth

The COFDM interface card supports operation in 8 MHz, 7 MHz, and 6 MHz channels. Select
the desired channel bandwidth from the drop-down menu.

Receiver
Mode

To achieve high accuracy measurements, particularly for MER and SNR measurements, the
COFDM IF card supports two modes of operation.
For conventional COFDM reception, a relatively low ultimate SNR is acceptable. For example
at 64 QAM, an ultimate receiver SNR of 30 dB can result in a reduction in system performance
of only 0.5 dB. However, for more detailed analysis of COFDM constellations, a much higher
ultimate SNR is required, preferably in excess of 40 dB. For this reason, two modes of
COFDM operation are provided.

High
Sensitivity

This mode gives the full dynamic range of a conventional COFDM receiver, but at the expense
of ultimate SNR. The High Resolution mode modifies the signal path to dramatically reduce
the noise generated in the receiver, giving a much higher ultimate SNR, but at the expense of
receiver sensitivity. So for general purpose monitoring where the input signal may vary over a
wide range, typically -75 dBm and lower, high sensitivity mode is preferred.
If the signal is consistently greater than -50 dB, high resolution mode provides better RF
measurement performance.

IF Filter The COFDM receiver incorporates two stages of selectivity. One of these can be bypassed
in WIDE mode to give a more accurate representation of the input spectrum flatness (at
the expense of overall selectivity).

Stream Priority When hierarchical modulation is present, the transport stream priority, HIGH or LOW, can
be selected for analysis by the MPEG analyzer tools. When no hierarchy is present, this
defaults to HIGH priority.

Carrier start When observing carrier amplitudes ahead of the channel equalizer, this value sets the
numerical value of the first carrier to be displayed, and defaults to zero.

COFDM-controls

Carrier end When observing carrier amplitudes ahead of the channel equalizer, this value sets the
numerical value of the last carrier to be displayed, and defaults to the maximum carrier number
in the COFDM signal (1704 for 2K, 6816 for 8K modes).
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Table 1-7: COFDM Settings (cont.)

Field Description
RF
constellation
(all data
carriers)

When the receiver is in RF lock, the constellation points are displayed. According to
TR 101 290, only the data pilots are used for MER and EVM calculation. The samples
collected are not real time, so there is some dwell (delay) before a complete constellation is
displayed. The persistence of the display can be varied using the Persist slider control at
the bottom of the graph.
MER and EVM calculations are performed on the constellation data according to the formulae
given in TR 101 290. This calculation specifically excludes the TPS carriers.

Overall SNR
(all continuous
pilots)

A time line graph of measured Signal to Noise Ratio is displayed, over the preceding
255 seconds.

Overall MER
(all data
carriers)

A time line graph of measured Modulation Error Ratio is displayed, over the preceding
255 seconds.

Linear
Amplitude
response
(selected
carriers)

A linear amplitude response is shown for the carriers selected using the carrier START and
STOP controls. Allows you to view and zoom in on frequency dependent amplitude distortions.

Instantaneous
Graphs.

Impulse
response

A channel response graph is shown, allowing time related distortions, particularly echoes, to
be displayed relative to the main signal. Echoes occurring before and after the main signal
are displayed. The graph is derived form the linear amplitude response, transformed into
the time domain.

COFDM Trend Graphs The trend graphs extend the principle of the instantaneous graphs by graphing measurements
over longer periods
Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display; the measurements have status LEDs associated with them.
Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.
Trend graphs are available for the COFDM interface card

Overall RF lock

MER post-equalizer

EVM post equalizer

Pre-RS BER

Pre-Viterbi BER

Input level

SNR

RF Carrier Offset Frequency
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RF Interface - 8VSB The settings and displays of the 8VSB RF interface card are as follows: 8VSB
Interface Settings, 8VSB Instantaneous Graphs, and 8VSB Trend Graphs.

Figure 1-38: Interface View - RF - 8VSB
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8VSB Interface Settings. The following 8VSB settings are available on the Open
Transport Stream - Real Time Analysis dialog box, and also in the Interface tab -
Controls area.

Table 1-8: 8VSB settings
Field Description

Tuner
Frequency
(kHz)

Enter the required tuned (channel) frequency. Remember to enter the center channel
frequency, not the "pilot" frequency.

IF Spectrum This can be set to Normal or Inverse, to allow for frequency conversions in the signal chain.
Conversions that use difference frequencies invert the spectrum; additive conversions do not.

Channel State Available options are auto, static, dynamic and fast dynamic. Using these options you can
match the receiver equalizer to the expected channel conditions. The recommended default
setting is auto.

NTSC
Rejection Filter

This setting gives you control over the integrated cochannel NTSC reject filter. Options are
On, Off and Auto. The recommended default setting is Auto.

Carrier Lock This setting allows you to control the carrier lock range. The Normal setting allows lock over
a ±150 kHz range; Wide extends the range to ±500 kHz. The recommended default setting
is Normal.

Tuner Phase
Noise (Normal
and High)

This control modifies the carrier loop bandwidth to allow the acquisition of noisy carriers.
Normal mode is recommended for general use.

8VSB controls

Signal
Detection

NTSC (National Television Standards Committee) and VSB (Vestigial Side Band).

Symbol
Distribution

This graph shows the samples received over time in a falling vertical line display. In a noise
free system, all samples would fall on one of the eight vertical lines. However, in normal
systems, the samples will be displayed distributed around the vertical lines. At the bottom of
the graph display, the sample values are accumulated into a distribution histogram. The
histogram can be displayed in a linear or logarithmic format.

Signal to Noise
(SNR) (after
equalizer)

The SNR values are plotted in a pen-trace style, giving a brief history of the collected values.

Equivalent
MER

An MER (Modulation Error Ratio) calculation is performed on the in-phase (I) data samples.
The quadrature data samples are ignored in this calculation.

8VSB
Instantaneous
Graphs

Equalizer The equalizer coefficients are plotted across the graph display. The display illustrates the
presence of multi-path echoes by indicating how the equalizer is adjusting to cancel them out.

NOTE. The Equalizer graph amplitude values are only approximate.
Trend Graphs The trend graphs extend the principle of the instantaneous graphs by graphing measurements

over longer periods
Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.
Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.
The following trend graphs are available for the 8VSB interface card: RF Lock, Equiv, MER,
EVM, Pre-RS BER, Input Level, SNR after Equalizer, and Carrier Offset.
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RF Interface - QPSK/8PSK The settings and displays of the QPSK/8PSK RF interface card are as follows:
QPSK/8PSK Interface Settings, QPSK/8PSK Instantaneous Graphs, and
QPSK/8PSK Trend Graphs.

Figure 1-39: Interface View - RF - QPSK/8PSK
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QPSK/8PSK Interface Settings. The following QPSK/8PSK settings are available
on the Open Transport Stream - Real Time Analysis dialog box, and also in the
Interface tab - Controls area

Table 1-9: QPSK/8PSK settings
Field Description

Tuner
Frequency
(kHz)

This value is the center frequency of the IF channel to be received (after downconversion in the
LNB where applicable). Any frequency can be entered; there is no need to follow a channel
plan. The frequency resolution is determined by the tuner step size of 1 MHz.

Symbol Rate
(kBaud)

This value is the symbol frequency (Baud rate) of the signal to be received, over a range
of 1 to 30 MBaud. You need to enter the symbol rate to a typical accuracy of 1000 ppm to
ensure successful lock.

Modulation
Format

The card supports a number of modulation formats: Turbo FEC 8PSK, Turbo FEC QPSK, DVB
QPSK and Digicipher™ II. Enter the appropriate format and puncture rate (also known as the
code rate) into the modulation dropdown dialog box. A Scan function is also provided, allowing
automatic acquisition if the precise code rate is not known.

LNB Power The QPSK/8PSK card incorporates a regulated power supply for control of a LNB (Low Noise
Block) or similar equipment. The supply voltage, using the drop down dialog box, is selectable
between Off (default), 13V and 18V. The output current is limited to 200 mA maximum, and is
foldback limited to a low value in the event of an overload.

QPSK/8PSK
controls

LNB 22 kHz
Tone

A 22 kHz tone is provided for control of an LNB (Low Noise Block) or similar equipment. The
tone, using the drop down dialog box, is selectable between Off (default) or On.

QPSK/8PSK
Instantaneous
Graphs

Constellation I and Q data are collected from the QAM front end and displayed as a conventional
constellation of 256 points by 256 points. The collected samples are not real time, so there is
some dwell (delay) before a complete constellation is displayed. The persistence of the display
can be varied using the Persist slider control at the bottom of the graph.
MER and EVM calculations are performed on the constellation data according to the formulas
given in TR 101 290.

QPSK/8PSK Trend Graphs The trend graphs extend the principle of the instantaneous graphs by graphing measurements
over longer periods
Each graph is associated with a measurement that is also displayed in the Readings panel on
the right side of the display. The measurements have status LEDs associated with them.
Individual trend graphs can be opened by making a selection from the drop-down menu of the
Trend graph or from the context menu of the measurement in the Readings panel.
The following trend graphs are available for the QPSK/8PSK interface card: RF Lock, MER,
EVM, Pre-RS BER, Input power, and SNR.
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IP Video Gigabit Ethernet Interface
The IP Video Interface tree view contains two primary nodes: IF Error Collection
and IF Warnings Collection as shown in the following figure. The secondary
nodes are specific to the IP Video interface. The detail views are contained under
five tabs: IP Tables, Diagnostics, Graphs, Interface Event Log, and All Session
Event Log.

Figure 1-40: Interface view - IP Video

IP Tables Tab The IP tables view contains the Multicast Database table, the IP Traffic table,
and the IP card readings panel.

Multicast Database. This table shows the multicast addresses that have been
added by the user. (See Figure 1-41.)

This table will be shown only when multicast subscription mode has been selected.

The table shows the status of the current multicast sessions: Join Requested,
Joined, Not Joined, Shadowed, Leave Pending, and Join Pending. Join Requested
is displayed when Join has been clicked and a message has been transmitted on
the network, but no traffic has yet been seen. As soon as traffic is detected, the
status will be updated to Join.

IP Traffic. The Traffic view as shown in the following figure displays all traffic,
including, for example, FTP (File Transfer Protocol) traffic and available IP
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sessions with rates higher than five network packets per second on the currently
selected interface (copper or optical)

The currently selected traffic is highlighted in this table. You cannot select
network streams that do not carry a transport stream. The column display can
be shown/hidden by selecting/deselecting headings from the column heading
context menu. The individual columns are described in the following table. If
a single subscription mode is selected, all sessions will be suspended except the
one currently subscribed.

Figure 1-41: IP Traffic view (tear-off view)

Table 1-10: IP Traffic view column descriptions
Field Description
Active Indicates the selected stream. The row is also bolded
Session Alias User allocated name
Source MAC Session source MAC address
Destination MAC Session target MAC address
Source IP Session source IP address
Destination IP Session target IP address
Source Port Session source IP port
Destination Port Session target IP port
VLAN Tag VLAN (Virtual Local Area Network) tag; "-" where not applicable.

Includes all parts of the VLAN information not just the identity
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Table 1-10: IP Traffic view column descriptions (cont.)

Field Description
Transport RTP (Real Time Protocol) or UDP (User Datagram Protocol)

(Others, such as FTP, are possible if there is a sustained flow of
another kind on the network)

Has TS Yes (check mark), if sync has been detected in this session. No,
if sync has not been detected in this session

Multicast Yes (check mark), if it is a multicast address
TTS (Time Stamp Transport Stream) Yes (check mark), if the session

is time-stamped.
TS Sync Error Yes (green), if no sync byte or sync loss errors have been

detected in the session since reset or startup
TS CC Errors MPEG CC (continuity count) error count in each session since

reset or startup
Pkt Error Total count of IP corrupted, lost packets, and out-of-order

packets in each session since reset or startup
PIT Error Yes (green), if the PIT (packet inter-arrival time) in each session

has not exceeded the user defined limit at any time since reset
or startup

MDI : DF (Media Delivery Index : Delay Factor) The MDI delay factor is
the maximum difference between calculated arrival of stream
data and the actual arrival

MDI : MLR (Media Delivery Index : Loss Rate) The MDI loss rate is the
count of lost or out-of-order flow packets over a predefined time
interval

Bit Rate (Kbps) Session bitrate (not the same as the stream bitrate, this includes
IP wrappers)

At the top of each of the IP tables (Multicast Database and IP Traffic) is a Show
filter option. You can use these to filter and limit the displayed items.

Readings. In this section, the IP Video interface readings are described. (See
Figure 1-42.) (See Table 1-11.)
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Previously configured setups are available in the Preset drop-down menu.
Selecting from the drop-down menu is equivalent to applying a configuration
in the Configure Interface dialog box. Use the Edit button to open the Edit
Interface Settings. (See page 1-18, Interface Card Configuration.)

Figure 1-42: IP Video interface Readings view (tear-off view)
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Table 1-11: IP Video interface readings
Field title Description Units
Link Information
Line Speed Shows the speed and type of the current physical connection to the

network. Line speed; 10, 100, 1000, 1000 (Optical), N/A. FDX - Full-duplex;
HDX - Half-duplex

NOTE. The IP Video interface card allows active network participation on
half-duplex connections. However, if there are issues with active traffic,
such as IGMP dropout, a full-duplex connection will be needed.

Mbps

Manual/DHCPv6 Address Manually entered address or address supplied by DHCPv6 server. -
Local Link Address The local link address is used for network address autoconfiguration where

no external source of network addressing information is available.
-

Stateless Address Unique IPv6 autoconfigured address. -
All Session Information

The All Session readings provide cumulative readings for the current multicast sessions.
Total Bit Rate Total bit rate on the currently selected copper/optical port including network

headers.
Kbps

Session Count The number of sessions present on the link. -
All Session IP Error Indicates the worst case packet error from all sessions.

NOTE. The All Session IP/PIT/TS error LEDs will turn red only when the
related limits defined on the Information screen are exceeded.

(Error LED)

All Session PIT Error Indicates the worst case PIT Error from all sessions. (Error LED)
All Session MDI Error Indicates the worst case media delivery index error from all sessions. (Error LED)
All Session TS Error Indicates compliance checking and sync errors for all sessions. (Error LED)
All Bit Rate Error Indicates bit rate errors for all sessions. (Error LED)
Selected Session Statistics

The Selected Session readings provide readings for the current session.
Lock The LED icon is green when the signal is in sync and is being received

normally. When a signal is present but no lock is achieved, the indicator is
red. When no signal is found, the indicator is gray.

(LED)

Session Bit Rate Bit rate of currently selected stream including network headers. Kbps
Min Packet Interarrival
Time

Minimum packet interarrival time (PIT) of the currently selected stream. ns

Mean Packet Interarrival
Time

Mean packet interarrival time (PIT) of the currently selected stream. ns

Max Packet Interarrival
Time

Maximum packet interarrival time (PIT) of the currently selected stream. ns

IP Errored Packet Rate The calculation is maintained per session on the interface card. The field
displays a red background if the rate is greater than zero.

pkt/min
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Table 1-11: IP Video interface readings (cont.)

Field title Description Units
IP Errored Packet Count Total IP packet error count since the last reset. The count is maintained

per session on the interface card, so that the count that is presented when
a stream is selected is since reset or startup, not since the session was
selected. The field displays a red background if the count is greater than
zero.

pkts

RTP Lost Packet Rate The calculation is maintained per session on the interface card. The field
displays a red background if the rate is greater than zero. This field is not
applicable (gray) if protocol is set to UDP.

pkt/min

RTP Lost Packet Count Total lost RTP packets since the last reset. The count is maintained per
session on the interface card, so the count that is presented when a stream
is selected is since reset or startup, and not since the session was selected.
The field displays a red background if the count is greater than zero. This
field is not applicable (gray) if the protocol is set to UDP.

pkts

RTP Out of Order Rate The calculation is maintained per session on the interface card. The field
displays a red background if the rate is greater than zero. This field is not
applicable (gray) if protocol is set to UDP.

pkt/min

RTP Out of Order Count RTP out of order packet total count (since last reset). Count is maintained
per session on the interface card, so the count that is presented when a
stream is selected is since reset or startup, and not since the session was
selected. The field displays a red background if the count is greater than
zero. This field is not applicable (gray) if protocol is set to UDP.

pkts

MDI Delay Factor (Media Delivery Index) The MDI delay factor is the maximum difference
between the calculated arrival of stream data and the actual arrival.

ms

MDI Media Loss Rate The MDI loss rate is the count of lost or out-of-order flow packets over
a predefined time interval.

TS pkts/s

TS CC Error Total MPEG CC errors on this session since reset or startup. The field
displays a red background if the count is greater than zero.

NOTE. The TS CC Error count may not equal the count shown in the
Analysis Tests view, for example TR101 290, test 1.4, Continuity. The
interface card starts counting before the MTM400 processor card, and will
continue to count per session, while the MTM400 monitors other sessions.

-

Locked Session Information
Source IP IP address of the currently monitored transport stream. -
Source Port Port that is currently receiving the transport stream. -
Destination IP IP address to which the transport stream is being sent. -
Destination Port Port to which the transport stream is being sent. -
Type of Service Type of service field of the transport stream IP packets. -
Datagram Size Datagram size of the transport stream IP packets. bytes
VLAN Tag Virtual Local Area Network (VLAN) tag displayed in hex format. This is a

two byte value containing priority bit, canonical format indicator (CFI), and
VLAN ID (VID).

-
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Diagnostics Tab This tab displays ping results in the same format as the DOS ping program. The
results include round trip time, TTL, and time-out messages. The results will be
shown in this table after the Ping button is clicked. The address format, IPv4 or
IPv6, should be selected in accord with the address format used.

Figure 1-43: IP Video interface - Diagnostics
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Graphs Tab This tab allows a range of measurements to be displayed in graphical form.
Readings are also displayed. (See page 1-90, Readings.)

Figure 1-44: IP Video interface graphs (tear-off view)

The following trend graphs are available: Lock, Corrupt Packet Rate, Dropped
Packet Rate, Packet Inter-Arrival Time (Peak and Average), Out-of-Order Packet
Rate, MDI Delay Factor, and MDI Loss Rate. The period over which the trend
values are displayed can be selected from the Trend Timescale drop-down menu
or from the graph context menus.

On some trend graphs, peak readings are shown in gray; the average readings
are shown a single line.

Also available are graphs of the selected session bit rate and session cumulative
bit rate (the sum of bit rates of all sessions).

Interface Event Log This log collects all of the interface errors in a single log file. The log can be saved
for detailed examination and manipulation.

All Session Event Log This log collects all events. Apart from displaying all events, two other subsets of
all events can be selected from a drop-down list and displayed, that is Selected
Stream Events and All IP Session Events.
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IP Video Interface Notes The following notes are included to assist with the setup and operation of the
IP Video interface card. Click the Interface button in the toolbar to access the
interface setup.

Before connecting to the network under test, enter a valid Input Card IP
address on the interface configuration dialog box, otherwise any router or
switch that is connected may add an invalid IP address to its own ARP table
(which may have a long time-out).

If the Input Card IP is 0.0.0.0, you cannot be active on the network. Similarly,
if the Input Card MAC is 00-00-00-00-00-00, you cannot be active on the
network. In the latter case, the IP Video card may have been incorrectly
configured.

A MAC address is allocated to the IP Video interface card during manufacture.
If required, you can change it using the Configure Interface dialog box.

The MAC and IP addresses of the IP Video interface card must be configured
before any of the other IP Video interface settings.

The Network Interaction setting must be one of the active options when you
are trying to send or receive pings on the network or when you are acting as
an end point for unicast and multicast traffic.

IGMP (Internet Group Management Protocol) join and ping commands cannot
be sent when the Network Interaction mode is set to passive.

An SFP (Small Format Pluggable) module is used to facilitate the Ethernet
Optical interconnection feature. The IP Video interface card has been tested
with SFP module(s) ordered from Tektronix. SFP modules purchased from a
supplier other than Tektronix are not warranted to work.

Only optical SFPs are supported; copper SFPs are not supported.

Only full duplex operation is supported by the IP Video interface card.

Traffic flows are displayed in the Traffic screen only if they have a total packet
rate of > 5 network packets per second.

The Traffic screen will show all traffic, for example, FTP. For non-transport
streams, the MTS400 Series instrument will perform IP level tests only.

Only transport streams can be selected for monitoring; transport streams are
indicated by a check mark in the TS column.
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GbE Video over IP Interface
GbE Interface setup is done in the Real-time Interface opening dialog box. No
Interface tab is displayed. An IP Graphs detail tab is added to the Programs view
as shown in the following figure.

Figure 1-45: GbE interface - IP Graphs

The following graphs are available: Packet Interarrival Time (PIT), PIT
Histogram, Ethernet Flow Rate, Delay Factor, and Media Loss Rate.

A number if IP specific proprietary tests are added to the Tests tree.
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Common User Interface Concepts
Many user interface concepts are used throughout the analyzer. The following
common elements are described in this section:

Windows Management

Icons

Graph Management

Timing Graphs

Bit Rate Graphs

PIT Graph

Now Playing Views

Parameter Edit

Event Logs

Bit Rates

EPG View

MPE Views

CaptureVu Features

Triggered Recording

Menu Bar and Options

Preferences

Script Files

Windows Management

NOTE. For basic Windows operations, such as minimizing windows or using the
scroll bars, refer to the MS Windows documentation.
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In addition to the standard windows management methods, the following controls
are added which allow the windows panes to be resized.

Horizontal and Vertical
Controls

Horizontal and vertical control icons are placed between adjacent panes. Clicking
on an icon will expand the adjacent pane in the direction shown by the icon.

Figure 1-46: Window size adjustments

The size of panes can also be controlled by placing the cursor over the horizontal
or vertical dividing bar so that it changes to a bidirectional arrow. The dividing
bar can then be dragged to the required position as shown in the following figure.

Table Manipulation The following activities are available for data displayed in tabular form:

Click a column header label to sort the section in ascending or descending
order

Drag a column header label divider bar to adjust the column width
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Select Resize All Columns to Fit from the context menu to adjust all columns
to fit the available display width

Columns can be hidden or shown by selecting them in the header label
context menu

Icons
Icons are used in the TSCA to convey information about a node or function.

In this section, the icons used in the TSCA and the icons used in the quick link
section of context menus are described. (See Table 1-12.) (See Table 1-13.) (See
Table 1-14.)

NOTE. The display of all icons is context-dependent. Not all icons will be visible
in all views.

Table 1-12: Object identification icons
Icon Description

Application Information Table (MHP)

Audio

Conditional Access PID

Data stream

Packet

PCR

Program

Programs

SI table

SI table container

SI tables

Stream scrambled
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Table 1-12: Object identification icons (cont.)

Icon Description
Subtitles

Teletext

Video

Video + audio

Closed caption - CC-EIA608

Closed caption - CC-EIA708

Table 1-13: Interface management icons
Icon Description

Open transport stream

View CaptureVu settings

Capture analysis

Bar chart

Pie chart

Stacked graph chart
Link to

Preferences

Audible alarm

CaptureVu breakpoint

Graph management
Graph selection

Zoom in

Zoom out
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Table 1-13: Interface management icons (cont.)

Icon Description
Show full dataset

Hide/show limits

Hide/show settling time indicators

Rotate graph view

Packet management
Remove all PID packets

Remove PID packet

Add PID packet

PID packet group

PID packet placeholder

Go to first packet

Go to previous packet

Go to next packet

Go to last packet

Open Go To Packet dialog box

Action control
Go to previous view

Go to next view

Table 1-14: Quick link icons
Icon Description

Go to next red LED in current tree

View this PID in PID tree

View packets with this PID
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Table 1-14: Quick link icons (cont.)

Icon Description
View packets in Packet tree
View PCR graphs

View this program’s PMT in SI tree

View this test in Tests tree

Graph Management
A number of screens displaying graphs are available in the analyzer. The graphs
are described in the relevant sections of this manual. This section describes the
management of the graphs user interface.

Four categories of graph are available: PCR measurements, section timing, bit
rates, and PTS (Presentation Time Stamps).

PCR measurement graphs include:

PCR Drift

PCR Inaccuracy

PCR Arrival Interval

PCR Frequency Offset

PCR Overall Jitter

PTS - PCR Variation

DTS - PCR Variation

PTS interval graphs include:

PTS value interval

PTS arrival interval

Section timing graphs include:

Section Repetition Interval

Subtable Inter Section Gap

Subtable Repetition Interval

For streams received over IP, the PIT (packet interarrival time) graph is available.
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The graphs that can be displayed depend on the selection made in the navigation
view. However, the menus and options for the graphs are similar and as described
in the following pages.

Measurement Background Measurement points (2048 maximum) are held in a circular buffer.

NOTE. A circular buffer is an area of memory used to store a continuous stream
of data by starting again at the beginning of the buffer after reaching the end.

A graph set for full display will show the current measurement points. During
real-time analysis, the graph is constantly being filled (from the right to left), and
measurements moving off the left side of the display are lost. The time scale
(Y-axis) is started from zero each time that the node is accessed.

For some of the graphs, sufficient data must be gathered before meaningful results
can be displayed. The phrase "Settling Time" will be displayed briefly in the
graph area while the necessary data is gathered.

Overview The following figure shows a typical timing graph display. In this example, a
PID carrying PCR has been selected, and two graphs are displayed: PTS Arrival
Interval and PCR Arrival Interval.

Figure 1-47: Timing graphs
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Within the category, the X axis is common to all graphs. A horizontal scroll
bar allows you to select an area for inspection when the graph extends beyond
the display area.

Cursor Data and Control A cursor can be displayed on the graphs, allowing you to see accurate
measurements in the adjacent data panel. You can place the cursor by clicking
any data point on one of the graphs. Note that the cursor is displayed at the same
point on all of the visible graphs. (See Figure 1-47.)

When you select a point, a tooltip provides the X and Y coordinates of the point;
the values of these will vary depending on the graph.

Data associated with the selected point is displayed in the statistics panel (above
the graphs). The displayed values (maximum, minimum, mean and standard
deviation) are calculated for all of the data that is received while the navigator
node is highlighted.

Similarly, data for all graphs is displayed in the Data at Cursor panel. A link to the
associated packet is provided in the context menu.

The cursor can be moved either by clicking a new position on the graph, or one
point at a time by using the left or right controls on the keyboard.

Graph Menu and Toolbar The Graph Toolbar allows you to select and control the available graphs. (See
Figure 1-48.) The graphs listed will depend on the interface in use.

Figure 1-48: Graph toolbar

At the left end of the toolbar, a drop-down menu allows you to select which
graphs are to be displayed. Only graphs for which data is available are listed. (See
page 1-109, Timing Graphs.)

MTS400 Series Analyzer Applications User Manual 1–105



Common User Interface Concepts

The remaining graph controls are as follows:

Icon Description
Zoom in

Zoom out

Return graphs to full scale display (All graphs can be returned
to full display by double-clicking anywhere in the graph display
area.)
Hide/show out-of-range indicators

Hide/show settling time

Rotate graph layout

The graph context menu can be displayed by right-clicking anywhere in a graph
display area. The options on the menu are applicable to only the graph from
which the menu was selected.

Figure 1-49: Graph context menu

The title bar displayed at the top of the menu shows which object the graph
applies to (for example, PID 600).

Adding and Removing
Graphs

Graphs can be added by selecting them from the context menu or from the
drop-down menu either in the toolbar or from the top right corner of any displayed
graph. All graphs can be opened by selecting Add All Graphs from the same
menu. Each graph type can only be displayed once.

Graphs can be removed by clearing them from the context menu or by clicking the
close icon in the top right corner of the graph to be closed.

Out of Range Indicators Each graphed measurement has limits set by default (derived from the stream
interpretation standard) or that you modify. (See page 1-117, Parameter Edit.)
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Limits imposed by the test parameters can be displayed on a graph by clicking the
Out of Range indicator icon. (See Figure 1-50.)In this example, the PTS Arrival
Interval has been set at 700 ms. The area outside the limits is shaded (red). The Y
axis is rescaled to show the maximum and minimum data points.

Settling Time Some of the graphs in the TSCA require a number of samples to be available
before meaningful results can be displayed. The period during which sufficient
samples are being gathered is referred to as the settling time. During this settling
time, the graph is grayed out and displays the phrase "Settling Time".

Zoom Feature You can zoom graphs in and out using the controls on the menu bar or from the
Graph Menu. An area of a graph can also be expanded by holding the right mouse
button and dragging a rectangle around the area of interest.

Zooming (in or out) is centered on the middle point of the graph, irrespective
of the cursor position. Both axes are expanded/contracted to accommodate the
revised display. The graph is expanded or contracted by 25% of the displayed area
each time that the control is used. Double-clicking on a graph rescales the axes
to show the complete plotted data set.

If you hold the shift key while you click the zoom control, the Y axis is locked
while the X axis is expanded or contracted.

If you hold the control key while you click the zoom control, the X axis locked
while the Y axis is expanded or contracted.
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During real-time analysis, expanding (zooming in) an area of a graph generates a
static snapshot of the graph. Because of the way that the measurements are stored
in the circular buffer, the display will eventually clear. The only way to redisplay
the graph is to return to full-scale display.

Figure 1-50: Out of range indicator
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Timing Graphs
The following table shows the timing graphs that are available for PIDs carrying
PCRs. If a PCR PID is also carrying time stamp information, the full set of graphs
will be available. (See page 1-103, Graph Management.)

Table 1-15: Timing measurement graphs
Graph Type PID + PCR PID + PCR + Timestamps
PCR Inaccuracy
PCR Arrival Interval
PCR Drift Rate -
PCR Frequency Offset -
PCR Overall Jitter -

Descriptions follow of each of the measurements. Adjustments can be made to
each of the measurement parameters.

If the interval exceeds the limits displayed on the screen, the scale is adjusted
automatically as necessary to include the maximum displayed values.

NOTE. As with other parameter value adjustments, it is important to note where
the adjustment is being made from. If the adjustment is made with a test node
highlighted, all PIDs will be measured against that value. If the adjustment is
made with a PID highlighted, only that PID will be measured against the modified
value.

PCR Inaccuracy (PCR_AC) PCR graph: Inaccuracy The PCR Inaccuracy graph shows the difference between
the actual and expected values for each PCR on the Y-axis. Expected PCR values
are calculated from the byte index of the PCR.

The default limits are set to ±500 ns.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR accuracy error.

PCR Arrival Interval The PCR Arrival Interval graph provides a display of the time interval between
successive PCRs, during the last 256 PCRs. The interval is displayed on the
Y-axis. The default limit (Maximum Repetition Period set in TR 101 290 test
2.3) is 40 ms.

The PCR Maximum Repetition Interval limit can be adjusted by modifying the
PCR max repetition interval.

PCR Drift Rate (PCR_DR) This Drift Rate graph shows the rate of change of PCR Frequency Offset, which is
often very small. It is calculated using PCR Frequency Offset measurements.
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The maximum PCR Drift Rate limit can be adjusted by modifying the Max PCR
frequency drift rate parameter.

PCR Frequency Offset
(PCR_FO)

The Frequency Offset graph shows the difference between the program clock
frequency and the nominal clock frequency (measured against a reference that is
not PCR or transport stream derived).

PCR Frequency Offset is a measurement of the error in the PCR frequency from
the specified 27 MHz; the MPEG specification sets the limits at±810 Hz.

The Maximum PCR Frequency Offset limit can be adjusted by modifying the
"Max PCR frequency offset" parameter.

PCR Overall Jitter
(PCR_OJ)

The PCR Overall Jitter graph shows the time interval between the actual value of
the PCR and its expected value based on its arrival time.

The Maximum PCR Accuracy Error limit can be adjusted by modifying the Max
PCR overall jitter parameter.

PTS and DTS Graphs Decode Time Stamps (DTS) and Presentation Time Stamps (PTS) indicate the
exact moment at which a video or audio frame has to be decoded or presented
to the user. The values of these time stamps are references to the program time
base, as indicated by the program’s associated PCR.

The decoding and presentation times for a frame will be different if the frames are
not transmitted in the order that they should be presented, that is, in video streams.
In streams which are not reordered, for example, audio streams, the PTS and
DTS values for a frame are identical.

The following PTS/DTS graphs are available for non-encrypted elementary
streams carrying PTS data:

PTS Value Interval. The PTS Value Interval graph plots the difference in value
between each PTS and the prior PTS. The time stamp value difference is displayed
in terms of time.

PTS Arrival Interval. The PTS Arrival Interval graph shows the difference in
arrival time between each PTS and the prior PTS.

PTS-PCR Variation. The PTS-PCR Variation graph plots the difference between
each PTS value and the value of the program time base at the moment the PTS
arrived. The program time base value at that point is interpolated from the
associated PCR values. The measurement is displayed in terms of time, and gives
an indication of how long after receiving the frame the decoder must wait before
presenting it to the user.

DTS-PCR Variation. The DTS-PCR Variation graph shows the difference between
each DTS value and the value of the program time base at the moment the DTS
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arrived. The program time base value is calculated in the same way as for the
PTS-PCR Variation graph. For video streams this graph is likely to differ from the
PTS-PCR graph, but for non-reordered streams it will display the same values.

The PTS-PCR and DTS-PCR graphs can be useful for detecting encoder timing
issues that are likely to cause receiver T-STD problems.

PTS Processing for PES
Private Stream Types

The default behavior of the TSCA is to perform PTS, and DTS, where applicable,
measurements on audio and video PIDs. For PES Private (stream type 6) PIDs,
these measurements are only carried out for PIDs that are recognized as carrying
subtitle/closed caption information.

A parameter has been added that can override this automatic detection of
PES Private PIDs. The behavior can be changed for all PIDs by opening the
configuration dialog: Settings > Configuration… > Test Parameters. Locate
and set the parameter Process PTS for PES Private streams.

Set the value to 0 to select the default automatic behavior.
PIDs with stream type 6 will be processed only for PTS/DTS measurements if
the TSCA recognizes them as carrying subtitles and/or teletext.

Set the value to 1 to force the TSCA to perform PTS/DTS measurements for
all PIDs with stream type 6.

Set the value to 2 to disable the PTS/DTS measurements for those PIDs with
stream type 6.

This parameter can also be adjusted for a specific PID. Highlight the required PID
in the PID view, and select Edit Parameters from the 2.5 PTS context menu in
the Associated Tests tab. This method affects the behavior of the selected PID
only, and will only take effect if the PID is marked as stream type 6 in a PMT.
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Bit Rate Graphs
Bit rate graphs are available on program and PID nodes. (See page 1-103, Graph
Management.)

Figure 1-51: Bit rate graph
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PIT Graph
The PIT Graph displays the mean interarrival time of IP packets. This can be
viewed from the Transport Stream node in the Program view. It can also be
viewed alongside other timing graphs for PIDs with PTS, DTS, and/or PCR
information. This can help you coordinate apparent problems with PCR, PTS,
and DTS timing with IP packet timing.

RTP Loss Distribution Graph
The RTP Loss distribution graph is available when analyzing transport streams
carried using RTP in real-time, using the IP Video Gigabit Ethernet interface
card or the internal NIC, or in file based analysis (PCAP). The graph shows
the distribution of RTP packet losses by plotting loss duration (the number of
consecutive packets lost) against loss distance (the distance between one block of
lost packets and the previous block). The color of each point represents the count
of occurrences of losses with a particular loss duration and distance.

To access the graph while analyzing an RTP stream, select the transport stream
node in the Programs tree, and select the RTP Losses tab in the detail view.
Note that any losses that occur outside of the range of the graph are captured and
displayed in aggregate form at the top and on the right side of the graph. The
limits can be changed by selecting the Edit Parameters… button.
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The Edit Parameters dialog box allows you to alter the loss duration and loss
distance values which will increase or decrease the X and Y axis ranges.
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Thumbnail Views
The Thumbnails tab displays video content at the transport stream and program
node levels. Icons at the top right of the now playing screen provide three levels
of detail and layout of the thumbnails: Thumbnails only, Brief Details, and Full
Summary. The following figures in this section illustrate the level of detail
provided by each icon.

The content of each program node can be viewed in more detail by clicking
the play button. This assumes that a suitable player application is installed, for
example, VLC Media Player.

In file analysis mode only, the program node content can be further analyzed
using the MTS4CC Elementary Stream Compliance Analyzer or the MTS4EA
Elementary Stream Analyzer (ESA). Select the ES button to open the analyzer.
The ES button will be hidden if either of the ESA applications is not detected
when the TSCA starts.

Figure 1-52: Thumbnail view - Thumbnail view
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Figure 1-53: Now Playing - Summary view

Figure 1-54: Now Playing - Detail view
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Parameter Edit
Each of the error states displayed on the user interface are the result of making one
or more measurements or tests on the analyzed transport stream. The displayed
tests are derived from the selected interpretation standard. Additional proprietary
tests are also included.

Some measurements and tests translate directly to an error state, and others are the
result of a combination of tests. For many of the tests, you can affect the result
by varying parameters that influence the test result, for example, maximum and
minimum bit rate values, although the test result may not then conform to the
chosen interpretation standard.

The Edit Parameters window is available from test and PID context menus. The
following figure shows the parameters that are available for the TR 101 290 test
2.5. The PID test parameters dialog box shows the subset of parameters that are
available for a single PID under TR 101 290 test 2.5. (See Figure 1-56.) Not
all parameters applied to a test are necessarily applied to a PID, and not all test
have configurable parameters.

Figure 1-55: Test parameters
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Figure 1-56: PID test parameters

Each test parameter entry includes the following fields:

Description of the parameter.

Value - the current setting. If the setting is the same as the nominal value, an
icon will also be displayed in this field.

Units in which the measurement is made.

Maximum and minimum values. These are the maximum and minimum
values recommended by the selected standard.

Nominal value. This is the value or setting recommended by the selected
interpretation standard.

It is important to understand the difference between default and nominal values.
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If a parameter value is set for a test, it becomes the default value for the test and
for all PIDs subject to that test. PIDs using the default value will have a bullet
icon displayed in the Value field as shown in the following figure.

Figure 1-57: Parameter value - default icon

However, you can also set individual PID parameter values. The value set is
applied to only that PID, not to the other PIDs using the same test or the test
default value.

The nominal value is provided by the interpretation standard; it cannot be changed
using the user interface.

Changing a Test Parameter
Value

To change the value of a test parameter:

1. Click in the Value field.

2. Enter the required value.

3. Press Enter.

NOTE. For a new value to take effect during offline analysis, the stream must be
closed. Select Restart Analysis to open and reanalyze the stream.

Access to All Parameters (See page 1-142, Configuration.)

Event Log
The event log displays a history of events related to a selected item. When no log
is available, the message "No log entries were found" is displayed. In a log, events
are placed in chronological order (with the most recent at the top).

Event log displays are context-dependent; the view and object that is currently
selected will dictate the content of the associated log. For example, with the
transport stream node selected in the Programs navigation view, the associated
event log displays all events. Similarly, with a single PID selected, the associated
event log only displays events relevant to that PID. Exported logs are similarly
context-dependent; only currently displayed events are exported.
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Event Log Control The event log normally displays the most recent event at the top of the log. Past
events are scrolled down the screen; not all of these event entries can be viewed
on a single screen, even in a maximized Log View window.

If events are constantly being generated, an event entry may pass out of view
before you have a chance to examine it.

However, if you scroll down to view a past event, the viewing window will
remain fixed on that entry, even though events entries are still being added at the
top of the log view. This is evidenced by the scroll box continuing to advance
toward the bottom of the screen.

The event entry being viewed will eventually move to the bottom of the event log.
At this point the entry will be lost, the view will return to the most recent entries
at the top of the screen, and automatic scrolling will restart.

Event Log Pinning Another way of viewing a single event in a stream of log events is by pinning the
log. By pinning the log, you are taking a snapshot of the log at a particular moment
in time; you can move up and down the pinned log as required. Newly generated
events continue to be generated, but are not displayed until the log is unpinned.

You can pin the log by selecting the Pin icon or Pin Log from the context menu.

Shows that the log is not pinned
Select to pin the log
Shows that the log is pinned
Select to unpin the log

When the log is pinned, it displays against a blue background and the pin icon
changes.

Pinning the log may take a few seconds. The whole log is saved, up to 1000
entries.

The log will remain pinned until you select the Pin icon or display another TSCA
view.

Exporting the Event Log You can export the log (pinned or unpinned) in either XML or CSV format.

You can export the log by selecting the Export icon or Export Log from the
context menu.

Select the format in which the log file is to be saved, either xml or csv, and
a location for the file.
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Clearing the Event Log You can clear all events from the event log by selecting the X icon or Clear Log
from the context menu.

Color-Coding Events Specific event types can be color-coded in the display to allow them to be
identified more easily as shown in the following figure. Color-coding can be
done from any event log display. The color-coding dialog box is available from
the event log context menu.

Figure 1-58: Event log - color coding

1. Highlight the event type and select Color from the context menu as shown in
the following figure. The following figure shows the Color dialog box.

Figure 1-59: Event log - context menu - color
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Figure 1-60: Event log - color dialog boxes

2. Select the primary display color.

The color can be specified from the Swatches tab. It can also be specified
in HSB (Hue, Saturation, Brightness) or RGB (Red, Green, Blue) terms by
selecting the appropriate tab and entering the required values.

3. Select OK. All events of the same type are now highlighted in the selected
color.

The color-coding on a single event type can be removed by selecting Reset Color
from the Event Log context menu. Color-coding can be removed from all event
types by selecting Reset All Colors from the context menu.

Bit Rates
In a stream, bit rates are calculated and displayed for the following:

Transport stream

Programs

PIDs
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The bit rates can be displayed in graphical form as a bar chart or a pie chart. The
management is similar for each graph type. In addition, a historical multiplex
graph can be displayed at the transport stream level.

Select the appropriate icon to switch charts:

Figure 1-61: Bit Rate display selection

Bar Charts The following information is included with the bit rate bar charts:

Error status (LED)

Object name (Program or PID name)

Stream type (PIDs only)

Bit rate bar including change bars and limit markers, where relevant

Bit rate statistics (including the current bit rate, the bit rate expressed as a
percentage of the overall bit rate, and the maximum and minimum values
reached during analysis).

Figure 1-62: Bar chart

The bit rate bars are scaled so that all bars are displayed relative to the one with
the highest bit rate.

Column widths can be adjusted by dragging the line dividing the title bar to the
left or right with the mouse.
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Error Indication Two levels of error status are displayed in each row. The error status LED shows
the test status of the element, for example, a program. The color of the bit rate
bar indicates the bit rate status and whether the rate has exceeded the limits that
were set.

Range Bar A range bar indicates the variation of bit rate in each program or PID. The ends of
the bar show the maximum and minimum values of the bit rate since monitoring
started.

Bit Rate Limits Bit rate limits can be set on a program or PID bar. An error will be indicated
when the bit rate exceeds the limits set.

You can highlight the program or PID and select Set Bit Rate Limits from the
context menu.
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The Set Bit Rate Limits dialog box opens:

You can enable the limits by selecting the Enable Limit checkboxes and entering
the required values. The cursor in the bar indicates the current bit rate. The limits
can also be changed by dragging the limit icons in the dialog box to the required
positions. The color of the overall bar in the limits dialog box indicates whether
the current bit rate is within the proposed limits. Select OK to close the dialog
box. The limit icons will now be displayed on the bit rate bar. The scaling of all
bars is recalculated to ensure that the maximum limit is displayed.

During file analysis, you must close and reopen the file to reanalyze it and view
the effects of the limits. Real-time limits take effect immediately. Limit values
are retained when the application is closed. Limits set for specific PIDs will be
applied (to a PID with the same number) irrespective of the stream being analyzed.

Setting (and resetting) the bit rate limits for programs and PIDs will automatically
update the Program Occupancy and PID Occupancy tests. To change the transport
stream bit rate limits, the parameters must be altered directly in the Transport
Stream Occupancy test. This can be found under the Other tab in the Tests view.

The Bit Rate Limits of all programs in a stream can be disabled and reset by
selecting the Clear Limits button at the top of the Programs screen.
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Pie Charts The information shown in the pie chart is similar to the information shown in
the bar chart.

Figure 1-63: Pie chart

The pie chart view is divided into two panes. The left pane shows the pie chart,
and the right pane provides a list of the component programs. Each program is
color-coded. Related information given includes the overall program status (icon),
the program name and number, and the bit rate (bps). The bit rate expressed as a
percentage of the overall bit rate is displayed in the segment labels. The maximum
and minimum values are not shown.

Labels for individual segments can be displayed by holding the mouse button
down over the segment. All labels can be displayed by double-clicking anywhere
on the pie chart. If a segment label is hidden at the edge of the window, click on
a segment to display the label in full.
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Historical Multiplex Graph This graph shows the bit rates for all programs in stacked area format. You can
select the time period over which the graph is calculated from the Time period
drop-down list.

EPG View
An electronic program guide (EPG), where present, is a schedule of events and
programs that are or will be available on each service. A short summary or
commentary for each event may also be included. Events for services that are
actually carried in the stream are referred to as "actual" and as "present" or as
"following" (labeled as "EIT actual p/f" in the navigation view).

A transport stream may also carry EPG information for other network services,
referred to as "other" (labeled as "EIT other p/f" in the navigation view).

NOTE. The examples shown in the figures in this section are of DVB transport
streams. The construction of SI and node names in ATSC and ISDB streams differ.

The EPG node in the navigation view contains and displays all of the program
information carried in the transport stream.
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The content of the Detail view will depend on the currently highlighted EPG table
node. Nodes representing an individual table or subtable will offer the usual
Summary, Section, and SI Repetition graph detail views. However, the higher
nodes will display the programming information graphically as shown in the
following figure.

Figure 1-64: EPG Summary view
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EPG Node Summary

Figure 1-65: EPG nodes

For each node type, the detail view shows the following information:

EPG node Links to the EPG information for all the transport streams
described in this stream.

Transport stream
summary nodes

Graphical view of the events identified in the service(s) belonging
to a specific transport stream.

SDT nodes (Service
Description Table):

Links to services identified in the SI for a specific transport
stream.

Service summary
nodes

Graphical view of the events identified in the service.

EIT nodes Detailed view of event information for a single EIT subtable.

EPG Summary View The elements highlighted in the EPG Summary View screen are described in
the following table: (See Figure 1-64.)

Item Description
Title bar Displays the title of the currently highlighted service or transport

stream.
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Item Description
Display Time Zone Select the required time zone from the drop-down list. The time

scale will change accordingly. The time zone may be derived
either from the transport stream, UTC (Co-coordinated Universal
Time), or local time (as set on the host computer).

Start Time Shows the event panel start time and date. Other dates can
be selected from the drop-down calendar, and the display will
scroll to the selected date.
In deferred mode, the initial date and time will be dictated by the
information found in the stream. If the selected date is beyond
that held in the EPG information, the date will be automatically
set to the last date held in the information.
In real-time mode, this information is updated regularly.

Display Shows the extent of the event panel. More detail can be
displayed by choosing a shorter time period. Select the required
range from the drop-down list.

Timescale Shows the start and end time of the current event panel. The
range is dictated by the Display field selection.

Service/Subtable panel When a transport stream EPG is selected, this panel shows the
names of the services currently displayed in the event panel.
The displayed services will vary depending on which node is
selected in the navigation view.

Event panel This panel shows the events for one or more services, depending
on the selected node. Individual events are color-coded and
shown as blocks; each block (and its associated tooltip) displays
event information that is extracted from the EIT. When a block
is selected, the complete event information is shown in the
event detail panel, including a link to the section carrying the
information.

Event detail panel Shows details of the selected event. The details are contained
in the EIT (event information table).

Events are color-coded as follows:

Red: Present event

Green: Following event

Blue: Schedule event

Yellow: (ISDB only) After event
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ATSC EPG Rating and closed caption information carried in ATSC EITs is displayed in the
ATSC EPG view. The consistency of closed caption signalling between the PMT,
EIT, and the closed caption content of video streams (Stream Tests > Other >
Miscellaneous > Closed Caption Error) is tested. The presence or absence of
CEA-608 and CEA-708 closed captioning is displayed next to thumbnails for
video streams, along with the current program rating information as signalled in
the EIT. The following thumbnail illustration shows the closed caption presence
indication.
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MPE Views
Multi-Protocol Encapsulation (MPE) provides a mechanism for transporting data
network protocols on top of the MPEG-2 transport streams in DVB networks.
MPE data has been optimized to carry the internet protocol (IP). MPE covers
unicast (datagrams targeted to a single receiver), multicast (datagrams targeted to
a group of receivers), and broadcast (datagrams targeted to all receivers). The 48
bit MAC (Media Access Control) addresses are used for addressing receivers.

The MPE views display the MPE data flow that is available in the stream.

Figure 1-66: MPE view

CaptureVu Feature
The CaptureVu feature allows you to capture and analyze system events during
deferred or real-time analysis to debug the intermittent and complex problems
that traditional analyzers miss.

The feature can be activated either manually by selecting the Capture button
during analysis or automatically by a CaptureVu breakpoint preset on a test. For
deferred analysis, a packet number can be identified, at which analysis will stop.
Any of these actions freezes the analysis and allows details of the analysis up to
that moment to be examined.
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Links to the packet and the test (where applicable) at the point at which the
Capture button was pressed or a designated test failed are displayed in the
CaptureVu Settings dialog box.

NOTE. If a recurring test failure needs to be examined in its true context, it is
advisable to make a triggered recording. With pretriggering set, it is then possible
to examine the events surrounding a test failure. (See page 1-135, Triggered
Recording.)

Setting Up the CaptureVu
Feature

The feature can be activated when a test flagged with a CaptureVu breakpoint
does not fall within the parameters set for the test. Breakpoints can be set at any
time. They will be activated during real-time analysis as soon as the flagged
test fails. To operate successfully in a deferred analysis stream, the stream may
need to be reanalyzed.

You can set a CaptureVu breakpoint as follows:

1. In either the Program or Tests view, locate and highlight the required test.

2. From the context menu, select CaptureVu Breakpoint.
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Note the addition of the breakpoint icon beside the test entry.

The CaptureVu breakpoint is now set. You can set as many breakpoints as you
require. The next time an error is detected on any breakpoint test, analysis
(real-time or deferred) will stop and the test will be identified.

CaptureVu Analysis The CaptureVu breakpoint will operate during real-time and during deferred
analysis. The CaptureVu Settings dialog box is displayed as soon as a breakpoint
is reached or the CaptureVu feature is activated from the toolbar.
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The State panel in the CaptureVu Status dialog box displays the test and packet in
which the test has failed when a breakpoint has been set. Clicking either the test
or the packet identity will open the related view (Tests or Packets) and highlight
the test or packet.

You can activate this dialog box when the breakpoint triggers. When enabled, the
CaptureVu setting dialog box is opened automatically when a breakpoint occurs.

The CaptureVu Settings dialog box can also be viewed at any time by selecting
the CaptureVu Settings button on the toolbar.

With the CaptureVu feature activated, all of the TSCA tools are available for you
to analyze and inspect the saved information.

NOTE. In Packets view, only the packets contained in the last 200 MB are
available for analysis.

Resuming Analysis You can resume deferred analysis by selecting the Resume Analysis button from
the dialog box or the toolbar.

NOTE. When you select the Resume Analysis button, analysis will continue from
the point at which analysis was paused.

Similarly, you can resume real-time analysis by selecting the Restart Analysis
button from the dialog box or the toolbar.

NOTE. While real-time analysis is paused, further analysis is stopped. When the
Restart Analysis button is pressed, analysis is restarted at the current time.

Triggered Recording
During real-time analysis, stream information can only be held for a finite time.
Eventually, the stream will be overwritten by more up-to-date information.

To examine events that occur in real-time mode more closely, recordings can be
made manually or automatically. Recordings are saved to hard disk and can be
subsequently analyzed and examined in more detail.

The Triggered Recording setup is accessed using Record > Record Settings on
the menu bar; the Recording Settings dialog box is displayed. The dialog fields
are described in the following illustration and text:
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Figure 1-67: Record Settings dialog box

Table 1-16: Record settings
Command Function
Source selection Record transport stream packets in an mpeg file (default selection).
Source
Selection

Transport Record transport stream packets in an mpeg file (default selection).

PCAP Record the network packets in a PCAP file.
PCAP
Nanosecond
Format

Record the network packets in a PCAP file with nanosecond timestamps.
The PCAP settings are available only when the GbE Video over IP interface is installed.

Status bar Indicates the trigger status (Ready, Armed, Recording, or Complete) and the pretrigger/recording
progress. The status and progress are also displayed on the toolbar in the main window.
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Table 1-16: Record settings (cont.)

Command Function
Path Enter the file name and path for the recording or use the browse button to find and select an

existing file name. If this file name already exists, you must approve the overwriting of the
old file when recording is initiated.

File Size Enter the file size required in megabytes. For example, for a stream at 30 Mbps, a file size of
600 MB would record approximately 160 seconds of stream information.

Target file

Pretrigger A proportion of a stream can be recorded before a trigger event occurs. (See page 1-138,
Pretrigger Recording.) Enter the pretrigger size (as a percentage of file size) that is to be
recorded. (Pretrigger is not available when recording from an IP input.)

PID Filter PID numbers cannot be entered directly into the PIDs field. Use the adjacent browse button to
open the Select PIDs dialog box and select PIDs to be recorded. The resulting recorded stream
will contain only the identified PIDs. (See page 1-139, PID Selection.)

Trigger The event that triggers the recording can be one of four types, selected from the drop-down list.
In each case, the trigger is set and pretrigger recording starts when Arm is selected. Pretrigger
recording must be complete before triggered recording will start.

Manual Recording will start when the Start button is pressed. IP analysis supports only manual
recording.

External Recording will start when a rising or falling signal edge is detected at the external trigger input
connector. (Refer to the MTS400 Series Technical Reference, 071-1724-xx for specifications.)

Test Failure Recording will start when an error occurs on a flagged test.
Tests are flagged by highlighting a test in the Program or Tests view and selecting Record from
the context menu. The record icon is displayed next to the test.

You can set the Record flag on as many tests as you require; recording will be triggered by the
first flagged test that is encountered.

Timed Recording will start when the time and date set in the Start recording at field is reached.
You can enter the date and time manually (in the format displayed). The date can be selected
from the drop-down calendar.
For all trigger types, except manual, when recording is complete, the starting packet is indicated
in the Record Settings dialog box. Click on the packet number to display it in the Packets view.

Arm button Places the recording function into an armed state. If a pretrigger value has been specified, the
pretrigger recording will start (as shown by the progress bar). Full recording will start when
any trigger requirements are met.
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Table 1-16: Record settings (cont.)

Command Function
Stop button Only active during recording, this button either disarms the previously armed trigger or stops

recording immediately. Any recording made up to the point when the button is pressed will
be lost.

Start button For manual recording, this button becomes active after arming and any pretrigger conditions
have been met; when pressed, recording will start immediately.

The Recording Settings dialog can be left open while waiting for a recording to
take place. If, after setting up the recording, the dialog is closed, the recording can
be controlled from the toolbar.

Pretrigger Recording Setting a pretrigger size allows the condition of the final recording to be examined
both before and after a trigger event. Pretriggering a recording allows a section of
a recording to be recorded before the trigger event. The pretriggered portion of
the file is filled and written over repeatedly until the trigger event occurs.

Pretrigger recording starts when the trigger is armed by pressing Arm. (See
Figure 1-67 on page 1-136.)

CAUTION. Recording may fail if the hard disk is unable to match the data
rate of the stream. This can be caused by a fragmented hard disk. Regular
defragmentation of the hard disk is recommended (refer to your Windows
documentation or on-line help).

NOTE. No timestamps are stored when performing a recording through an IP
interface

1–138 MTS400 Series Analyzer Applications User Manual



Common User Interface Concepts

Figure 1-68: Record Settings dialog box - Recording in progress

PID Selection PIDs can be selected for recording.

To identify PIDs for recording, select the PID Filter browse button in the Record
Settings dialog box to display the Select PIDs to include dialog box.
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Figure 1-69: PID selection

PID numbers to be recorded can be entered directly in the PID(s) field or selected
using the mouse pointer in combination with the Shift and Ctrl keys. PIDs that are
not currently present in the stream can also be entered.

If the Only include the following PIDs in the recording check box is selected in
the Record Setting dialog box, the TSCA will record only packets that include
the selected PIDs.

Menu Bar and Options
The Menu Bar provides access to a selection of major system options using
drop-down menus. The menus and their options are described in tables listed in
this section.

Table 1-17: Analysis menu options
Command Function
File Analysis... Opens the Open File Analysis dialog box
Real-time Analysis... Opens the Select Real-time Interface dialog box
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Table 1-17: Analysis menu options (cont.)

Command Function
Restart Analysis Restarts the current analysis
Save Captured Stream… Saves the captured stream (200 MB maximum). Only available

in real-time mode
Save TS Packets... Saves the transport packets from a PCAP (packet capture) file

with the current IP filtering. Only available in deferred mode
Recent Files Lists the most recently analyzed files. Select a file name to

reanalyze the file
Close Analysis Stop and close the current analysis, leaving the TSCA open
Exit Exits the TSCA

Table 1-18: View menu options
Command Function
Show Toolbar Show/hide the toolbar
Show Status Bar Show/hide the status bar
Tear-Offs > Lists the open tear-off screens

Table 1-19: Navigation menu options
Command Function
Back Returns to previous view
Forward Goes to next view
FlexVuPlus Goes to the FlexVuPlus screen
Select Tree > Allows selection of a navigation view (Programs, Tests, SI/PSI,

PIDs, Packets, Interface)

Table 1-20: Settings menu options
Command Function
Configuration... Opens the Configuration dialog box
Standard... Opens the Standard dialog box

Table 1-21: CaptureVu menu options
Command Function
CaptureVu Status… Opens the CaptureVu status dialog box
Capture Pauses the current analysis to allow detailed inspection
Resume Resumes analysis - only available in deferred analysis mode
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Table 1-22: Record menu options
Command Function
Record Settings Opens the Record Settings dialog box.
Arm Arms the record function.
Start Starts recording.
Stop Stops recording.
The Record menu is only available during real-time analysis

Table 1-23: Help menu options
Command Function
About… Displays application and system information.

Configuration
Select Settings > Configuration to display the Configuration dialog box. Two
configuration categories are offered in the Configuration dialog box: Stream and
Preferences. Several sub-categories are also offered.

Stream Use this category to modify stream-related settings.

Item Description
Enable thumbnails Thumbnail views of program content will be displayed when this

option is enabled.
Reset Actions The Factory Default button restores all configuration items to

those set in the factory. All parameters, including the interface
card settings (where installed), will be reset.
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Stream - Test Parameters All parameters are accessible from the Settings > Configuration > Stream > Test
Parameters window. Parameters are initially listed in alphabetical order. To
quickly search for a parameter, enter text in the search field, for example ‘BER’.
Only parameters containing the entered text in their description will be displayed.
You can clear search text by selecting the button adjacent to the search field.

Figure 1-70: Configuration - Test Parameters

Parameter values can be changed in the same way as individual parameters. (See
page 1-117, Parameter Edit.) Changes made to values in this dialog box are also
applied to the individual PID parameters, since changes made here become the
default value for the parameter.

Select the Set All to Nominal button to return all parameter values to their
factory settings. During file analysis, you will need to restart analysis for the
new parameter settings to take effect.

Stream - PCR Filters The PCR measurements provided by the MTS400 Transport Stream Compliance
Analyzer are defined by TR 101 290. Appendix I of TR 101 290 describes the
measurements in detail, and also introduces the concept of the "demarcation
frequency" at which PCR errors are separated into drift errors or jitter errors.
Errors below the demarcation frequency are measured as drift, while errors above
that frequency are measured as jitter.

TR 101 290 also defines three standard demarcation frequencies, MGF1 (10 mHz),
MGF2 (100 mHz), and MGF3 (1000 mHz), at which the PCR measurements can
be made, and provides for a user-definable demarcation frequency, MGF4.
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From the menu bar, select Settings > Configuration > Stream > PCR Filters to
open the PCR Filters dialog box. (See Figure 1-72.) Any PCR error below the
low-pass filter cut-off frequency will be measured as drift; any error above the
high-pass filter cut-off will be measured as jitter.

The filters can be set to any of the standard MGF profiles, or a user desired
cut-off frequency, by selecting MGF4 and entering a value between 1 mHz and
10000 mHz (10 Hz).

Alternatively, these filter values can be changed by selecting Settings >
Configuration > Stream > Test Parameters from the menu bar, filtering the
appropriate parameters, and making the required changes.

Figure 1-71: PCR parameters - Filter settings

Figure 1-72: Configuration - PCR Filters
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Note that the TR 101 290 drift limit of ±75 mHz/s is only defined at a demarcation
frequency of 10 mHz. As the low-pass filter frequency is increased above that
value, more of the PCR jitter will be measured as drift, and so the measured drift
values will increase. If you are attempting to check that your source PCR clock
is compliant with the TR 101 290 limits, the low-pass filter cut-off frequency
should be set to 10 mHz.

Settling Time. All of the PCR measurements that depend on demarcation filters
have a settling time.

The measurements will not return valid values before this time elapses. The
settling time is indicated on the PCR graphs in the TSCA.

This settling time is inversely proportional to the cut-off frequency of the
demarcation filter. This means that there is a trade-off between reducing the filter
frequency to improve drift measurement accuracy and increasing the time it takes
to obtain any drift measurements at all.

Table 1-24: PCR settling times
Filter cut-off Settling time TR101-290 profile Comments
10 mHz 500 s MGF1 TSCA default for PCR_FO/DR low-pass

filter cut-off; drift limit of±75 mHz/s is only
applicable at this level

100 mHz 50 s MGF2 TSCA default for PCR_OJ/AC high-pass
filter cut-off.

1000 mHz (1Hz) 5 s MGF3 -
1 mHz - 10,000 mHz 5000 s - 0.5 s MGF4 User-defined profile

For more information about PCR measurements, please read the PCR
Measurements Primer, available on the Tektronix Web site (www.tektronix.com).

Preferences Use this category to modify general preferences.

Figure 1-73: Configuration - Preferences
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Default File Folder: Set the default folder that will be shown when first
displaying the Open File Analysis dialog box in a session.

NOTE. Navigating away from the set folder within the open dialog box will
change the default folder shown for this session only.

Maximum File History Size: Specify the maximum number of file names to be
shown in the Analysis > Recent Files list.

Timezone for timestamp display: This setting affects the display of timestamps
in the event log.

The available timezones are: Local: The timezone set on the PC running the
client application UTC: Universal Co-ordinated Time Remote: The timezone set
on the system running the analysis engine

Connecting to a remote machine, the Local and Remote settings will produce
different timestamps if the client and device are in different timezones.

When connecting to localhost, the Local and Remote settings will yield the
same displayed timestamp, since the client and remote software are on the same
machine, for example, an MTS400 Series instrument.

Packet Size used for TS bit rate: Specify the packet size (188 or 204) to be used
to calculate the transport stream bit rate. This is displayed in the status bar.

Optimize for UI performance: Under some circumstances when analyzing
large files or using low specification instruments, the user interface may appear
to freeze. Enabling this feature will cause the user interface to refresh at more
regular intervals, thus reassuring you that the analysis is progressing.

Color Scheme: Select the background color for all graphs. When Default is
selected, the graphs are based on a white background. When Instrument is
selected, the graphs are based on a black backgrounds.

1–146 MTS400 Series Analyzer Applications User Manual



Common User Interface Concepts

Preferences - Font The Font preferences option allows you to specify the display font and size for log
entries and stream content. Place the cursor in the field to be changed and select
the font name or font size required from the displayed drop-down list.

Figure 1-74: Configuration - Preferences - Font

Preferences - Decode The decode preferences relate to the VLC Media Player that can be used to play
elementary stream video and audio content.

Figure 1-75: Configuration - Preferences - Decode

VLC Selecting the VLC setting indicates that a stream should be sent to the VLC
Media Player.

UDP The UDP setting, which is only available for real time systems, is used
to designate the port over which streams should be sent to external players, for
example, the MPlayer. The UDP Destination can be set either automatically or
manually.
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Script Files
In the TSCA, scripts provide a method of interpreting and displaying standards
during analysis. Scripts provide templates, which determine how the SI
information found during stream analysis will be displayed. The scripts must cater
for all the information that may be found in a stream, including the various table
types found in all of the identified standards. To this end, it has been found that
the best approach is to make the scripts modular; each script module deals with
different aspects of the SI and standards.

For example, when DVB is identified as the standard against which to analyze,
the scripting dialog box displays a list of Script modules. Additionally, when it
is known that tables or descriptors not commonly carried in the identified base
standard and region are likely to be included, extra scripts can be written and
added to the Script Files list to be used for the analysis.

Essential scripts are installed and enabled using the Stream Interpretation dialog
box. In the absence of any enabled scripts, only the PAT table will be analyzed,
and all other data will be presented as private data.

Scripts can be customized or new scripts can be written to analyze private data.
With the Custom Scripts checkbox enabled, if a suitably configured script
is selected and enabled before a stream is analyzed, custom data will also be
analyzed when the stream is opened.

Scripts can be selected and enabled when files are open; analysis will restart
as soon as any changes as accepted.

A script file will not be used for analysis until it is present in the Script Files panel
of the Open Transport Stream dialog box.
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Setting Stream
Interpretation

Set the stream interpretation as follows:

Figure 1-76: Stream Interpretation dialog box

Select Settings > Standard to open the Standard dialog box or select Change
from the opening dialog box.

1. From the Base Standard drop-down list, select the required base standard.

The selected standard will dictate the availability of options that are available
in the Regions drop-down list.

2. From the Region drop-down list, select the required region.

The regions list allows country-specific extensions to be added to the base
standard scripts. If No Extensions is selected, only the standard scripts are
listed in the script list. The remaining country-specific extensions add extra
scripts to the current listing. Scripts that will be used are listed in the main
pane.

Scripts listed by default are resident in the default installation directory
(program files\tektronix\mpeg\mts400\scripts). Other directory
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locations can be specified in the custom script selection mode. All selections
will be retained between TSCA sessions.

3. Select OK to confirm changes.

Scripts are syntactically analyzed when the OK button is selected. A fault in the
syntax of a script will not necessarily prevent a stream from being analyzed, but
it may result in an incomplete analysis of the stream. Errors in the script syntax
will be noted in the stream log.

Custom Script Selection When the Custom Scripts checkbox is enabled, the buttons beside the script listing
become active and custom scripts can be selected in addition to the standard
scripts. Some script names in the listing are dimmed; these are considered to
be essential and cannot be removed.

The buttons operate as follows:

Button Operation
Resets the script list to the default list for the standard and
region.
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Button Operation
Opens the script selection dialog box. You can highlight the
required script and select OK. The script name is added to the
Script Files list.
Removes any script name highlighted in the Script Files list.

Scripts are applied to streams in the order that they are listed
in the Script Files list. Use these buttons to move a highlighted
script up and down in the list.
Opens the highlighted script in ScriptPad (the Tektronix script
editor).

Verifies the syntax of the scripts listed in the Script Files pane. A
message window lists any errors found.

If the standard script list has been changed and you want to return to the default
list of scripts, highlight the Base Standard and Region required, and select the
default script button. The list will be overwritten with the default list.

More information about ScriptPad can be found in the MTS400 Generator
Applications User Manual.

Scripts Directory The Scripts Directory field indicates the root directory for scripts named in the
Script Files list when analysis starts. If scripts are not present in the scripts
directory, the interpretation and validation of the SI will be incomplete.

NOTE. If the script list is modified in any way, always use the n button to verify
the changes.

Scripts can be selected from any directory (using the + button). If the directory
is not the same as that identified in the Scripts Directory field, the path (either
relative or absolute) will be displayed with the script name in the Script Files list.

NOTE. The Scripts Directory browse button allows you to specify a default
directory for script selection. The browse window does not display the scripts
available. If you need to see the scripts available, use the Windows Explorer.

If the standard script list has been customized and you want to return to the default
list of scripts, highlight the required Base Standard and Region and select the
default script button. The list will be overwritten with the default list.

NOTE. Each Base Standard and Region combination can be individually
customized.
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Script Validation Validating scripts checks the syntax of the listed scripts.

If the "Enable scripted section validations during analysis" check box is enabled,
the scripts are checked during analysis to ensure that the data as defined by the
scripts is as expected (for example, values are within specified ranges). A fault in
the syntax of a script will not necessarily prevent a stream from being analyzed,
but it may result in incomplete analysis of the stream. Errors in script validation
will be logged in the stream error log. Enabling this check box may have an
impact on real-time analysis.
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Task Examples
The examples in this section describe how to locate a fault or information using
the analyzer.

To use this section, you should have a basic understanding of the analyzer user
interface and be familiar with the more important aspects of digital television
transport stream structure and interpretation standards.

The MPEG Test System is a tool which allows you to analyze a transport stream
and then examine it in detail. Errors in the content can be identified and examined
to byte level.

Because of the comprehensive nature of the analyzer, there are a number of ways
of achieving your objective. In these examples, one or more ways are described to
achieve the objective.

Error Status LED icons are used throughout the analyzer interface to represent the status of
the tests applied to associated items, for example, programs. Colors used are as
follows:

(Red) Error; test failed

(Yellow) Transient error (error not currently being detected but
has been seen since last reset)
(Green) No error; test passed

(Dark Blue) Warning (Interface tab only)

(Light Blue) Transient warning (warning not current, but has
been detected since last reset) (Interface tab only)
(Gray): Test disabled

(White) Test not applicable or unknown state

(Red) PID referenced but not found in the stream

(Green) PID referenced but not found in the stream; applicable
test disabled.

When an LED represents a parent node in a tree (for example, a program node is
the parent of elementary stream nodes) or a navigation tab, the color represents
the worst case of all of its tests and the worst case of all of the tests represented
by its child nodes.

Similarly, when an LED representing a parent node in a tree is disabled or
enabled, all subsidiary (or child) nodes are also disabled or enabled to reflect the
state of the parent node. When an LED representing a parent node is reset, all
the child nodes are also reset.
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Which Tests Have Failed in an Analyzed Stream
In this example, the analyzer has just finished analyzing a stream. The Program
navigation view is initially displayed with the transport stream tree collapsed. The
transport stream error LED is red, indicating that one or more tests have failed.
(See page 1-38, Error Status LEDs.)

Method With the Program tab still selected, view the tests summary view (bottom right).

Figure 1-77: Failed tests - example

Identify the tests that have failed (red LED). The following tests have failed in the
test summary view (TR 101 290 tab) : (See Figure 1-77.)

First Priority: 1.6 PID

Third Priority: 3.1a NIT Actual; 3.2 SI Repetition; 3.5a SDT Actual; 3.6a
EIT Actual

Remember that the tests may be distributed over more than one tab in the test
summary view; the color of the LED on the tab helps you locate the failed tests.
(See Figure 1-77.)
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You can view a test (and see other PIDs that it has failed on) by highlighting a test
and selecting "View this Test in Tests Tree" from the shortcut menu:

You can also display the fault by expanding the tree in the Tests navigation view
until the fault is revealed.

Expanding the test itself reveals the PIDs that have failed the test.
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How Many PIDs Are There in a Stream?
How Many PIDs Are Referenced?
How Many Are Unreferenced?

For this task, the PID navigation view is used to view information about
individual PIDs in the transport stream. Under the All PIDs node, which displays
all of the PIDs in the summary view, there are four subgroup nodes: Reserved
PIDs, Referenced PIDs, Unreferenced PIDs, and User PIDs. The number (in
parenthesis) in each node gives the number of PIDs found during analysis.

Method Select the PID navigation view.

1. Expand the All PIDs node to display the subgroups (and their quantities).

2. Expand the All PIDs node to display the subgroups (and their quantities).
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What Tests Have Been Applied to a Program PID?
1. Select the Program navigation view.

2. Expand the Transport Stream tree until the required PID can be highlighted.
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In the Associated Tests view, note the tests that are enabled. Gray LEDs indicate
tests that have been disabled, and white LEDs indicate tests that are not applicable
to the selected PID.

Establish the Stream Type of a PID
Method 1 1. Select the Program navigation view.

2. Expand the Transport Stream tree until the required PID can be highlighted.

3. Keep the cursor over the PID. A tooltip will display the stream type.

The tooltip is available wherever the selected PID node is displayed (for example,
in the PID navigation view).

Method 2 1. Select the Program navigation view.

2. Select the program node.

3. In the summary view, select the Summary tab.
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Note the Stream Type column in the display. The stream type is given for each
PID in the selected program.

How Many Programs Are There in the Stream?
1. Select the Program navigation view.

2. Expand the Transport Stream tree and note the number of program nodes.
(See Figure 1-78.)

3. The Summary view (bar chart or pie chart) also displays a program count.

Figure 1-78: Program count
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What Are the Contents Of the Programs?
And What Pids Are They On?

1. Select the Program navigation view.

2. Expand the Transport Stream tree and a program node as shown in the
following figure.

3. Note the number of program PIDs. Each PID is accompanied by an icon
indicating the stream type. Hold the cursor over a PID node to display more
information.

4. The Summary and the PID Information views also display the program PIDs.

Figure 1-79: PID count

What is the Bit Rate of Each PID in a Program?
Bit rates are displayed in the Program and PID summary views. The bit rates
displayed depend on the node highlighted in the navigation view.

Table 1-25: Bit rate views

Navigation view Node
Bit rates displayed in
Summary view

Program Transport Stream All programs
Program Program Program PIDs
PID All PIDs All PIDs
PID Secondary nodes

(Reserved, Referenced,
Unreferenced, and User)

PIDs in secondary groups
PIDs
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Figure 1-80: Program PID bit rate - bar chart

The PID bit rate summaries can be displayed as either bar charts or pie charts by
selecting the appropriate icon at the top left of the Summary view.
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Figure 1-81: Program PID bit rate - pie chart

A selection of statistics for each program or PID is shown in the charts. Either
current or mean bit rates can be shown by selecting the Show Mean Values option
from the Summary view shortcut menu. For deferred analysis, the current bit
rate is the final bit rate.
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You can also display a bit rate graph for the highlighted node by selecting the Bit
Rate Graphs tab.

Figure 1-82: Bit rate graph
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What is the Latest Version Number of the Program Association Table (PAT) in
the SI?

Tables and their versions can be found in the Tables (SI/PSI) view. When a node
representing a table is selected in the navigation view, the table identity and the
version are displayed in summary view (top right) as shown in the following
figure.

Figure 1-83: Table Identity and Version (summary view)
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The table identity and version can also be seen in the table header using the Tables
(SI/PSI) section view as shown in the following figure.

Figure 1-84: Table Identity and Version (section view)

Examine a Transport Packet
A transport stream packet is a unit of data that contains a header and a payload.
The Packets view allows individual transport stream packets to be identified and
examined.

Navigating Around the
Packets

The navigation bar at the top of the Packet summary view is used to move
between packets. How the controls work depends on the selection in the Packets
navigation view. If All Packets are highlighted, the controls will operate on all
packets. If a PID has been identified, added to the PIDs node and highlighted, the
controls will operate only on packets carrying the selected PID.

The packet position bar shows the position of the selected packet in the stream.

The controls work as follows:

Selects the first available packet (in the stream or carrying the
selected PID).
Selects the previous available packet (in the stream or carrying
the selected PID).
Selects the next available packet (in the stream or carrying the
selected PID).
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Selects the last available packet (in the stream or carrying the
selected PID).
Opens the Go to packet dialog box.

The packet position bar can also be used to navigate through the stream. You can
use the cursor to point to and click the next packet to be displayed. Similarly,
double-click the packet number in the bar and enter the required packet number in
the Go to packet... dialog box.

Looking at the Packet When you have identified and selected a packet, the Packets summary view
displays the interpreted code and the raw data in hexadecimal and ASCII format.
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SI/PSI Nodes
The Tables view (SI/PSI tab) displays the service information in tree form. The
tree represents all of the service information tables found in the analyzed stream
that comply with the selected digital video standard (including MPEG program
specific information, DVB service information, and ATSC and ISDB program and
system information protocol). The tree contains nodes for each table found; tables
and nodes are grouped together functionally.

This section identifies the nodes that may be present for each standard.

The following figure shows an example of Table navigation view with DVB
stream interpretation selected.

The following tables in this section show the nodes that can be displayed in the
SI/PSI navigation view depending on the selected interpretation standard and the
content of the stream.

Figure 1-85: Primary SI/PSI nodes (DVB example)

Table 1-26: MPEG SI/PSI
Primary node Subsidiary node
TS info

TSDT
Programs
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Table 1-26: MPEG SI/PSI (cont.)

Primary node Subsidiary node
PAT
PMT PIDs

Conditional access
CAT

Other Tables

Table 1-27: DVB SI/PSI
Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
TS info

Partial TS
DIT
SIT

BIT
Programs

PAT
PMT PIDs

PMT PID +
SDT

Bouquets
BAT

Conditional
access

CAT
Networks

NIT - This
NIT - Other

Time
TOT
TDT

EPG
This TS

SDT Actual
Service (number,
name)

Now/Next (EIT P/F)
Schedule (EIT
schedule)
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Table 1-27: DVB SI/PSI (cont.)

Primary node Subsidiary node 1 Subsidiary node 2 Subsidiary node 3
Other TS

SDT Other
Service (number,
name)

Now/Next (EIT P/F)
RST

MHP apps
Other tables

Table 1-28: ATSC SI/PSI

Primary node
Subsidiary
node 1

Subsidiary
node 2

Subsidiary
node 3

Subsidiary
node 4

TS info
MGT

Programs
PAT
PMT PIDs
VCT C/T
ETT-V

Conditional
access

CAT
Ratings

RRT+
Time

STT
EPG

Source/Services
EIT0 > EIT127

Directed
channel
change

DCCT id +
DCCSCT

Other tables
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Table 1-29: ISDB-S SI/PSI nodes

Primary node
Subsidiary
node 1

Subsidiary
node 2

Subsidiary
node 3

Subsidiary
node 4

TS info
Partial TS

DIT
SIT

BIT
Programs

PAT
PMT PIDs
SDT

Conditional
access

CAT
Networks

NIT - This
NIT - Other

Time
TOT

EPG
This TS

SDT Actual
Service
(number,
name)

Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)

Other TS
SDT Other
Service
(number,
name)

Now/Next (EIT
P/F)
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Table 1-29: ISDB-S SI/PSI nodes (cont.)

Primary node
Subsidiary
node 1

Subsidiary
node 2

Subsidiary
node 3

Subsidiary
node 4

Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)

Maker
id/model id +

Other tables

Table 1-30: ISDB-T and -TB SI/PSI nodes

Primary node
Subsidiary
node 1

Subsidiary
node 2

Subsidiary
node 3

Subsidiary
node 4

TS info
Partial TS

DIT
SIT

BIT
Programs

PAT
PMT PIDs
SDT

Conditional
access

CAT
Networks

NIT - This
NIT - Other

Time
TOT

EPG
This TS

SDT Actual
H

Service
(number,
name)
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Table 1-30: ISDB-T and -TB SI/PSI nodes (cont.)

Primary node
Subsidiary
node 1

Subsidiary
node 2

Subsidiary
node 3

Subsidiary
node 4
Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)

M
Service
(number,
name)

Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)

L
Service
(number,
name)

Now/Next (EIT
P/F)
Basic
Schedule (EIT
schedule)
Extended
Schedule (EIT
schedule)

SDTT
SDTT(H)

Maker
id/model id +

SDTT(L)
Maker
id/model id +

Other tables
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Getting Started
The Packetized Elementary Stream (PES) Analyzer performs a series of user
selectable conformance tests on a previously recorded file. Files can be interpreted
according to either the ATSC or DVB standards. Once the file is analyzed, users
can view the results of the selected tests and browse through the content of the
PES packets.

Information can be viewed in graphical and textual formats. To analyze and view
the Transport Stream packets, use the companion program TS Analyzer, which
can be run at the same time as this PES Analyzer.

The functionality provided includes:

Display of program structure showing the programs contained within the
transport multiplex and the PES streams which make up each program.

Display an interpretation of PES packet for individual packets.

Hexadecimal representation of PES packet.
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Extraction and display of Presentation Time Stamp (PTS) and Decoding Time
Stamp (DTS) information from the PES packet header.

Display of access unit information for video and audio access units.

NOTE. The examples shown in this chapter are taken from both ATSC and DVB
compliant transport streams. An example of each type is sometimes shown
as a reminder that both standards are supported or where a difference needs
explanation.sds

Starting the Program
Start the program by selecting the Tektronix PES Analyzer option from the Start >
Programs menu or by double clicking on the Tektronix PES Analyzer shortcut on
the desktop.

Initial Appearance Once the program has started and is ready for use it will open a Main Window.
When the program first starts it looks as follows:
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The Toolbar (row of buttons above the dark gray area of the empty window) may
be hidden from view, moved to a separate window or moved to either side or the
bottom of the main window.

The Status Line at the very bottom of the window may be hidden from view.
Because no file is open, it is displaying a message that the TS packet number
is Not Valid.

Above the Status line is the Slider Bar. This has three groups of controls for
selecting streams and packets within a file. This may be moved to the top of
the window.

Initial Menu Options PES Analyzer presents different menus and options, depending on whether or
not a file is open for analysis. The menu options available when no file is open,
are as follows:

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.

File Menu Options. The File menu contains the options listed in the following
table.

Table 2-1: File menu options
Command Function
Open... Opens an MPEG file for analysis. The

program opens the file selection dialog
allowing the user to choose the required file.

Print Setup ... Opens a dialog for selecting which printer
and associated options to use.

1 <filename>
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently analyzed files.
If the program has recently been installed the
list may be empty or hold less than four files.
Selecting a filename opens that file for
analysis.

Exit Finishes running the program.

View Menu Options. The View menu contains the options listed in the following
table.

Table 2-2: View menu options
Command Function
Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the status bar.
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Settings Menu Options. The Settings menu contains the options listed in the
following table.

Table 2-3: Settings menu options
Command Function
Test Options Opens a dialog for setting the Conformance

Test Options for analyzing and interpreting
the PES information in stream files.

Options Menu Options. The Options menu contains the options listed in the
following table.

Table 2-4: Options menu options
Command Function
Limit Repeat Errors Lists the first 20 occurrences of each error

type in the event log.

Options
The MPEG and ATSC Conformance Test Options for MPEG and ATSC may not
be modified when a file is open. To change them, all files must be closed, the test
options modified, and the file opened again.

Select Test Options from the Settings menu to open the Conformance Tests dialog.

NOTE. The Settings Menu is only available when there is no file open. It is hidden
when a file is opened and redisplayed when the file is closed.

Conformance Tests The dialog box contains two tabbed pages containing tests relating to MPEG and
ATSC files, respectively. Note that the MPEG tests are sufficient for DVB streams.

Test of PES Header Syntax (MPEG). The tests of PES header Syntax are based on
the conformance requirements laid down in the standards document ISO/IEC
13818-4 for Packetized Elementary Streams
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Each check box uses the same name for a particular test as the standard. For
example, to test conformance to the standard for the length of PES packets select
the PES_packet_length option.

A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

Test of PES Header Syntax (ATSC). When the ATSC Stream box is checked,
selected streams are interpreted according to the ATSC standards, A/52 and A/53
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A check mark shows that a test is selected and an empty check box indicates that
the test will not be performed.

For streams in a DVB standard stream, leave the ATSC Stream option unchecked.
The ATSC Stream option is disabled (grayed out) if the software license is only
for the DVB standard.

2–6 MTS400 Series Analyzer Applications User Manual



Getting Started

Opening a File
Any file holding a recorded or synthesized sample of a stream can be opened
for PES Analysis by this program. To analyze the Transport Stream packets,
open the file in the TS Analyzer. A file can be opened by both the TS and PES
Analyzers at the same time.

Opening a File from the
Menus and Toolbar

To open a file select the Open... option from the file menu. If the required file is in
the list of recently analyzed files then it can be opened from the list to save using
the Open file dialog. Alternatively, use the Ctrl+O keyboard shortcut.

There is also a shortcut button available on the Toolbar for opening a file, which
has the standard file open symbol:

Once a file is open this button will be disabled, which is shown by being "grayed
out".

MTS400 Series Analyzer Applications User Manual 2–7



Getting Started

Window Layout Program Structure and Event Log windows are opened as soon as the file is
opened. The layout of the windows will have been saved from the last time the
program was used. If the program has just been installed, the windows will be in
the application default Cascade arrangement, which looks like this:

2–8 MTS400 Series Analyzer Applications User Manual



Getting Started

Many users rearrange the windows so that the Program Structure and Event Log
windows do not overlap. The examples in this manual often use this arrangement:

NOTE. The above example is from a transport stream interpreted and labeled
according to the DVB standard. If the ATSC Stream option is set the elementary
streams will be interpreted and labeled according to the ATSC standard. For
example: audio streams would be labeled AC-3 Audio, instead of Audio or AAC
Audio.

PES Analysis The PES Analyzer program now starts to analyze the file for conformance to the
selected tests. Due to the very efficient algorithms used by the program, it will
analyze large files in a few minutes. Other algorithms have been seen to take
much longer. The rightmost pane in the Status Bar shows a progress indicator
during Analysis.

MTS400 Series Analyzer Applications User Manual 2–9



Getting Started

As the file is analyzed messages are written in the Event Log and the structure
diagram is drawn in the Program Structure window. When the processing is done
an "Analysis Complete" message is written in the Event Log.
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Menus and Controls
When a file is open the program presents a different set of menus and options.
They change as soon as the Program Structure and Event Log windows appear.
For example, the Open file commands are replaced by Close file commands.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Closes the current file. This button becomes enabled the
moment a file is opened and analysis starts. If the wrong file is
being opened, or the wrong options are selected, clicking on the
button will abandon the analysis and close the file.
Open a file. This button is disabled when a file is open.

Print the contents of the current window.

Opens a dialog which displays the program version number.

Toggles the Event Log window. When the button is in this state
the window is not visible and clicking on the button will open
the Event Log.
Toggles the Packet Hex View window. When the button is in
this state the window is not visible and clicking on the button
will open the Hex View.
Toggles the PTS/DTS View window. When the button is in this
state the window is not visible and clicking on the button will
open the PTS/DTS View.
Toggles the Header Interpretation window. When the button is in
this state the window is not visible and clicking on the button will
open the Header Interpretation.
Zoom In on data in the PTS/DTS View. This button is only
enabled when the PTS/DTS View is the current window.

Zoom Out from the data in the PTS/DTS View. This button is
only enabled when the PTS/DTS View is the current window.
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The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this click on the background inside the Toolbar, that is, not on one of the
buttons, and drag into the main window area. The result is a self-contained
window which looks like this:

To replace the Toolbar on the window border drag it over the border until the
outline changes shape. It can be placed on the top, bottom, left or right edges.

Status Bar

The Status Bar may be hidden from view, but if visible is always at the bottom of
the main window. It displays the following information about the program and
keyboard states:
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Slider Bar

The Analyzer can display the contents of any PES packet in the currently loaded
file. Packets are numbered, within a PID, according to their position in the file; the
first PES packet of each PID being PES packet 0 (zero). The Slider Bar displays
the packet number and the PID for the current packet.

The slider bar controls are as follows:

Slider

Packet number

Packet Type - Elementary
Stream
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Like the Toolbar the Slider Bar can be dragged from the edge of the main window
into a floating pallet; to do this click on the background inside the Slider Bar
and drag it into the main window area. The result is a self contained window
which looks like this:

To replace the Slider Bar on the window border drag it over the border until the
outline changes shape. Unlike the Toolbar it can only be placed on either the top
or bottom edges.

Selecting Packet Type The Slider and Packet Number can only select packets in the currently selected
program stream. The stream is indicated in the Packet Type drop-down list and by
the magnifying glass symbol,

in the Program Structure window. A new stream may be selected from either the
list box or the window.

Menus and Options

NOTE. A check mark next to an option indicates that the window or toolbar is
currently visible or enabled, no check mark means that it is hidden or disabled.
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File Menu Options The File menu contains the options listed in the following table.

Table 2-5: File menu options
Command Function
Close Closes the current file. This option is available as soon as

analysis starts. If the wrong file is being opened, or the wrong
Conformance Tests are being run, selecting this option will
abandon the analysis and close the file.

Print Prints contents of the current window.
Print Setup Selects printer and configuration.
Exit Closes any file that is open and terminates execution the

program.

Edit Menu Options The Edit menu contains the options listed in the following table.

Table 2-6: Edit menu options
Command Function
Copy Copies the contents of the current window to the MS Windows™

Clipboard, from which it can be pasted into a document in
another application.

Copy TS Packet Allows the user to select an AU (access unit) within the PES
Analyzer, and then copy the TS packet number onto the
Windows clipboard. The Stream Analyzer may then be started
and Paste TS packet selected to go to the packet number
retrieved from the clipboard.

View Menu Options The View menu contains the options listed in listed in the following table.

Table 2-7: View menu options
Command Function
Toolbar Shows or hides the Toolbar, which provides a set of convenient

shortcuts for the more frequently used menu options.
Status Bar Shows or hides the Status Bar.
Event Log Shows or Hides the Event Log.
Hex Shows or Hides the Hex View.
Interpretation Shows or Hides the Packet Interpretation view.
PTS/DTS Timing Shows or Hides the PTS/DTS Timing Analysis window.
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Options Menu Options The Options menu contains the options listed in the following table.

Table 2-8: Options menu options
Command Function
Limit Repeat Errors Only lists the first 20 occurrences of each error type in the event

log.

Window Menu Options The Window menu contains the options listed in the following table.

Table 2-9: Window menu options
Command Function
Cascade Arranges all the windows so that they are neatly stacked; only

the title bars show behind the active window.
Tile Reduces and moves windows so that they can all be seen at

once.
Arrange Icons Aligns icons of any minimized windows at the bottom of the

program’s main window.
1 <window title>
2 <window title>
3.. etc.

Makes the named window active, putting it on top of any
windows which had been hiding all or part of it.

Help Menu Options The Help menu contains the options listed in the following table.

Table 2-10: Help menu options
Command Function
About PES Analyzer… Opens a dialog that displays the program version number.
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Packet Hex View

This is the lowest level view of the PES Packet data. It displays the contents of
every byte in hexadecimal. Each byte is represented as a pair of hexadecimal
digits. The window may be resized to display 16, 32, 48,… bytes of information
on each row.

The four digit numbers in the left most column are the addresses of the first (that
is, leftmost) byte in the row. The addresses are shown in hexadecimal.
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Packet Header
The Hex View displays the bytes holding PES Packet header information in
magenta color text. For example here is a packet containing a PTS field, from a
video stream:

The most significant two bits of the eighth byte (that is, the byte at address
0x0007) contain the PTS_DTS_flags. The ninth byte (address 0x0008) contains
the PES_header_data_length, which specifies how many additional bytes are
present. In the above example:

PTS_DTS_flag = 2

PES_header_data_length = 5

These specify that there is a 5 byte Presentation Time Stamp (PTS) field in
the header. The contents of the PTS are 21 0A 17 64 B3 and they follow the
PES_header_data_length.

The preceding packet, from the same stream, carried both a PTS and DTS field:

PTS_DTS_flag = 3

PES_header_data_length = 10 (shown as 0A in hexadecimal)
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Instead of having to interpret header information from the Hex View, the PES
Analyzer provides the Header Interpretation window. This interprets the header
and displays the contents, in table form, according to the MPEG-2 standards.
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Event Log

The program always opens the Event Log window when it starts to analyze a
file. As the file is analyzed the program writes the results to the window as they
are produced. When processing finishes an "Analysis Complete" message is
appended to the report.

Packet Selection
If a warning or error message gives a packet number, that packet may be inspected
by selecting the message. For example, here is an extract from a file with PTS
errors on two of the Audio streams:

Clicking on the message for Prog. 3 Audio (PID 106), PES Packet 78 selects both
the program stream and the packet. This is reflected by the Slider Bar, in the
Program Structure, Hex View, Header interpretation and PTS/DTS Views.
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The Slider bar will look like this:

In the program structure view, the magnifying glass icon, , appears on the
selected stream:

If the Hex View and/or Header Interpretation windows are open they will be
updated to show the contents of the selected packet. If the PTS/DTS View
window is open the cursor is placed on the packet and the panel showing the
Data at Cursor is updated.
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Having selected the packet it can now be inspected with other tools. The
information in the Header Inspection and Hex View windows will look like this:

To look at the timing of all the PTS carrying packets, open the PTS/DTS View:

This shows all the PES packets for the selected PID. See the section on the
PTS/DTS View for more information on selecting a particular packet.
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Packet Header Interpretation

This window interprets and displays the header of the currently selected packet.
The above example shows a packet which carries a Presentation Time Stamp
(PTS).

The relationship between the top row of information displayed in the Header
Interpretation, for this packet, and the Hex View is:
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The next row completes the compulsory header information. The mapping
between the Header Interpretation and Hex View is:

The last row is a reminder that after the header comes the packet data. Any other
rows represent additional fields, such as the Presentation Time Stamp (PTS)
carried in this example. The relationship of these rows to the Hex view is:

The size of the header depends on the fields it carries. Here is the Header
Information view of the preceding packet which carries PTS and DTS fields:
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Program Structure
The Program Structure window displays a list of all available programs and the
elementary streams that they contain. It shows which stream is currently selected
for inspection and may be used to select a different stream.

The example below shows a program structure from a file conforming to the
ATSC standard.

The example below is a program structure from a file that is compliant to the
DVB standard.
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The Diagram
The Program Structure is displayed by the program as soon as a file is opened. As
the file is analyzed, the top levels of a structure diagram are drawn in the window:

An Elementary Stream is selected by default. The Program Structure view shows
the selected stream and other streams in the same program. The first program is
expanded to show the streams in the next level.

Streams in the other programs are initially hidden from view.

The structure is represented by a tree diagram, with the "root node" or highest
level component at the top. Components which contain more information beneath
them in the structure are indicated by a square box.

Components that are connected to a branch of the tree without a square box are
leaf nodes. In this case the Video and Audio elementary streams are leaf nodes.
They display the lowest and finest level of detail.

Nodes can be expanded and contracted by clicking on the square box.
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Selecting a Packet Type
When a file is first opened and analyzed a stream will be selected by default. The
type is indicated by the magnifying glass symbol, , in the Program Structure. It
is also displayed in the Packet Type "list Box" on the Slider Bar. A new stream
may be selected from either the list box or the window.
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PTS/DTS Timing Analysis

The PTS/DTS View shows timing analysis of the selected stream. The x-axis
shows the duration of the stream in seconds. The y-axis shows the differences
between the expected and actual DTS values. A vertical blue line is used to show
the difference between the PTS and DTS for each Access Unit (AU). Therefore, a
compliant stream will exhibit each DTS on the 0ms y-axis. Streams with errors
usually exhibit a "stepped" graphical effect.

Any AU in the stream may be selected to view additional information in the
panel on the right. If the panel is not tall enough to show all of the information a
scroll bar appears.
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When first opened the entire stream is shown. Even a small file may display data
points packed too closely together to be read; for example, here is just under
12 seconds of video:

A longer sample may appear as a solid band of blue.

To see the individual packets or access units click on the Zoom In button on
the Toolbar:

In this example, clicking the on the Zoom In button four times gave a much
clearer view:
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The blue crosses of Presentation Time Stamps and the magenta crosses of
Decoding Time Stamps can now be differentiated.

To Zoom back out click on the Zoom Out button as many times as required:

Access Unit Selection
The triangular cursor above the graph indicates the selected access unit. Extra
information about that access unit is displayed in the Panel on the right of the
Graph.
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Scrolling the View
The Slider at the bottom of the window indicates where the displayed packets /
access units are in relation to the rest of the file. It can be used to scroll the display
through the data in the same way as a standard window scroll bar.

To scroll the stream through the view drag the Slider Control left or right with
the mouse. After dragging the Slider Control it returns to the previous position
showing the location of the selected access unit.

Click the mouse pointer on the white space either side of the View Bar to center
the displayed graph about the currently selected access unit.

When an access unit is selected on the graph, the Slider Control is automatically
repositioned within the View Bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.

Selecting an Access Unit on the graph also changes the selection for all of the
other views to the packet containing that Access Unit.
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Video Streams

The panel on the right shows information about the selected access unit. For video
streams these are always complete packets. Some of the information shown in the
panel is specific to video streams, that is, frame rate and frame type.

The graph shows the frames of video in transmission order analysis and, when
"Zoomed In" close enough, the type of each packet plotted along the x-axis. The
graph scale is drawn in gray dashed lines. It is the equivalent of the scale or
graticule on an oscilloscope or logic analyzer.
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X-Axis The x-axis shows the nominal time of an access unit. The first access unit
displayed is taken to have a nominal time of zero. Each access unit has a nominal
duration, calculated from parameters within the elementary stream. These
parameters include "low_delay" and "repeat_first_field", which allow analysis of
effects such as 3:2 pulldown. These effects alter the access unit duration, which is
nominally equal to a video frame period.

Y-Axis The position on the y-axis of a PTS or DTS shows the relative timing of the
timestamps. The first timestamp (PTS, or DTS) is taken to have a y-value of
zero. Each Subsequent timestamp has a y-value given by the difference between
their timestamp and the first timestamp, less the difference in nominal time of
their access unit and the first access unit.

The solid blue vertical lines show the time difference between the PTS and DTS
from the same Access Unit.
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Audio Streams

The panel on the right shows information about the selected access unit. For video
streams, these are always complete packets. The frame rate and frame type shown
in the panel are specific to video streams. The "Picture Size (H x V)" information
is taken from the display_horizontal_size and display_vertical_size values in the
sequence display extension. If that is not present, the horizontal_size_value and
vertical_size_values in the sequence header, as modified by the sequence header
extension values horizontal_size_extension and vertical_size_extension in the
sequence header extension are used.

Some of the information shown in the panel is specific to audio streams.
AC-3 Audio streams will differ from Audio streams.
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The graph shows timing analysis of the PTS. There are no DTS in an audio
stream. Select an access unit by clicking on it with the mouse. Clicking between
two PTS will select an access unit that does not carry a PTS.

The graph scale is drawn in gray dashed lines for each value on the axis. In this
example there are only two values on the y-axis, at 0 ms and 24 ms.

AC-3 Audio Streams
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The Data at Cursor panel of the PTS/DTS View shows different information
for AC-3 Audio streams. Otherwise the window works in the same way as for
Audio streams.

AAC Audio Streams

The Data at Cursor panel of the PTS/DTS View shows different information
for AAC Audio streams. Otherwise the window works in the same way as for
Audio streams.
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Getting Started
The T-STD Buffer Analyzer models the behavior of the buffers in the hypothetical
Transport Stream System Target Decoder, as specified in ISO/IEC 13818-1. It
can process video, audio, and system control streams. The results of the analysis
are displayed as graphs of the buffer capacity over time and a log of exceptions
and noteworthy events.

Suitable Streams
Any valid MPEG file, recorded or synthesized, can be processed by this
application. A valid file is one that starts on a transport stream (TS) packet
boundary (the first byte of the file must contain the first byte of a TS packet).

The Buffer Analyzer will process video, audio, and system control streams that
are compliant with the 1996 standard ISO/IEC 13818 parts 1-3.

The Buffer Analyzer is able to analyze the following types of elementary streams:
MPEG1 Audio and Video, MPEG2 Audio and Video, H.264 Video, MPEG2 AAC
Audio, MPEG4 Audio (Only LC and SBR profiles) and AC3 Audio. It also
supports HEAAC along with the above elementary streams.

The Buffer Analyzer will handle transport streams that contain PCR and/or
PTS/DTS discontinuities. The PTS/DTS and PCR in a stream must, however,
use the same timebase.
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The Buffer Analyzer is unable to work on scrambled streams. If it fails to make
sense of a stream, use TS Analyzer to determine if the stream is scrambled.

Table Handling
Multiple PAT and PMT

Versions
Buffer Analyzer forms a list of elementary streams that are present in the transport
stream. This is called the Stream List. It creates the Stream List by reading
the first occurrence of the Program Association Table (PAT) and Program Map
Table (PMT).

If more than one version of the PAT and/or PMT are present, TS Cutter can be
used to isolate a particular section for analysis.

MPEG-2, DVB and ATSC
Tables

Only PIDs carrying MPEG-2 PSI tables are included in the System model. Any
DVB or ATSC tables that are present in the Transport Stream are ignored.

Starting the Program
To start the program, select the Tektronix Buffer Analyzer option from the Start
> Programs menu or double click the Tektronix Buffer Analyzer Shortcut on
the desktop.
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Initial Appearance Once the program has started and is ready for use, it will open a Main Window.
When the program starts, the Main Window looks like this:

The Toolbar (row of buttons above the dark gray area of the empty window) can
be hidden from view, moved to a separate window, or moved to either side or the
bottom of the main window.

The Status line at the very bottom of the window can be hidden from view. It
displays information about the application and keyboard status.

Initial Menu Options The application presents different menus and options, depending on whether a
file is open for analysis. The menu options available when Buffer Analyzer has
just been started, or after a file is closed, are: File menu options. The following
table lists the File menu options.

Table 3-1: File menu options
Command Function
New Opens a stream file for analysis and opens or creates a Buffer

Model Results (BMR) file in which to dstore the results.
The application opens a file selection dialog allowing you to
choose the stream file. It then opens another file selector dialog
to specify the BMR file.

Open... Opens an existing BMR file to review results of a previous
analysis. The application opens the file selection dialog allowing
you to choose the required file.
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Table 3-1: File menu options (cont.)

Command Function
Print Setup... Opens a dialog for selecting which printer and associated

options to use.
1 <filename>
2 <filename>
3 <filename>
4 <filename>

A list of the four most recently used BMR files. If Buffer Analyzer
has recently been installed, the list may hold less than four files.
Selecting a filename opens that BMR file for review.

Exit Finishes running the program.

View menu options. The following table lists the View menu options.

Table 3-2: View menu options
Command Function
Toolbar Displays or hides the toolbar.
Status Bar Displays or hides the status bar.
Settings… Opens the Settings dialog for specifying Video Buffer Sizes and

Video Data Transfer method.

(A check mark next to an option shows that the toolbar is currently visible; no
check mark means that it is hidden.)

Settings
Various configuration parameters, including Packet Interpretation, Pre-Scan
Packets, PES Private Interpretation, Video Buffer Sizes, Video Data Transfer
method, and Audio Buffer sizes can be modified before and after opening an
MPEG file. When a file is open, one or more streams can be analyzed, the settings
can be changed, and then other streams can be analyzed with the new settings. If
the settings are changed, to reanalyze streams analyzed with previous settings, the
MPEG file must be closed and opened again.

It is a good idea to check the settings before opening a file to verify the method
with which video streams will be analyzed.

Select Settings... from the View menu to open the Settings dialog.

This opens the Settings dialog, which has three tabs: System, Video and Audio.
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System Settings

These options can only be set before analyzing a file. They are disabled (grayed
out) while a file is open.

The MPEG2 / ATSC option is available on ATSC or ATSC/DVB dual standard
MPEG Test System products. It is disabled (grayed out) on single standard DVB
systems.

Packet Interpretation. Specifies which standards will be used for interpreting the
packets in the Transport Stream when a file is opened for analysis

The options are:

MPEG2 Interprets the packets according to the standards for DVB
streams.

MPEG2/ ATSC Interprets the packets according to the ATSC standards. This
option is required if AC-3 audio stream content will be analyzed.

Pre-Scan Packets. During the initial processing of an MPEG file, a number of
packets are prescanned for information that will result in a more accurate analysis
of the initial parts of the transport stream

The greater the number of prescanned packets, the greater the chance of locating
all of the information required for accurate analysis. The drawback is increased
processing time. By default, 10000 packets are prescanned, which should be
sufficient for most streams, excluding High Definition Video.

All Packets Select this check box to cause all packets to be prescanned.
If this check box is selected, the packets field will be disabled
(grayed out).

Packets If the All Packets check box is not selected, enter the number
of packets to be prescanned in this field.
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PES Private Interpretation. This setting specifies the model type to use for streams
signaled as PES Private (stream_type = 6)

The selections available include the following: AC-3 Audio, AAC Audio,
MPEG-2 Audio and Video, MPEG-4 Audio, H264 Video and System. The default
setting is AC-3 Audio.

Video Settings

Buffer Size. Specifies the sizes that will be used for the Main and Elementary
Buffers, when interpreting the stream. The options are:

Automatic Automatically detects the buffer sizes from the Sequence
Headers and Extensions in the elementary stream being
processed. This is the default option when the application is
started.

Manual Enables the size of the Main or Multiplex buffer (MB) and
Elementary Buffer (EB) to be specified manually. The MB and
EB fields are available for editing when this option is enabled.

Data Transfer. By default Buffer Analyzer inspects the stream to determine which
transfer method to use

This can be overridden if required. The options are:

Automatic Examines the stream to determine the transfer method. This is
the default option when the application is started.

Leak Method Initiates modeling of the stream using the Leak Method.
H.264 streams support only this method but the option can be
kept as Automatic.

VBV Delay Method Initiates modeling of the stream using the Video Buffer Verifier
(VBV) Delay Method. This option is specific to MPEG-2.
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Default Frame Rate. The frame rate is one of the parameters that is searched for
during the prescan phase of analysis. However, if it is not found, the default value
selected from the drop-down list in the Default Frame Rate field is used.

Audio Settings

Buffer Size. Specifies the size that will be used for the audio buffer when
interpreting the stream. The options are as follows:The options are as follows:

Automatic Examines the stream to determine the transfer method. This is
the default option when the application is started.

Manual Enables the size of the buffer (B) to be specified manually. The
B field is available for editing when this option is enabled.

AAC. Select the number of AAC channels required from the drop-down list

Within the ADTS (Audio Data Transfer Stream) fixed header, the channel
configuration field is used to indicate the number of channels required by AAC. If
the number in this field is zero, the value in the AAC Default channels field is used.

NOTE. The associated ADIF (Audio Data Interchange Format) is unsupported.

Refer to Information technology - Generic coding of moving pictures and
associated information, Part 7: Advanced Audio Coding (AAC) ISO/IEC
13818-7:1997

NOTE. Remember that if the settings are modified, the new settings are used for
all video streams that are subsequently processed. The settings are reset to the
default option when the application is started.
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Opening an MPEG File
Any file holding a recorded or synthesized sample of a Transport Stream that
carries video, audio, and/or system control streams can be analyzed. These files
are referred to as MPEG files to distinguish them from Buffer Model Results
(BMR) files. The results of analysis are written to a BMR file.

Opening a File from the
Menus and Toolbar

To open a file for analysis, select the New option from the File menu.
Alternatively, use the Ctrl+N keyboard shortcut.

NOTE. The list of previously used files shows BMR not MPEG files, as can be
seen by their .bmr extension.

There is a shortcut button for the New command on the Toolbar:

In response to the New command, the Buffer Analyzer opens a file selection
dialog to choose an MPEG file for processing. When the MPEG file has been
chosen, the MPEG file selector closes and another file selection dialog opens. This
is for choosing a Buffer Model Results File (BMR), which holds the results of any
analysis performed on the MPEG file.

NOTE. Choosing an existing BMR file will erase all results that had previously
been saved in that file.

Buffer Analyzer suggests an output file with the same name as the MPEG file but
a file extension of .bmr to hold the Buffer Model Results. Select OK to accept
the suggested filename. Otherwise, select a different file or type in a different
name, and then select OK.
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Opening a BMR File
An existing Buffer Model Results (BMR) file can be opened to review the results
saved in it from previous Buffer Model Analysis.

Opening a File from the
Menus and Toolbar

To open a BMR file, select the Open... option from the File menu. Alternatively,
you can use the Ctrl+O keyboard shortcut.

If the required file is in the list of recently analyzed BMR files, it can be opened
from the list to save using the open file dialog.

There is a shortcut button available on the Toolbar for opening a file, which has
the standard file open symbol:
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Window Layout
The Stream List window opens as soon as either an MPEG or BMR file is
opened. The application inspects the file to find what program streams are present
according to the Packet Interpretation setting. For example:

Initial Processing of MPEG Files
If an MPEG file is opened, the program performs initial analysis to form the
Stream List and calculate the mean transport rate. All streams in the list are
marked as Unprocessed, because no analysis has been performed on them in
this session.

To build the Stream List, the MPEG file is scanned for the PAT and PMT table
contents. It is assumed that the contents are constant, which is the general case.
If the program changes in a drastic way, such as streams disappearing between
PMTs, the model will give meaningless results.

Only the first occurrence of complete PAT and PMT are read when forming the
Stream List. Use TS Cutter to isolate a section when multiple versions of the
tables occur.

A number of packets in the file are scanned for the Sequence Header and
Extension start codes (containing profile and level) (See page 3-4, Settings.) for
more information. If they are not found the Main Profile and Level setting are
assumed together with the maximum VBV buffer size.
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Initial Processing of BMR Files
If a BMR file is opened, the State column indicates which streams were processed.
The file only holds results for those streams marked as Processed. To obtain
results for unprocessed streams, the original MPEG file will have to be opened
again and analyzed.
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Menus and Controls
When a file is open, the program presents a different set of menus and options.
They change as soon as the Stream List window appears. For example, the Open
file commands are replaced by Close file commands.

Toolbar

The Toolbar provides a set of convenient shortcuts for the more frequently used
menu options. The available commands are:

Opens dialogs to select an MPEG file for analysis and a BMR
file for saving the results. This button is disabled (grayed out)
when a file is open.
Opens a dialog to select a BMR file to review the results of a
previous analysis session. This button is disabled (grayed out)
when a file is open.
Closes the current file. This button becomes available the
moment a file is opened. If the wrong file is being opened, or the
wrong options are selected, clicking on the button will abandon
the analysis and close the file.
Opens the Settings dialog.

Prints the contents of the current window.

Opens a dialog that displays the program version number.

Analyzes the stream(s) from the PID(s) that are currently
selected in the Stream List. This button is only enabled when
one or more PIDs that are marked as unprocessed are selected.

The next group of five buttons open Results Views for the selected streams.

Opens a graph of the Transport Buffer for the selected stream.
This button is only enabled when the PID of a Processed stream
is selected in the Stream List window.
Opens a graph of the Multiplexing Buffer of a video stream; Main
Buffer of an audio stream or of a system information stream.
The button is only enabled when the PID of a Processed stream
is selected in the Stream List.
Opens a graph of the Elementary Stream Buffer for the selected
video stream. This option is only available when a PID carrying
a Processed Video stream is selected in the Stream List.
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Opens the Event Log for the selected stream. The button is
only enabled when the PID of a Processed stream is selected in
the Stream List window.
Opens all of the relevant graphs and the event log for the
selected stream. This option is only available when a PID
carrying a Processed Video stream is selected in the Stream List.

The remaining buttons control display options for Graphs of buffer analysis
results.

Toggles the graph displays between having all points drawn and
sampling the points for drawing.
Synchronize Graphs toggles the graphs between using the
same position and zoom settings or operating independently.
Auto Scale toggles the selected graph between fixed and auto
scaling of the y axis.
Zoom In increases the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.
Zoom Out reduces the magnification along the x-axis (time
scale) of the currently selected graph. All graphs are affected if
Synchronize Graphs is enabled.
Reset Zoom resets the magnification of the currently selected
graph from zoomed to original state.
Trace analyzes the message logs. You can view the message
log that is produced by the Buffer Analyzer.

The Toolbar can be dragged off the edge of the main window into a floating pallet.
To do this, place the mouse pointer on the background inside the Toolbar, (not
on one of the buttons), hold the left button down, and drag into the main window
area. The result is a self-contained window that looks like this:

To replace the Toolbar on the window border, drag it over the border, until the
outline changes shape, and release it. It can be placed on the top, bottom, left
or right edge.

Status Bar
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The Status Bar may be hidden from view, but when visible, the Status Bar is
always at the bottom of the main window. It displays the following information
about the program and keyboard states:

Menu Options
The available menu options are listed in the following tables.

Table 3-3: File menu options
Command Function
Close Closes the current file. This option is available as soon

as analysis starts. If the wrong file is being opened, or
the wrong options are selected, selecting this option
will abandon the analysis and close the file.

Print Prints contents of the current window.
Print Preview Prints contents of the current window.
Print Setup Selects printer and configuration.
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Table 3-3: File menu options (cont.)

Command Function
Font Selects the font to be used for printing text.Trace Print

Options Colors Not available with Buffer Analyzer.
Exit Closes any file that is open and terminates the

program.

Table 3-4: Edit menu options
Command Function
Cut Moves the currently selected records from the main window to

the clipboard.
Copy Copies the contents of the currently selected records to the

clipboard. They are not removed from the main window.
Delete Deletes the selected records from the main window.
Delete Except Deletes all records except those selected from the main window.
Delete All Deletes all records.
Select All Selects all records.

Table 3-5: View menu options
Command Function
Toolbar Shows or hides the Toolbar.
Status Bar Shows or hides the Status Bar.
Settings… Opens the Settings dialog.
Global Event Log Shows or hides the Global Event Log window.
Transport Buffer Opens a graph of the Transport Buffer for the selected PID.
Main Buffer Opens a graph for the selected PID in the Stream List. The

graph shows results for the Main Buffer of audio and system
streams or the Multiplex Buffer for video streams.

Elementary Buffer Opens a graph of the Elementary Buffer for the selected PID.
PID Event Log Displays the Event Log for the selected PID.
All Buffers Opens all graphs and the log for the selected PID.
Trace Generates a detailed trace log.

Table 3-6: Options menu options
Command Function
Draw All Points Toggles between drawing all points on the graphs, drawing

every nth point. ‘n’ is calculated from the total number of data
points and the screen space for the graph.
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Table 3-6: Options menu options (cont.)

Command Function
Synchronize Views Toggles the graphs between using the same position and zoom

settings and operating independently.
Auto Scale % Axis Toggles the selected graph between fixed and auto scaling of

the y axis.

Table 3-7: Process menu options
Command Function
Process Streams Applies the stream(s) from the PID(s) selected in the Stream List

to the System Target Decoder Buffer Model.
This option is only enabled when one or more unprocessed PIDs
are selected in the Stream List.

Table 3-8: Trace menu options
Command Function
View
Column Opens the column definition dialog box for selecting the columns

of information that has to be displayed.
Font Selects the font that is used for displaying the text of detail

message log records.
Colors.... Selects background and text colors that are used to display

each type of message.
Newest End Displays the newest record.
Show
Markers Shows markers permanently while using Trace with the Buffer

Analyzer.
General Text Shows or hides general messages. For example, messages

indicating the start of processing for a particular PID.
Fixed Shows or hides information such as transport rates and buffer

sizes.
PCR Timestamp Shows or hides messages about PCRs and associated

instantaneous transport rates.
System... Selects which types of system messages to show.
Audio... Selects which types of audio messages to show.
Video... Selects which types of video messages to show.
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Table 3-9: Window menu options
Command Function
Cascade Cascades the windows.

Tile Tiles the windows.

Arrange Icons Arranges any minimized windows along the bottom of the main
window. Aligns icons of any minimized windows at the bottom
of the program’s main window.

1 <window file> Lists all of the available windows. A check mark indicates the
active window. Select an option to bring that window to the top.

Table 3-10: Help menu options
Command Function
About Buffer Analyzer… Opens a dialog that displays the program version number.
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Stream List
The Stream List is displayed in the form of a tree view. The tree view is grouped
and sorted by the program numbers with the label for the PIDs, stream types,
and the states displayed. The Stream List displays all the elementary streams in
the file. An unprocessed state is indicated by the black label and the processed
state is indicated by the green label.

The ‘+’ symbol displayed to the left of some icons indicates that the item includes
lower-level stream components that are not displayed. The symbol changes to
‘-’ when the lower level components are displayed. To expand the hierarchy,
click on the ‘+’ symbol. Similarly, to collapse the hierarchy, click on the ‘-’ of
the selected upper-level icon.

The System, Audio, and Video PIDs of a specific program number are displayed
as leaf nodes of the same level.

Stream Type includes Video, Audio, AC-3 Audio, AAC Audio, System, or
Private. Private streams cannot be processed, but may show more information
about the type, for example ISO/IEC 13818 Auxiliary. The Packet Interpretation
from the System tab of the Settings dialog box sets the standard that is used for
identifying these types.

The preceding example is from a DVB compliant transport stream.
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An ATSC stream might look like this:

This tree view lists processed (analyzed in the buffer model) and unprocessed
streams. A stream may be processed only once when the file is open. To process a
stream again, the file must be closed and then opened again.

When an MPEG file is first opened, the program streams are all marked as
Unprocessed. Unprocessed state indicates that no buffer analysis has been so far
performed in this session so far.

If a BMR file is opened, the streams state will be displayed as processed or
unprocessed. The file only holds results for those streams marked as Processed.
To obtain results for unprocessed streams, the original MPEG file must be
reopened and analyzed.

Selecting Streams
To analyze or open the results views for a stream, or streams, they must first be
selected in the Stream List. To select a stream, click on the PID number.

For example, click on PID 1 Stream Type text to select the Video stream carried
in PID 1.

By using the Shift and Control key, you can make multiple selections for all the
tree nodes.
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You can select the highest level node to process all the descendent nodes. For
example, selecting the highest level transport stream node will process all the
PIDs or selecting a specific program level node will process all the PIDs of that
program.

To select a contiguous range of streams: click on the first streams PID, then hold
the Shift or▲ key down and click on the last stream’s PID number. If the required
streams are not adjacent, hold the Ctrl key down and click on the PID number
for each stream.

All streams can be deselected by clicking the mouse pointer outside the tree view
data. To deselect a particular stream while leaving the others selected, hold the
Ctrl key down, and click the stream’s PID number.

Processing Streams
When one or more streams are selected from the Stream List, they can be analyzed
in the buffer model.

To start analysis, select the Process Streams option from the Process menu.

Alternatively, click on the Process button in the toolbar.
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You can also process the highlighted streams by selecting Process Streams from
the shortcut menu.

When H.264 streams with SEI (HRD) parameters are processed, a dialog box is
displayed, prompting you to either continue or abort the processing of streams.
If you continue, the STD leak method will be used for analysis. If you abort the
process, the state of that stream will be displayed as aborted.

NOTE. For HRD model analysis, use Tektronix ES Stream Analyzer (MTS4EA).

Supported Profiles &
Levels

Buffer Analyzer supports 6 Profiles for MPEG-2 video: Simple, Main, SNR,
Spatial, High, and High4.2.2.

Buffer Analyzer supports 7 Profiles for H.264: Baseline, Main, Extended, High,
High10, High4.2.2, and High4.4.4.

It supports 4 Levels: High, High - 1440, Main, and Low.

Details of valid combinations of profile and level are given in standards document
ISO/IEC 13818 part 2 section 8.5.
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Start-Up The hypothetical T-STD specified in ISO/IEC 13818 part 1 section 2.4.2 assumes
a processing steady state. To handle the start-up processing before reaching the
steady state, Buffer Analyzer performs as follows:

The fraction of the first video frame leading up to the first picture start code
is not passed through the Buffer Analyzer. This is because it is not possible
to determine whether the Leak or VBV Delay method is being used. During
this period, the PES header, Sequence Header, and Extension information are
extracted. This information is used to determine the initial DTS, size of the
MB and EB buffers.

The Decoding Time Stamp (DTS) for the first frame is assumed to be correct.
It is used as a base for the timing of all subsequent frames. MB underflow
errors are suppressed during the first frame.

If the DTS of the first frame is not correct, use TS Cutter to remove the suspect
frame(s) from the file.

Approximations The application uses the following approximations to model the behavior of the
hypothetical T-STD:

Data is processed one packet (188 bytes) at a time. An underflow/overflow
condition that occurs and clears within the period of one packet will be missed.

Processing one packet at a time causes the buffers to be emptied in block
fashion, thus giving a stepped graphical output.

Slight quantization effects occur because the model is processed at discrete
time intervals, corresponding to a single packet length. This may affect the
VBV Delay calculations. The timing intervals for transferring frames from
MB to EB are dynamically adjusted to compensate.
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Event and Message Logs
The T-STD Buffer Analyzer allows you to access the Global Event log and the
PID Event log. You can use the Trace to create a log containing a more detailed
analysis of the entire process.

The views can be synchronized by selecting the Synchronize Views option from
the Options menu. While Synchronize Views is enabled, a change to any view is
immediately applied to all the other views.

Global Event Log

The Global Event Log displays: reports from the initial analysis, PID independent
information (Transport Stream errors) and high level details for each stream
processed.

For details of events detected during the processing of a stream, open the PID
Event Log for that stream.

PID Event Log
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An Event Log window may be opened for each PID that has been or is currently
being processed. Results are written to the log as they are produced. All time and
packet numbers are given, relative to the start of the file.

Event Selection Selecting an event row from the Event Log will place a cursor at that time in
each of the Buffer Results graphs. To select an event, click on the row of the
desired event.

To deselect an event, click the mouse pointer outside the data column.
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Trace
The Trace is used for analyzing the message logs produced by the Buffer
Analyzer. The message logs may be useful for in-depth analysis of the internal
processing, particularly for the video stream type. Trace has filtering capabilities
that allow you to focus on message types of particular interest.

Trace record is displayed only for processed streams.

User Interface To start Trace, select the Trace option from the View menu.

Alternatively, click the Trace button in the toolbar.

Trace displays the detailed message log in the main window. It has a Status bar at
the bottom of the window and a scroll bar on the right side.

The Status bar can be hidden from view, but when it is visible, it is always at the
bottom of the main window.

Detailed Message Records These are displayed in the trace window as a table. Each record is represented
by a single row of the table. The window displays buffer sizes, transfer rates,
profiles, levels, and frame rates that are used for the analysis. The window also
displays the data movements between buffers and their occupancies with respect
to time and packet numbers.

The example shows a log in which a PID (PID 17) carrying video was analyzed
and another PID (PID 20) carrying audio was analyzed.
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The types of messages that are displayed in the trace window is selected from
the Show menu.

To move forward and backward through the log, use the scroll bar on the right
of the window, the Page Up, Page Down, Cursor Up Arrow, and Cursor Down
Arrow Keys.

NOTE. If more than one PID is processed concurrently by the Buffer Analyzer,
the records will be interleaved in the Trace display. Unless this interleaving is
required, processing one PID at a time will make it easier to follow the messages
for each stream.

Selecting Records Records may be selected for printing, copying, deleting, and other Edit menu
operations. To do this, they must first be selected.

A single record can be selected by clicking on it. To select a contiguous range of
streams, click the first record to be selected and then hold the Shift down and click
the last required record. Alternatively, click the first record, hold the left mouse
button down and drag the pointer to the last record.

Selected records are repainted in the highlight color scheme. By default, this is
black text on a magenta background. For example:

The selected records can be edited and viewed by using the shortcut menu option.
You can edit (cut, copy, delete) records, define the Trace (column, font, colors),
and select messages (System, Audio, Video) to be displayed in the Trace. You can
also show/hide general text, fixed, and time stamp features.
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Column Options To set the columns of information that are displayed in the Trace table, select the
Column option from the View menu.

A column is shown for each option that is enabled and is indicated by a check
mark. Clicking on an option toggles it between being shown and hidden.

Fonts The font of the messages displayed in the Trace table can be changed using the
Font dialog box.
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You can select the font, font style, size, and script from this dialog box. A sample
of the selected font is displayed in the Sample display box. Click OK to see the
selected font in the Trace table.

Color Schemes The color scheme for each message type and for highlighting selections can be
changed using the Select Colors dialog box.

To modify the color schemes, select the Colors option from the View Menu.
This opens the Select Colors dialog box.

Select the message type to be changed from the list box on the left. The current
color scheme will be displayed in the Sample under the list box. Click on the
swatch (colored square) in the Text Color and Background panels for the required
text and background colors.

Repeat the procedure for each message type that is to be changed and click OK.

The Reset button restores the selected message type to the default color scheme.
The Reset All button restores all the color schemes to their defaults.
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Results Graphs
The results of the analysis are plotted on a separate graph for each buffer. When a
graph is opened for a stream that is still being processed, each result is plotted as
soon as it is produced from the model.

All of the graphs have a similar format and controls.

Common Features
The Axes All of the graphs plot time from the start of file on the x-axis and current space

used in the buffer on the y-axis.

Zoom When the results graph is first opened, the entire graph is shown. Even a small file
may display data points packed too closely to see the features clearly. For example,
here is just under 20 seconds of a video stream that generated several events:

Even this small sample holds some solid bands of blue lines and green event
markers, from which only general trends can be determined.

To change the time scale (x-axis) to resolve finer detail, click on the Zoom In
button on the Toolbar:

Zoom in as many times as required to achieve the desired magnification. The
magnification is doubled each time the button is clicked.
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In this example, clicking the Zoom In button three times gave a much clearer view:

To Zoom back out, click on the Zoom Out button as many times as required:

Each time the Zoom Out button is clicked, the magnification is halved, until the
full graph is again displayed.

Scrolling the View The slider at the bottom of the window indicates where the displayed area is in
relation to the rest of the file. It can be used to scroll the display through the graph
in a similar way to a window scroll bar.

To scroll the stream through the view:

Drag the Slider Control left or right with the mouse.

Click the mouse pointer in the slider bar (either the clear sections or the view
bar) to the side of the Slider Control.

When a time or event is selected on the graph, the Slider Control is automatically
repositioned within the View Bar. The placement of the Slider Control reflects the
position of the selected packet in the field of view.
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Event Markers A graph may show one or more green triangular markers along the top. Each
marker indicates the time a particular event, listed in the PID Event Log, occurred.

Only events that relate to the points plotted on the graph are displayed in that
graph. An event relating to a Video Multiplex Buffer will only be marked on the
Video Multiplex graph and not on the Elementary or Transport Buffer graphs.

Double-clicking on a marker will display a pop-up window. This shows the time
and a brief description of the event that is marked.
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For example, selecting an event relating to the Elementary Buffer from the Event
Log of a video stream will place a cursor at the time of the event in the buffer
results graphs. Looking at the graphs, a marker of the event has been placed on
the Elementary Buffer graph, but not the Multiplex Buffer graph.
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Synchronize Views Graphs of results can be open for one or more streams. For each stream, one or
more graphs can be displayed. The graphs can have their zoom, cursor position
and visible section manipulated separately or all the graphs can be synchronized.
For example, in unsynchronized operation, the open graphs might look like this:

This pair of graphs show different periods in the file at different magnifications.

To synchronize the views, select the Synchronize Views option from the Options
menu.

Alternatively, click on the equivalent shortcut button.
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This will apply the zoom, cursor, and visible section of the active window to all of
the other graphs. While Synchronize Views is enabled, a change to any graph is
immediately applied to all the other graphs.
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The Trace table can also be synchronized with the other graphs by enabling the
Synchronize Views icon. While Synchronize views is enabled, a change in the
selected event of the Trace table moves the cursor position of all other graphs
accordingly. Similarly, a change in any of the graphs moves the highlighted event
of the Trace table accordingly.

To separate the control of the graphs, disable synchronize views by selecting the
menu option or by clicking the shortcut button again.

Selection The cursor can be repositioned within a graph by clicking on the required point.
This is useful when Synchronize Views is selected as a way of marking the same
time in all the graphs for ease of comparison.
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Auto Scale The scale on the y-axis of the graphs shows space used in the buffer as a
percentage of total space. By default, all of the graphs have a vertical scale that
goes from -50% to 200%. The following illustration is an example.

Selecting the Auto Scale % Axis option from the Options menu changes the
y-axis for the active graph.

Alternatively, select the equivalent shortcut button.

The y-axis is now drawn so that the full scale contains the range of values in the
graph, to the nearest 25%. For example, if the range of values was from 30% to
64%, the y-axis would go from 25% to 75%.
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The earlier example will be rescaled to look like the following:

To revert to the default scale, select the menu option or click on the shortcut
button again.

Draw All Points The graphs will often contain more data points than can be resolved on the screen.
By default, to avoid drawing points on top of each other, the application will plot
every nth point. This also speeds up the drawing process. How many points to
plot is determined from the available width of the graph on the screen and the
total number of points to plot.

Use the Draw All Points option to look for outlying points and to resolve the fine
detail when the display is zoomed in on the data.

Selecting the Draw All Points option from the Option menu will cause the
application to plot every point.

Alternatively, select the equivalent shortcut button.

For larger files, this might take much longer than the default option. The option
may be disabled by clicking on the shortcut button again or deselecting the option
from the menu. This can be done even while the analyzer is still redrawing the
graphs.
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Elementary Buffer Graph

An Elementary Buffer graph can only be opened for Video Streams, since these
are the only type that have an elementary buffer.

Elementary Buffers are not allowed to overflow, so the graph of the results never
goes above 100%. The graph uses the scale -50% to +250% to make comparison
easy.

Multiplex or Main Buffer Graph
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For Video streams this graph shows the results for modeling a Multiplex Buffer.
For Audio and System Control streams the graph shows the results for the Main
buffer. The title bar shows the stream type.

Here is an example to show the title for a graph of a System Control stream.

Transport Buffer Graph
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The Transport Buffer graph shows the results of modeling the Transport Buffer
for Video, Audio, or System Control streams. The type of stream is shown in the
title bar. In the above example, the results plotted are for a Video stream carried
in PID 305.

Here is an example of an audio stream.
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Elementary Stream Analyzer
Elementary Stream (ES) Analyzer is an MPEG (Motion Pictures Expert Group)
stream analyzer that allows all MPEG-1 and MPEG-2 streams to be quickly
analyzed. Developers of MPEG compliant encoder and decoder systems, or field
application engineers (FAEs) supporting MPEG-based products will find ES
Analyzer a powerful and easy-to-use tool and debugging aid.

ES Analyzer provides the following facilities:

Analyze in detail and verify whether MPEG-1 system and MPEG-2,
video, and audio streams conform to MPEG standards. (A built-in stream
demultiplexer makes it possible to analyze elementary streams embedded in
a transport stream. All streams are checked for both syntactic and semantic
conformance. Syntactic conformance means conformance with the MPEG
language, while semantic conformance relates to the field value and range
restrictions.)

Quickly zoom from transport streams, through PES and video streams into
GOP, pictures, slices, and all the way down to the macroblock layer.

Play out audio streams to MPEG-1, MPEG-2, Layers I and II, Japanese AAC,
and Dolby Digital (AC-3) standards.

Audio play to soundcard.

Analyze Layer I, Layer II audio data, AC-3 audio, and AAC audio.

View video output with the incorporated video player and analyze picture
data for any frame.

Produce picture quality analysis data including Quantizer Scale distribution,
motion vectors graph in a picture, and macroblock and picture size plots.

View the coded block patterns that have been extracted.

Display and analysis of DCT coefficients for each macroblock in a picture.

View interpreted and hexadecimal view of headers for all streams.

Display and analysis of DVB Teletext information.

View and analyze DVB subtitle content.

View and analyze ATSC closed caption to EIA608 and EIA708 standard.

View PID spectrum analysis for transport streams.

Analyze multiple streams in batch mode through the regression testing mode.

Quickly navigate through stream hierarchy using the powerful and easy to use
graphical interface including the Stream Properties summary window.
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‘Seekback’ at all levels, allowing users to go back in a stream at all levels,
thus allow more flexibility in navigation.

Set a level to report errors, filter them, and also store errors in log files.

NOTE. It is assumed that you are familiar with MPEG compression standards and
terminology. If you are new to MPEG and want to know about MPEG compression
standards and terminology, refer to the documents: ISO/IEC 11172 (Vol. 1, 2, 3
and 4) for MPEG-1 and ISO/IEC 13818 (Vol. 1, 2 and 3) for MPEG-2 basics.

Starting the ES Analyzer
The program can be started by selecting the Tektronix ES Analyzer option from
the Start > Programs menu or by double-clicking on the Tektronix ES Analyzer
shortcut on the desktop.

Initially an empty shell window is displayed. It is necessary to open a stream
before any screen details can be seen.
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Opening an MPEG Stream
1. To open a file, select the Open… option from the File Menu or select the

corresponding icon on the toolbar.

The following dialog box appears:

ES Analyzer displays a standard windows Open dialog box with two
additional fields: Hex Window and Open As.

2. Select the file you want to open.
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The types of files that can be opened are as follows:

Transport stream files

PES stream files

Elementary stream files

MPEG-1 and MPEG-2 files

Regression scripts

Mask files

NOTE. If you want ES Analyzer to automatically detect the type of MPEG
stream the file contains, let the default Auto remain in the Open as field.

If you want to open the file as a specific type of stream and do not want ES
Analyzer to detect it, select the stream type in the Open as field.

If you open an MPEG stream as an incorrect stream type, numerous errors
may be reported and ES Analyzer may also behave unexpectedly.

If you open an ATSC stream as auto and the stream contains no PSIP service

information, the AC-3 audio may appear as and not decode. Close the
file and reopen with ATSC Stream selected from the Open as field; the AC-3
audio will now decode correctly.

3. Enable or disable the hex window.

ES Analyzer parses and demultiplexes the opened MPEG stream, and displays
the packet header fields in two formats—interpreted and hexadecimal.

If you want ES Analyzer to display the packet header fields in both the
formats, interpreted and hexadecimal, check the check box next to Hex
Window. (The hexadecimal format is displayed in a separate window.)

If you want ES Analyzer to display the packet header fields only in the
interpreted format, let the default remain. (By default, the check box next
to Hex Window is clear.)

NOTE. If you do not enable the Hex Window when you open a stream, you
cannot enable it later when ES Analyzer is parsing the stream.

4. Click Open when you are through with this dialog box.
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Understanding the Main Window and Icons
ES Analyzer allows you to view multiple programs and streams simultaneously.
The tree view area on the left side displays the stream hierarchy. For the currently
selected stream, the details of the header are shown on the right side. Errors, if
encountered, are logged in the error log window at the bottom. A summary of the
stream parameters is displayed in the Stream Property window. The status bar at
the bottom of the window displays the current status and stream characteristics.

Tool Bar The tool bar provides a means of accessing frequently used menu bar commands
quickly; each icon represents a menu bar item. Icons will display a tooltip
description when the cursor is rested over it. The tool bar illustration below does
not show all of the buttons.

The table below lists the function of each icon and also indicates when the icon is
available. Availability refers to an icon being enabled or disabled with respect to
selected nodes in the left tree view window; disabled icons are ‘grayed out’.
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You can toggle the tool bar display by selecting/deselecting the Toolbar command
on the View menu.

Table 4-1: Tool Bar icons

Icon Function
Availability
(Enabled/Disabled) Menu Bar equivalent

Opens an MPEG stream, a saved
regression file (.REG file by default),
or dumped reports

Always enabled File > Open…

Restarts analysis from the beginning
of the selected parent or child
stream

Enabled for all nodes Node > Intialize

Extracts a PES, Audio, or Video
stream from a multiplexed stream

Enabled for all the
embedded stream
nodes (PES, VES, AES)

Node > Dump Stream

Allows navigation to the selected
TPT packets; used in conjunction
with the Next icon

Enabled for Transport
and Program

-

Enables navigation to the nth packet
at TPT node or the nth GOP at
GOP node or nth frame at AES
node. Used in conjunction with the
adjacent button

Always enabled;
disabled only for VES
node

-

Allows navigation to the
next/previous packet of the
selected node

Always enabled;
disabled only for VES
node, or at end of file

Next/ Previous Packet/
GOP

Toggles Start and Stop to run
through Test mode

Only enabled at GOP
level

Start Stop

Toggles between hexadecimal and
decimal display of data in fields

Always enabled -

Shows or hides the error log window Always enabled -

Shows or hides the Hex Viewer,
which displays data in hexadecim

Enabled if Hex Window
is checked when
opening a stream,
otherwise always
disabled

-

Enables or disables packet view
analysis that displays the PID
spectrumal format

Enabled only for PES -

Allows zooming into any part of
data being displayed; useful when
viewing Motion Vector Display in the
Slice And MB tab

Always enabled -

4–6 MTS400 Series Analyzer Applications User Manual



Elementary Stream Analyzer

Table 4-1: Tool Bar icons (cont.)

Icon Function
Availability
(Enabled/Disabled) Menu Bar equivalent

Shows Frame Size Statistics for
different frames within a GOP

Enabled only for GOP
node (Disabled if the
Picture Player tab is
selected)

Frame Sizes

Shows Slice Size Statistics, i.e.,
information about the sizes of the
slices within a Picture in a GOP

Enabled only for a GOP
node from within the
Slice And MB tab

Slice Sizes

Allows viewing the version and
copyright information

Always enabled Help Topics

Working with ES Analyzer
Commands

When using ES Analyzer, you can issue commands in one of three ways:

By clicking commands on the menu bar; this also includes the keyboard
shortcuts, which are shown next to the menu bar entries

By clicking icons on the toolbar

By clicking the right mouse button and selecting a command on the quick
menu

After you have invoked ES Analyzer, you need to select the bit stream file
you want to be analyzed by clicking Open on the File menu or by clicking the
appropriate icon on the toolbar. If the bit stream file is a valid MPEG file, ES
Analyzer displays the first packet of the top level stream. Now you can use
commands, described below, to navigate randomly to any part of the stream. You
can also run through a selected embedded stream using the Go command.

Tree View and Navigation

Figure 4-1: Icon Function Availability (Enabled/Disabled) Menu Bar equivalent
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The tree view window displays the stream hierarchy of the currently opened
bit stream file. Each node in the tree view represents a level of hierarchy and
is displayed with:

An associated icon (the icon varies depending on the type of stream that the
node represents; these are displayed in the following table).

A tip that describes the kind of stream represented by the node.

The PID associated with the node, if applicable.

Table 4-2: Navigation icons
Icon Stream type representation

Transport stream.

Program stream.

System stream.

Packetized elementary stream (PES); PES containing a video
or audio stream, respectively.

Audio stream; an MPEG-1 and/or MPEG-2 audio stream.

Teletext.

Dolby AC-3 audio stream.

Video stream; an MPEG-1 and/or MPEG-2 video stream.
If Closed Caption data is detected during analysis, ‘CC’ is added
to the video icon.
User data stream.

Group of pictures (GOP).

DVB subtitle PES.

Suffix 1 and 2 in the Tree View icons (Video and Audio Elementary Streams)
refer to MPEG-1 or MPEG-2. Note that MPEG-2 streams can contain MPEG-1
audio information.

NOTE. If packets are scrambled or if stream analysis (AAC Audio) has been
excluded by dongle, ES Analyzer does not display them.
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Navigating through
Streams

When an MPEG file is initially opened, ES Analyzer automatically determines the
kind of MPEG stream it is. For a valid MPEG bit stream, ES Analyzer opens the
tree view with a node for the top level stream contained in the file. By default,
the stream hierarchy is expanded to only one level. You can expand/collapse a
node by clicking it. You can select the stream to be viewed at any level displayed
in the tree view window by simply clicking the left mouse button on the specific
node. Automatically, the window on the right is refreshed to display the header
and related information for the selected node.

ES Analyzer gives you full flexibility in viewing streams at any level. You can
navigate through the stream independently at each level of the stream. For
example, you may be viewing the first PES packet of a PES Stream, but in the
embedded VES stream, you may be viewing the last GOP that is not contained
in the first PES packet.

Using GoTo, Next and Previous Commands. These commands are applicable to all
types of streams and assume that you have opened a valid MPEG file

Each of these commands can be executed for any node that is displayed in the
stream hierarchy tree where each node is either a GOP or a valid MPEG stream
(embedded or top level).

Step forward/backward to the Next/Previous packet or GOP in a video stream
for the selected node.

Position the file pointer to the nth packet or GOP in a video stream or frame in
an audio stream for the selected video/audio node.

Position the file pointer to the nth packet of the selected PID; this is applicable
to MPEG-1 system streams and MPEG-2 transport and program streams.

Position the file pointer to the first packet of the selected node.

Save the embedded stream corresponding to the selected node in a separate
file.

Toggle between hexadecimal and decimal display.

Use the Transport Stream PID drop-down list to select a PID and navigate to
the selected PID using the Next button.
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Header, Extension and Hex Displays
Header Display Window The header display window shows the current header and related information for

the selected node in a read-only mode. The fields are interpreted and displayed.
The header is not displayed syntactically. Wherever field codes represent specific
values, the corresponding value is shown rather than the code itself. For example,
in a video sequence, although Chroma format is a two-bit code, it is displayed
with the interpreted value of 4:2:0 or 4:2:2 or 4:4:4.

You can view field values in decimal or hexadecimal format by clicking the
appropriate icon on the toolbar. One bit fields are displayed using one of three
icons:

Table 4-3: Header icons
Icon Field value representation

One-bit field was set to 1

One-bit field was set to 0

One-bit field is not applicable here

Almost all MPEG headers allow stuffing bytes and have marker and unused bits
defined in their syntax. Although all these are parsed and checked for correctness,
they are not displayed since they do not provide any meaningful information.

Wherever appropriate, ES Analyzer provides visual feedback, by the use of color,
to represent different states.

Extension Displays Besides this generic structure, individual headers may have special displays.
For example, the video sequence header has a lot of information to be displayed
in a small area. This is achieved by using tabbed folders for all the MPEG-2
extensions (see the following illustration). The tab corresponding to an extension
is disabled if the corresponding extension does not appear in the sequence header.

When an extension appears in the video sequence, its presence is also
communicated by the changed color of text (in red) on the corresponding tab.
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Hex Display Window The hex display window shows a hexadecimal dump of header bytes contained in
the header being currently displayed in the header fields display window. This is
useful if you are used to viewing the headers in the hexadecimal format rather
than the interpreted format that is displayed in the header display window. Also
able to be displayed are sequence information at VES level and frame information
at GOP level (as shown below).

The data collection for the hex display window can sometimes be memory
intensive and can affect ES Analyzer’s performance. You can turn on the hex
display or turn it off according to your requirements by checking or clearing the
check box next to Hex Window in the Open dialog box. If you have not enabled
the Hex Window option when opening a stream, you will be unable to open it
when ES Analyzer is parsing the stream. However, you can dynamically turn off
the Hex Window, whenever you want, by clicking the Show/Hide Hex Viewer

icon on the toolbar if you enabled it when you opened the stream (see details
in the Opening an MPEG Stream section).

The hex window displays a hyphen (-) after every eight bytes for display purposes.
The status bar in the hex window displays the current cursor position’s byte offset
from the start of the header. If you select a sequence of bytes in the hex window,
the size and the byte offset from the start of the selection appears in the status bar
when you release the mouse button.

To search for a specific byte pattern in the Hex Window:

1. Type the pattern in the Find field, on the left of the Find button, on the status
bar.

2. Click the Find button.

The specific pattern will be searched from the current cursor position. If the
pattern is found, it is highlighted in the hex window. If the pattern is not found,
you will hear a beep. The search loops back to the beginning of the file and
subsequent occurrences of a pattern can be found by clicking the Find button.
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To position the cursor to a specific byte location from the start of the packet header:

1. Type the byte position in the Goto field, on the left of the Goto button, on
the status bar.

2. Click the Goto button.

The cursor will be positioned to the corresponding byte location in the header in
the hex display window.

Summary of Displayed Information (Header and Hex displays). The following
table summarizes the information displayed in the hex window that corresponds
to the information displayed in the header display window.

Table 4-4: Hex Headers Display
Header display window
information Hex dump in the hex display window
Transport packet header. Header data of the current packet.
PES Header. Header data of the current packet.
MPEG-2 Program stream - Pack
Header.

Header data of the current packet.

MPEG-1 System Stream - Pack
Header.

Header data of the current packet.

Video stream - Sequence header /
sequence extension.

All the video level information which is above the GOP level.

Video stream - When viewing
picture at Picture or Slice level
display (with video analysis setting
set to Macroblock level).

All the information for the currently selected picture. When the first picture is selected in the
picture slider, data corresponding to the GOP header (if available) along with first picture data
appears. For all pictures other than the first picture in the GOP, only picture data is shown. The
subsequently read sequence header and extension data is updated in VES node.

Video stream - Hex data display
when viewing picture at Slice level
display (with video analysis setting
set to Picture level).

Same as above.

Video stream - Hex data display
when viewing picture in Picture
display form (with video analysis
setting set to Picture level).

Same as above, but with the following exception.
Picture data includes only picture header and extension data. No slice or macroblock level data
is shown. However, when you go down to the slice level display by clicking the Slices button,
ES Analyzer appends slice and macroblock data in the current picture data for the hex viewer.
When you return to the Picture display dialog, ES Analyzer continues to show the complete
picture data. The pictures for which you do not step down to the slice level, you’ll still be shown
picture data that includes only the picture header and extension data.

Audio Stream Both frame header and audio data is shown.
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Error Testing Methods and Outputs
ES Analyzer can error check an entire stream in an automated manner (regression
test). Part of a stream, triggered from a node for a specific program, can be
manually checked (run though mode).

Regardless of the stream type, testing is only possible at the compression layer;
it is the task of Tektronix TS Analyzer and PES Analyzer to test at the systems
layer. However, you can still view the headers of the transport and PES packets,
but note that no tests are performed (either run-through or regression).

Both test modes will produce screen or file output error messages. Manual test
is also possible by examining the various block/slice/vector and picture display
menu screens.

Error filters can be applied to the tests, and fields selected to allow diagnostics up
to the error point to be dumped in a file for ‘pre error point’ analysis.

Run Through Stream Test Mode
This is operated by highlighting the test node - usually the GOP filmstrip icon - of
the appropriate program, then clicking on the Start/Stop (green ball) in the top
toolbar.

The stream will be run though and errors reported in the error display window.

Error Display Window The error display window displays information, warning and error messages
generated by the run-through test mode for a specific program node.
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For each message, the following are shown:

An associated icon that indicates the kind of message (the icons E, I, and S
shown below indicate a syntactic error, information, and a semantic error,
respectively):

where:

E = protocol syntax (Rules) error.

S = semantic-parameter or data range error.

I = Information only; not an error. Both E and S should be regarded as errors.

A string that identifies the exact location in the bit stream where the error was
encountered; the format of the string is:

(STREAMTYPE) -> (STREAMTYPE, STREAMID) -> (NODE) (packetNumber)

For example, the following string identifies an error in packet number 2 of the
MPEG 1 audio stream on PID 210:

TPT->PES(PID=210), MPEG 1 Audio->AES0(2)

The message string associated with the message.

Double-clicking a message in the error display window lets you view more
detailed information about the message.

Error Filtering
Configuring and Filtering

Messages for Display
You can configure and filter the kinds of messages you want ES Analyzer to
report. You can turn on/off messages of any type (Information, Errors, Semantic
checks) to be reported for the entire stream, or any node in the stream hierarchy
displayed in the tree view. You can also store the displayed messages in a file
or clear the message window.

To configure messages:

1. Click the right mouse button anywhere in the error display window.

2. Select Filter Messages from the context menu that appears:

4–14 MTS400 Series Analyzer Applications User Manual



Error Testing Methods and Outputs

The Filter Message dialog is displayed. The dialog box contains two tabbed
pages: Global and Node.

Message Filtering - Global. The Global Message Filter tab provides settings that
can be used to select which messages are enabled and disabled and how many
times enabled messages are to be displayed

The rules created are global; that is, they will be applied to all nodes in the active
stream. Rules to be applied to a single node (such as PSI, PES, VES) can be
added from the Node tab.

The top half of the Global tab contains:

A drop-down list from which the category of messages can be selected to
which rules are to be applied, and

Three options for the display of messages.

As rules are created using these fields, they should be added to the Rules text field
below by selecting the Add Rule button.
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The three options are as follows:

Disable all messages on the basis of severity, that is, Info (I), Semantic (S)
or Error (E). Enable the Disable Messages(s) of checkbox, select the type of
message to be disabled and press the Add Rule button. Note that the rule is
added in the Rules text field.

Disable messages on the basis of message number. Each message is assigned
a unique number based on the type of streams it is related to; a tooltip will
be displayed when the cursor is passed over the message number. Enable the
Disable message Number(s) checkbox, select the message numbers to be
disabled and press the Add Rule button. The Shift and Control keys can be
used to make multiple selections. Note that the rule is added in the Rules
text field.
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Report repeated messages only a specified number of times. Enable the
Report Message Number(s) checkbox and select the message numbers to be
disabled. The Shift and Control keys can be used to make multiple selections.
Select the maximum number of times that the message is to be reported and
press the Add Rule button. Note that the rule is added in the Rules text field.

Combinations of message rules can be created; they will need to be created and
added one at a time.

Rules can be removed individually (Remove Rule button) or globally (Remove
All button). Rules that are already set cannot be edited; they must be removed
and recreated.
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Rule sets can be saved and reloaded as required using the Save Rules… and Load
Rules… buttons.Message Filtering - Node.

1. Select a stream in the left scroll window and then select the types of messages
you want to be filtered out. By default, all messages are displayed for a stream.

If you want your message filter(s) to be applicable to all streams opened
until now, select it for the entire World. This option will apply the filter(s)
to all nodes displayed in the tree view window.

If you want your message filter to be applicable to all streams, irrespective
of whether they are opened or not, click the Set for all Streams button.

2. Click OK to accept to changes; Cancel to close the dialog box without
applying the changes.

To Store the Displayed
Messages:

1. Click the right mouse button anywhere in the error display window.

2. Select Dump To File from the menu that appears.
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3. The Dump Message dialog box is displayed. Enter the name of the file in
which you want to store the messages.

4. Click the Save button when done.

To Clear the Windows 1. Click the right mouse button anywhere in the error display window.

2. Select Clear Log Window from the menu that appears.

MTS400 Series Analyzer Applications User Manual 4–19



Error Testing Methods and Outputs

Status Bar
During regression and run-through mode, progress through the stream is indicated
by the status bar at the bottom of the main window. The status bar is split into
multiple fields and displays the following:

A progress bar indicates the approximate byte position in the file for the
currently selected stream.

NOTE. Since you can view each embedded stream inside a multiplexed stream
independently, it is possible that in each embedded stream you may be viewing
packets which are far apart in the stream. In such cases, the file pointer will be at
different positions for each embedded stream and the file progress bar is updated
according to the stream being currently viewed. The byte offset in the file for the
currently displayed unit of data is also displayed in the status bar. For example,
when you are viewing a Packetized Elementary Stream (PES), the byte offset of
the first byte of the start-code of the currently viewed packet in the opened file is
displayed in the status bar. Similarly, when viewing a GOP in a Video stream
that is embedded in a Transport stream, the byte offset of the start code of the
corresponding GOP in the file is displayed in the status bar. More details are
given with the explanation of status bar with each individual stream.

Characteristics of the stream being currently viewed. These vary with the
stream and are described in detail for each stream in subsequent chapters
in this book.

The state of the status bar display can be toggled by selecting/deselecting the
Status Bar command on the View menu; that is, View > Status Bar.
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Regression Testing and Error Log Files
With ES Analyzer, you can regression test MPEG streams (with errors being
saved to log files) and save data from selected fields to report files for viewing
later (see the section Reviewing a Report for details).

Regression Test Window To perform a regression test, close the file, if it is open, using the File menu.
Select File > New Regression Script…. Note that disk drive icons are displayed
on the right side of the directory window; you may need to scroll right to
view/access them.

Double-click on the file you require and it should appear in the lower window
Streams Selected for Regression with an orange question mark to the left of the
file name.

When regression is done, this will turn to a red or green ball, depending on the
errors found. A default log file name is entered; it can be renamed by clicking on
the double-arrow button to the right of the name. After regression testing, the log
file can be viewed by double-clicking on the log file name.

Error messages written to the log file can be controlled via the Message Settings
screen.

The button View Reports is only available to show dump/.dat files if they have
been set up beforehand (see Select Fields and Reviewing a Report sections).
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Setting up the Regression You can select multiple streams for regression from the displayed list of files. (To
select multiple files, double-click a file or select it and then drag-and-drop it in the
lower window.) The streams selected for regression appear in the lower window.

For each stream, the following are displayed:

File name.

Default log file where the messages for the stream will go. You can change
this by clicking the icon displayed next to the log file name. ES Analyzer
displays a default directory where all log files are created that store the
results of the regression. You can change the directory for storing log files
by clicking the Default Dir… button.

The stream type. Initially this is not known and is set to Unknown. Once
the regression is complete, this is updated to reflect the type of stream that
the file contains.

An icon indicating the state of the stream. Initially, when a file is selected,
the icon appears as a question mark indicating an unknown status. After the
stream is regression tested, the icon changes to red if the regression reported
errors, or changes to green if there were no errors.

For a regression test, you can also select embedded streams that correspond to
nodes in the tree view for a stream hierarchy. You can do this by clicking the
Streams Option button in the regression test window; see Reviewing a Report
below. This displays the settings for the current stream. By default, the tests
are enabled for all types of streams, which you can disable. Saving a regression
script also saves these settings.
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Running the Regression Once you have set up a regression script, you can run it by clicking the Start
Regression button. A status window displays the continuous status of the
regression. If you want, you can cancel the regression anytime by clicking the
Cancel Regression button in the status window. When the regression is complete,
the state of the regression run on each stream is displayed in a dialog box through
the changed icon which is red (for failure) or green (for success), and the updated
file type. The icon remains a question mark if the file was not a valid MPEG file.

Viewing and Saving
Results

You can view the error log file created for any stream after it has been regression
tested by double-clicking the specific bit stream file in the regression test dialog
box. You will need to associate files of the type *.log with a text editor of your
choice. You may do so through the Explorer. Click View > Options to display the
Options dialog, and then click the File Types tab. By default, ES Analyzer opens
the log files with the application with which they are currently associated.

You can save the regression script and the results in a regression script. To save
the file, choose Save As from the File menu. The file is saved as a binary file and
also saves the regression results. You can reload the regression file including the
results of the last regression whenever you want. Regression can also be run on a
previously saved regression script file.

Message Settings Messages sent to the log file can be controlled through the Message Settings
dialog box. Rules to be applied to messages can be created as required. The
operation of this dialog box is similar to Message Filtering. For more information
(See page 4-14, Error Filtering.)

Reports and Field Selection
You can save and review reports consisting of field value dumps of specific fields
when you regression test a stream. To review a report, it must first be created by
selecting the fields to be viewed, then setting up and running the regression, and
finally selecting the View Reports button (it is also possible to select and open
multiple reports).

Creating a Report A regression report is packet-by-packet details listed with information fields you
can choose. A report is not an error list, although errors detected may appear in it.
A report can be used to examine run-ups to problems (pre-trigger).

Before starting a regression test, select the Stream Options button in the
Regression test window. Ensure that the Dump Fields check-box is enabled and
select the adjacent Select button. You can then add the fields to be listed in the
dump file columns (individual fields or all fields).

You can check the dump in file box and name your dat file or use the default
VES.dat or AES.dat.
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Do this for video & audio elementary streams.

To select fields.

1. Click the Stream Options button in the regression test window to display
the following screen.

2. Enable and disable the streams using the checkboxes in the Analyze column.

Deselect the streams you don’t want ES Analyzer to analyze. By default,
all the streams are selected.

3. If you want to analyze Video Elementary Streams, you may either select
Macroblock Level or Picture Level from the adjacent drop-down list.

4. Select the streams for which you want to dump data by enabling the checkbox
under the Dump Fields column.

5. Click the highlighted Select button to display the Select Fields dialog box.
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6. Finalize the list of names by adding/deleting the field names in the Fields
Included list box and click OK.

If you have selected a video elementary stream, ES Analyzer also displays
options in the Select Fields dialog box.

You may click the appropriate buttons to select fields specific to these options.
This is a quick way to add/delete specific fields into the Fields Included list
box; otherwise, you will need to manually find and add fields from the Fields
Excluded list box.

For example, if you have added all the fields from the Fields Excluded list
box, and now want to delete VES-related fields from the Fields Included list
box, you may click the Delete All button in the VES section. You can also
click the Add All button under Display Extension to add related fields to
the Fields Included list box.

You may also double-click a field name displayed in the left list box to include
it in the right list box.

7. Specify the file into which you want the fields to be dumped.

You may type the filename (*.dat) or select one by using the browse button
next to the default filename.

8. Specify the dump options.

If you select Part of Stream, the Maximum Size (MB) field is enabled and you’ll
need to specify the size of the stream from which the fields will be dumped.

Once you have specified the fields, return to the regression test window by
clicking the button next to the Stream Options button.
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Reviewing a Report A sample report looks like this:

Collecting Statistics for "C:\mpegstreams\mls\bird4.mpg"

Date 04/02/98 Time: 16:38:42
Packet No. SCR Fixed Flag Audio Bound
1 0 1 1
2 1083 1 1
3 1083 1 1
4 3250 1 1
5 4334 1 1
6 5417 1 1
7 6501 1 1
8 7585 1 1
9 8668 1 1
10 9752 1 1

NOTE. The “dump files have the default extension of .dat.

Demultiplexing Transport Streams to PES or Elementary Output Files
It is possible to select a given stream node in navigation view (such as PES
video/audio) or VES audio/video (but NOT gop). The diskette icon will highlight
on top toolbar at the left when the function is available. Select the icon, name the
dump file and select it’s type if required. ES Analyzer will then create a PES
or elementary stream.

This stream can be loaded back into the ES Analyzer to be checked, and then it
can be used as input to Tektronix Multiplexer application to create a transport
stream with SI/PSI to your specifications.
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Working with Transport and PES Streams

Using Packet View
ES Analyzer displays transport packets in a specific way that is useful for
analyzing the Transport stream and also for quickly accessing a packet at random.

The packet view window can be displayed by clicking the Show/Hide Packet
View icon on the toolbar. A window appears that shows a spectrum of the packets
in the order in which they appear in the transport stream. Each PID is assigned
a color and each packet is represented using a single line of the corresponding
color. By double-clicking the spectral line for any packet, you are positioned to
the corresponding packet in the main window of ES Analyzer.

Packet View communicates with ES Analyzer’s main window through OLE. You
can selectively turn on/off the display of spectral lines for any PID in the Packet
View by clicking the corresponding color index in the Packet View dialog. The
color index is also a toggle for display. You can also view distance graph between
packets of the same PID by just viewing spectral lines of the corresponding PID.
To switch back to displaying all PIDs, double-click the All index (represented by
white color).

NOTE. When you first open Packet View, it displays just the front page of the
stream, so that not all of the PID numbers present in the stream are displayed in
the button boxes below the main display. If you want to see them all, drag the
horizontal scroll bar pointer to the far right; all of the PID number buttons will
then be displayed (this could take a few seconds for large stream files).

Packet view does not operate when a program node is highlighted; it works in all
other nodes in navigation view.
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Understanding PES
A Packetized Elementary Stream (PES) as the name suggests is composed of
contiguous packets of an elementary stream with packet headers, as shown
in the following illustration, prepended to the packet. A PES occurs only in
MPEG-2 streams and its structure has been adapted from the packet structure of
the MPEG-1 System stream.

For more information on PES streams, refer to the ISO/IEC 13818-1 document.

An embedded stream is checked when you navigate through one. For more
information, refer to Navigating through Streams. (See page 4-9, Navigating
through Streams.)

For PES streams, you can:

Run through the stream. (See page 4-9, Navigating through Streams.)

View packet headers with their decoded fields.

View an embedded elementary stream.

View PES extension (if received).

Explaining the Status Bar
Display

The status bar, for PES streams, displays the following:

Packet number, which is the number of the current packet in the PES stream.

Byte offset in the file, which is the first byte of the Pack header being currently
viewed in both the hexadecimal and decimal formats.
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Working with Video Streams
ES Analyzer performs detailed checks on MPEG Video streams. Video streams
are complex with an embedded hierarchy. Structurally, a Video stream consists
of a video sequence that has a start code, end code, sequence header, and any
number of group of pictures (GOP). Each GOP consists of a GOP header and a
group of pictures. Pictures may be of different types (I, B, or P). Pictures can
also be frame pictures that correspond to progressive video or field pictures that
correspond to interlaced video. Pictures are broken down into a slice structure
and each slice consists of macroblocks.

For more details, you may want to refer to the documents ISO/IEC 11171-2 and
ISO/IEC 13818-2 that describe the MPEG-1 and MPEG-2 video standards.

Using ES Analyzer, you can:

View the sequence header along with the extensions.

Navigate through a stream. (See page 4-9, Navigating through Streams.)

Run through a stream with the option of analyzing the stream at the picture
level or at the macroblock level.

When analyzing a group of picture, you can:

Randomly access any picture within the group.

View the picture type spectrum and picture size plots.

Zoom into any picture and see its details at the slice or macroblock levels, or
view the encoded picture. You may also use the video or picture player to play
the entire video and pause at any picture when you notice a degradation in
quality; you can then review the details of this picture down to the macroblock
level. ES Analyzer provides an easy mechanism to switch between the Picture
display and the data analysis display windows.

Select any macroblock and examine its detailed coding.

Perform picture quality analysis with special displays of quantizer scale
distribution, slice size distribution, macroblock-size spectrum and motion
vector plots.

Interpret any video descriptors received in the higher level streams and
validate them against the stream.

When analysis with the DCT option is enabled, you can:

View 8x8 coefficients for all macroblocks within a picture.

View coefficient tables for y, cr, cb, luma and chroma pixel data.
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Viewing the Sequence Header
The sequence header is interpreted and displayed as shown below.

NOTE. Placing the cursor over either Load Intro Quantizer Matrix or Load
Non-Intra Quantiser Matrix, displays the applicable quantizer matrix. The check
mark icon indicates that the matrix was received in this sequence header.

For MPEG-2 streams, an optional sequence extension and user data may also be
received. User data is displayed as a hex dump. If data is in the ASCII format, the
ASCII equivalent is displayed next to the hex dump.

The picture rate, chroma format, and the video type (NTSC/PAL/Unspecified,
etc.) appear in the status bar when the sequence headers are displayed.

The information whether the stream is an MPEG-1 or an MPEG-2 stream is
displayed in the tree view window as a single numeral (1 or 2) on the node icons.

Within a sequence, you can view the GOPs by clicking on the GOP icon in the left
side hierarchy view of the stream. The GOP node appears below the sequence
header node.
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Viewing the GOP and Picture Header
When displaying a GOP, ES Analyzer shows you a window with three tabs, as
shown below.

Briefly, the contents of each tab are explained below. For details, see the specific
sections: Displaying the GOP Header, Displaying the Slice and Macroblock, and
Using the Video Viewer for Picture Analysis.

The GOP tab displays the following:

GOP header data.

A slider for the pictures in the GOP. The slider can be used to randomly access
any picture within the GOP; the slider moves in steps of two to facilitate
working with large GOPs. The slider lists the pictures in the received
(decoding) order.

GOP position transport controls lie to the left of the slider bar

Using these controls, any picture can be selected within the GOP. The controls
include Start and End GOP controls and Next and Previous I frame jump controls.
Note that the I frame controls only works in streams where multiple I frames are
present between GOP sequence headers.

Picture header display for the picture selected in the slider.

Picture extensions (applicable only to MPEG-2).

The Slice and MB tab:

Takes you inside a specific picture and provides detailed information down to
the macroblock level.

Allows you to generate picture quality plots.

Allows you to view a picture frame by frame and view macroblock level data
for a selected macroblock in the picture.

The Picture Player tab allows you to play and view the video output on your
screen.

NOTE. ES Analyzer synchronizes the picture being currently displayed by the
video viewer with the picture/data that is displayed on the other tabs: GOP
And Picture and Slice And MB. For example, if you select a macroblock and
switch from the picture display to the other picture-quality analysis tabs, the same
macroblock remains selected for easy identification.
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As an aid to locating a stream, you can click on any open GOP icon in the tree
view to switch picture displays in the stream multiplex.

Displaying the GOP Header The GOP header is an optional header and it is displayed, as shown below, when
received.

The lower part of the display also shows the picture extensions that have been
received.

Video Analysis Settings. Analysis of GOPs can be carried out at picture level or
macroblock level

This will affect the speed at which the ‘next GOP’ is analyzed. The setting is
selected from the Video Analysis Settings dialog.
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Select Menu Bar > Settings > Video Analysis. The following dialog is displayed:

Picture level analysis provides faster analysis but error reporting at the macroblock
level is suspended. Macroblock level analysis provides error reporting but at the
cost of analysis speed.

Status Bar (in GOP mode). When ES Analyzer displays the GOP and picture
headers, the status bar, as shown below, displays the:

Picture rate

Chroma format

Video Type (NTSC/PAL/Unspecified etc.)

GOP number of the current GOP

Picture number of the currently selected picture, relative to the current GOP
(the first picture is given the offset 0.)

Picture display number, which gives the picture number in display order,
relative to the first GOP received. This represents the actual picture Display
number. It is calculated by adding the temporal reference of the current
picture to the cumulative picture display number prior to the GOP.

Displaying the Picture
Header

The GOP header tab has a slider for selecting the picture whose details you want
to display. The header for the selected picture is displayed below the GOP header
in the same dialog box as shown in the earlier illustration.
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Displaying the Picture
Extension

For MPEG-2, several picture extensions may be received. The picture coding
extension is always displayed, while the other picture extensions are displayed
on tabbed folders, as shown below. The tabs for each of these extensions are
enabled and the text on the tab appears in red, only if the corresponding extension
is received in the stream.

All tabs with red text represent extensions that have been received for the current
picture. The next section describes each extension and its interpretation.

Explaining the Picture Extensions.

QME (Quantizer Matrix
Extension)

This allows the quantizer matrices to be downloaded for any
picture.
At most four matrices can be downloaded, namely,
intra-quantizer matrix; non-intra-quantizer matrix, chroma
intra-quantizer matrix, and chroma non-intra-quantizer matrix.
The QME tab displays through a check mark the matrices that
were downloaded. A downloaded matrix is displayed when you
move the mouse over the name of the specific matrix.

CE (Copyright Extension) This indicates any copyrights on the video. The copyright field
is interpreted and displayed.

PDE (Picture Display
Extension)

This extension gives display extensions for MPEG-2 video.

PSSE (Picture Spatial
Scaleable Extension)

This is received when the spatial scalability of MPEG-2 video is
used in the video stream.

PTSE (Picture Temporal
Scaleable Extension)

This extension is received when the temporal scalability of
MPEG-2 video is used in the video stream.
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UD (User Data) This displays any user data associated with the picture in
hexadecimal format. If the data represents ASCII text, the ASCII
text is also interpreted and displayed.

CPE (Camera Picture
Extension)

NOTE. These tabs will only operate if the appropriate extensions are present
within the stream under test.

All four matrices will only display if they are downloaded with certain stream
types for example, HDTV streams. - indicates that only the default matrix
will be displayed.

Displaying the Slice and Macroblock
ES Analyzer allows you to take a microscopic view of a picture by letting you
view the picture’s slice and macroblock structure.

To View Slice Details of
Any Picture:

1. Select the picture by using the picture slider on the GOP And Picture tab.

2. Click the Slice and MB tab.
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The macroblocks for the selected picture are displayed as shown below:

The Slice dialog box graphically displays the slices and macroblocks in the
picture and also displays the:

Slice header for the selected slice.

Macroblock details for the selected macroblock.

Picture Quality data, which overlaps the slice display area.

Decoded field/frame for the selected picture.

Explaining the Slice and
Macroblock Display

When displaying the slices, the current picture is represented by its constituent
slices; see the above illustration. You can move the mouse to any slice and select
it using the left mouse-button. The slice header display shows the header for the
currently selected slice. MPEG-1 slices can span multiple rows and the display
shows the same.

Slice display is color coded. Intra-slices are shown in green color, while slices
that do not have this flag set are displayed in gray color.

Within a slice, the macroblocks are also shown. You can select a macroblock in
the slice using the left mouse-button. The header and information of the currently
selected macroblock is displayed below the macroblock display. Skipped
macroblocks in a slice are shown using a different color and cannot be selected.
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When viewing the slice display, you can move forward to the next picture or
backward to the previous picture. You do this by clicking the picture navigation
buttons on the top right corner of the dialog box. You can also return to the
GOP display and select a specific picture. When moving backwards, you cannot
cross the GOP boundary; however, when moving forward, you can cross a GOP
boundary.

When displaying macroblocks, the status bar looks like this:

Viewing Coded Block
Patterns for a Macroblock

While in the slice and macroblock level display, you can view the coded block
pattern for any macroblock (except for the skipped macroblocks). This is
displayed in the last field (CBP) as shown below.

Depending on the chroma format, the coded block pattern is displayed as a
sequence of 6, 8, or 12 bits. From left to right, the bit pattern represents the blocks
in the macroblock as they are numbered in the standard MPEG specifications. For
more details, see the ISO/IEC 11172-3 and ISO/IEC 11318-3 documents.
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Analyzing Picture Quality
Viewing the Macroblock

Size Spectrum
The Macroblock Size Display provides a color-mapped two-dimensional graphical
plot of the macroblock size and type distribution in a picture; it is plotted as an
overlay on the slice display area. This plot can be viewed by clicking on the MB
Size Display button in the Slice and MB tab. The types of all macroblocks in
the picture are color-mapped; a key is shown at the right side of the display and
described below (see Macroblock Colors). Skipped macroblocks are displayed in
dark green. The macroblock size for the selected macroblock is displayed in the
macroblock field display area below it.

Macroblock Colors. The color-coded macroblock type represents the prediction
type employed

Field Based Predictions are made independently for each field by using data
from one or more previously decoded fields.

Frame Based Predictions are made for the frame using the data from one or
more previously decoded frames.
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16 x 8 MC (16 x 8 motion compensation) In which two motion vectors are
used for each macroblock. The first motion vector is used for the
upper 16x8 region, the second for the lower 16x8 region. In the
case of a bi-directionally predicted macroblock a total of four
motion vectors will be used since there will be two for forward
prediction and two for the backward prediction. 16x8 MC is only
used with field pictures.

Dual Prima Only one motion vector is encoded (in its full format) in the bit
stream together with a small differential motion vector. In the
case of field pictures, two motion vectors are then derived from
this information. These are used to form prediction from two
reference fields (one top, one bottom) which are averaged to
form the final prediction. In the case of frame pictures, this
process is repeated for the two fields so that a total of four field
predictions are made. This mode is only used in P-pictures
where there are no B-pictures between the predicted and
reference fields or frames.

NA Not Applicable - Refers to the instances where there is no
prediction in the macroblock.

(For more detailed information, refer to ISO/IEC 13818-2 : 1996, Information
Technology - Generic coding of moving pictures and associated audio information,
Part 2 Video).

Viewing the Quantizer
Scale Distribution

Quantizer scale distribution for the macroblocks in a picture is plotted where
the picture slice is displayed. This gives you a graphical view of the scale code
distribution and lets you visually check any obvious scale code problems. This
plot can be viewed by clicking on the Q-Scale Code Display button in the Slices
dialog box. The scale codes of 1 through 31 are mapped to shades of green with
1 being mapped to the lightest shade and 31 to the darkest (black). Skipped
macroblocks use the same scheme but are mapped in shades of gray. The value of
the scale code for the selected macroblock is displayed in the macroblock field
display area below it.

Viewing the Motion Vector
Plots

ES Analyzer gives a detailed graphical display of motion vector for the selected
B or P picture. Both MPEG-1 and MPEG-2 type vectors are interpreted and
displayed.

To view motion vectors (applicable to only B or P pictures).

1. Position the cursor to the picture for which you want to see the slice size plot.

2. Move into the slice display.

3. Click the Motion Vector Display button in the slice display dialog box.
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For each macroblock, the motion vectors corresponding to it are plotted to scale
as a directed arrow. The direction of the arrow represents motion coding for the
macroblock from the reference frame to the current frame. Different types of
vectors are plotted in different colors. You can also selectively choose to display
different motion vectors by using the buttons on the right.

FF Forward Frame BF Backward Frame
FTF Forward Top Field BTF Backward Top Field
FBF Forward Bottom

Field
BBF Backward Bottom

Field
DTF DMV Top Field DBF DMV Bottom Field

If a button is grayed out, the associated vector is not currently available.

The motion vectors are plotted for the luminance blocks. They are to scale (in the
resolution of full pel or half pel) according to the pel resolution fields received.
For each macroblock, multiple vectors may be received. All or some of them may
be displayed simultaneously.

When Tooltips are enabled, a summary of parameters is displayed in a popup
window.

For MPEG-1 that has only frame pictures, two kinds of motion vectors are
applicable -forward frame (for P and B pictures) and backward frame (for B
pictures).
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For MPEG-2 video, additional vectors may also be coded, which are: forward
frame (for P and B pictures), backward frame (for B pictures), forward top field,
backward top field, forward bottom field, backward bottom field, dual prime top
field, dual prime bottom field.

ES Analyzer interprets all the above vectors and lets you view them graphically.
When motion vectors cross the picture boundary, an error condition occurs and
the same is reported in the error log window. In this case, the vector is drawn
until the edge of the picture display.

Reviewing the Decoded
Picture

ES Analyzer decodes and displays the selected picture when you click the Picture
Display button. You can view I, B, or P frames or fields (only for MPEG-2).

ES Analyzer also allows you to view the previous and the next decoded picture
(whether frame or field) by clicking the appropriate buttons. The actual size of the
picture is displayed and if the picture is larger than the picture display area, scroll
bars will appear. For the picture being viewed, you can select a macroblock by
clicking the left mouse button anywhere in the picture display area. When you do
so, the slice and macroblock area below the picture displays the slice and MB data
for the currently selected macroblock.
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If Tooltips are selected, a summary of the macroblock information is displayed in a
popup box. When you switch from the picture display to the other picture-quality
analysis tabs (e.g., MB Size Display, Q-Scale Code Display or Slice Display), the
same macroblock remains selected for easy identification.

You can also enable a macroblock grid on the displayed picture by using the Show
Grid button to easily identify and select macroblocks.

The picture display has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

Main Profile @ High Level (MP@HL)

Main Profile @ Main Level (MP@ML)

4:2:2 Profile @ Main Level (4:2:2P@ML)

Viewing the Decoded Picture with Motion Vector Plots. The decoded picture can be
further enhanced with an overlay of motion vector plots.

The interpretation of the display corresponds with the description in the previous
section - Viewing the Motion Vector Plots.

To view the vector plots for the currently displayed picture:

Select the Show MV button on the right side of the picture.

The vectors displayed will depend upon the selections made from the
remaining buttons on the right side of the screen.
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The picture display has the following limitations:

When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those
that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

For MPEG2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

NOTE. Make sure that your monitor’s Display Properties is set to either 24 or
32-bit true color; otherwise, you may find a distortion in the colors in the picture
being displayed.

Displaying DCT Coefficients. The Discrete Cosine Transformation matrix of each
block in a selected macroblock can be seen by selecting Settings > DCT Display
from the Menu Bar
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The DCT Display option is available only when viewing the details of GOP in
Video Stream Analysis. Enabling the DCT Display option will enable Show
DCT button next to the displayed picture in Slice & Macroblock Tab, Picture
View Mode.

The Show DCT button is used to toggle the DCT Coefficients display. To view
the DCT values of the a macroblock, select the macroblock; a window containing
details of coded and decoded DCT values will be displayed.

Note that the luma (y) control has four selections (0, 1, 2 and 3) which correspond
to an 8x8 pixel corner of the 16x16 pixel selected macroblock. Chroma
sub-sampling (Cb and Cr) will display matrices for the color differences between
frames.
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The picture display has the following limitations:

When navigating to a specific GOP using the toolbar icon, the picture display
may be unable to display some B pictures correctly. These pictures are those
that use a frame from the previous GOP for reference. This happens only
when you navigate to a GOP that is not a closed GOP.

For MPEG2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

For MPEG2 streams, ES Analyzer currently displays and decodes only
decodes MP@HL, MP@ML, and 4:2:2 video streams.

DCT Value Display - Version Changes. The diagram also indicates the changes that
occurred between ES Analyzer, Version 1.5 (MPEG Test System, Versions 6.4
and 6.4.2) and ES Analyzer, Version 1.6 (MPEG Test System, Version 6.5). The
"windows" referred to are those in the DCT Values window.
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Configuring Video
Analysis Settings

The video analysis or picture analysis default settings can be set as required.

NOTE. The selected Video Analysis settings will not affect analysis on either the
Slice and Macroblock or the Picture Player pages. On the Slice and Macroblock
page, analysis is always at the macroblock level. On the Picture Player page,
analysis is always at the picture level.

Video Analysis Settings. Select Settings > Video Analysis… from the Menu Bar.
The following dialog box is displayed:

Select Picture level analysis to view frames quickly.

Select Macroblock level analysis if pictures/frames are to be analyzed at the
macroblock level.

When Macroblock level analysis is enabled, select the shading scheme required.

Picture Display Settings. A number of display and vector parameters are set from
the Picture Display Settings dialog

Select Settings > Picture Display… from the Menu Bar. The following dialog
is displayed:
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Display Order of Pictures Select Presentation Order or Decoding order
Motion Vector Overlay
Colour Section

White: All vectors will be displayed in white.
Black: All vectors will be displayed in black.
Vector Dependent: Colors will correspond to the vector selection
button colors.
Background Dependent: Colors are combined with picture
background to provide a contrast.

Viewing the Slice Size
Distribution

For any picture, you can also view the slice size distribution.

To view the plot.

1. Position the cursor to the picture for which you want to see the slice size plot
on the GOP And Picture tab.

2. Move into the slices display by clicking the Slice and MB tab.

3. Click the Show Slice Size Statistics icon on the toolbar.

NOTE. The Show Slice Size Statistics icon is grayed out on all tabs except
the Slice and MB tab.

The plot appears in another window.

Viewing the Frame Size
Spectrum

You can view the picture spectrum for a GOP and the frame size plots.

To view the plot.

1. Display the GOP for which you want to see the Frame Size Spectrum plot.

2. Click the Show Frame Size Statistics icon on the toolbar.
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The following plot is displayed. Each bar represents the frame size in kilobytes:

Selecting the Show Data Distribution button will further enhance the plot by
showing the content of each frame.

Content is color-coded as shown by the key in the bottom left corner. Details of
the content of each frame are displayed when the cursor is moved over a frame.
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Using the Video Viewer for Picture Analysis
The video viewer (or Picture Player) allows you to play a video stream and
display the decoded picture on the screen. The picture player playback speed may
vary from real time according to the ES Analyzer processor speed. You may
also notice certain pauses in the display at regular intervals. These pauses occur
at GOP boundaries. The Remote Control (described below) allows you to pause
and resume the display at any frame. You can also restart the display from the
beginning of the current GOP, or from the start of the video sequence.

The number of the current picture and the number of the last decoded picture are
displayed, as shown in the following illustration. Here is a typical sequence of
steps in which you may use the video viewer:

1. Open the video stream you want to analyze.

2. Start the video viewer.

3. Monitor the displayed picture for quality problems.

4. Pause the player whenever you notice a problem in a picture, such as a
degradation in quality. The player is intentionally made to play at a speed
slower than the regular play speed to allow you to stop at specific frames.
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5. Switch to the analysis tabs to view details of the currently displayed picture
down to the macroblock level.

6. Step forward or backward in decode order in the Slice And MB tab, or switch
back to the video viewer and resume play.

ES Analyzer synchronizes the picture being currently displayed by the video
viewer with the picture/data that is displayed on the other tabs: GOP And Picture
and Slice And MB. This means that:

The GOP And Picture and Slice And MB tabs always display data for the
same picture.

When you switch from the video viewer to either the GOP And Picture or the
Slice And MB tab, you are presented the data for the picture being displayed
on the Picture Player tab.

When you switch from the GOP And Picture or the Slice And MB tab to the
Picture Player tab, the video viewer presents the picture for the data being
displayed on the GOP And Picture or the Slice And MB tab.

If you select a macroblock and switch to the picture-quality analysis tabs
(such as MB Size Display, Q-Scale Code Display or Slice Display), you will
find that the same macroblock remains selected for easy identification.

The video viewer, however, has the following limitations:

When you navigate to a specific GOP using the toolbar icon, the picture
display may be unable to display some B pictures correctly. These pictures
are those that use a frame from the previous GOP for reference. This happens
only when you navigate to a GOP that is not a closed GOP.

For MPEG-2 scaleable streams, you will be able to display pictures only
from the base layer. Other extension layer data cannot be displayed using
ES Analyzer.

ES Analyzer currently displays and decodes video streams within the
following MPEG-2 profiles:

Main Profile @ High Level (MP@HL)

Main Profile @ Main Level (MP@ML)

4:2:2 Profile @ Main Level (4:2:2P@ML)

Picture Player Remote
Control

The Remote Control is displayed whenever the Picture Player tab is selected.
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Play Video Plays the video stream from where it last stopped.

Stop Stops the video stream and allows the other analysis tabs to
be selected.

Next Picture Steps forward one frame.

Play from GOP Start Plays the pictures from the start of the current GOP.

Zoom/Restore Display Enlarges and restores the area in which the picture appears.

Fit Best in Display
Area/Display Picture at
True Size

Fits picture in display area or displays picture at original size.

Left/Right Scroll Scrolls the displayed picture left and right.

Up/Down Scroll Scrolls the displayed picture up and down.

Show/Hide information

Shows or hides the information panel for the displayed picture.
The following information is displayed:
GOP Number - in which the frame is present. Coded Number
- refers to the picture number within the GOP. Display Time -
in hh:mm:ss:cc; where cc is the display number in the whole
file. Display Number - refers to the display number of a picture
within the GOP.
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Working with Audio Streams
ES Analyzer analyzes both MPEG (-1 and -2) Audio streams and Dolby Digital
(AC-3) Audio streams.

Understanding MPEG Audio Streams
An MPEG audio stream consists of a sequence of audio frames. Audio data
may be received for multiple channels. Each channel is divided into sub-bands
for which data is transmitted.

ES Analyzer verifies audio streams according to the MPEG audio
recommendations. Support for both MPEG Layer I and Layer II audio is available.
MPEG-2 extensions for Layer I and II (surround and center channels, and low
frequency channels) are also interpreted and analyzed. Multi-lingual extensions in
MPEG-2 are currently not analyzed. ES Analyzer is also unable to analyze the
MPEG-2 Audio stream if the extension bit stream is present.

For a detailed discussion on the MPEG audio syntax, refer to ISO 11172-3 and
ISO 13818-3.

With ES Analyzer, you can:

Navigate to any audio frame; see details in the Navigating through Streams
section in the Getting Started chapter.

View frame details, including frame header, and plots of the frame data, as
shown in the following illustration.

Interpret and display audio descriptors received in higher level streams and
validate them against the stream.

Play an audio stream.

For each audio frame, data may be received for at most two channels, as shown
in the next illustration; additional channels may also be received in the MPEG-2
extension.
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Audio Player
The Audio Player is available on MPEG-1, MPEG-2 and Dolby AC-3 streams
(and AAC as an option). With a suitable sound card installed in the host PC,
audio streams can be played.

NOTE. The speed and quality of playout, isnot high fidelity, but is sufficient to
allow an audio stream to be monitored for analysis.

WARNING. While an audio stream is playing, you cannot access any other
analyzer functions. In particular, do not close the Audio Player while an audio
stream is playing (especially in loop mode), because you will be unable to reopen
the player (and control the stream) until it has finished playing.

If more than one audio device is installed, a selection can be made from the
Device drop-down list.

The channels to be played can be selected from the Play Channels drop-down list.

To open the Audio Player, select the player start button, which is available
on the audio stream header pages.

The Audio Player control panel is displayed:

The player controls follow the same convention as the Video Player controls:

Icon Description
Play

Stop

Fast forward

Fast rewind

(To use Fast Forward and Fast Rewind, press the required button and then stop the
action with the Stop button.)
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The Audio Player display shows the following:

Play time

Stream Name and Audio PID number

Player status (Stop/Play)

The following controls are available in addition to those described in the
preceding list.

Toggles continuous (or looped) playout.

Toggles a real-time waveform display.

NOTE. Currently two channels are output to the sound card. These can be
assigned as required (as mono or stereo) from any of up to five channels in a
stream.
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Explaining MPEG-1 Audio
Streams

ES Analyzer displays data for each channel separately.

For the selected audio frame, ES Analyzer displays the following:

The frame header.

A plot of bits per code word against the sub-bands for each channel.

SCFSI (Scale Factor Selection Information) plotted against sub-band for each
channel.

Grouping information plotted against sub-bands for each channel.

The scale factor plotted against the sub-band.

Channel selection and playout controls.
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Explaining MPEG-2 Audio
Streams

For MPEG-2 Audio streams, ES Analyzer analyzes the following channels if the
data is present: Left, Right, Left Surround, Right Surround, Center and LFE.
Currently, ES Analyzer analyzes 5.1 Audio streams. When ES Analyzer detects
an MPEG-2 Audio stream, the information displayed is similar to what is shown
in the following illustration.

ES Analyzer displays information on the following tabs: MPEG-1 Header,
MC Header (Multi-channel header), and MC Composite Status (Multi-channel
composite status).

MPEG-2 Audio streams are backward compatible with MPEG-1 streams.
Therefore, the MPEG-1 header for each frame is the same as that for an
MPEG-2 Audio stream.
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The MC Header tab displays information about the additional data present for the
multi-channel extensions, over the two stereo channels. It gives you the number
of channels that are present, the presence of the LFE channel, additional CRCs,
and other relevant fields in the MC Header, as shown.

The MC Composite Status tab provides the sub-band information of the channels;
and their relationship with the transmission channels, as shown.

The lower part of the dialog box displays information specific to the channels.
You can select the channel for which you want to see the details by clicking the
appropriate graphic at right. The channel-specific data for the selected channel is
displayed at left as for MPEG-1.
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Explaining the Status Bar
Display

The status bar for Audio streams displays the following:

Frame number, which is the number of the current frame in the stream.

Layer number, which is the number of the audio stream.

Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.

Understanding Dolby Digital (AC-3) Audio Streams
ES Analyzer also analyzes Dolby Digital’s audio streams, which could be an
independent, stand-alone audio stream, or a multiplexed stream that is embedded
inside an MPEG-2 System stream (ATSC transport or program stream). The
Dolby Digital stream is analyzed by ES Analyzer for syntactic compliance with
Dolby Digital specifications.

For a detailed discussion on the Dolby Digital audio syntax, refer to the document
A/52 from Advance Television Systems Committee (ATSC).

ES Analyzer analyzes Dolby Digital stream frame by frame and also performs
CRC checks for each audio frame. When analyzing a Dolby Digital stream, you
may navigate to any frame and also view data specific to an audio block within it.

Automatically detecting the data format used in the Dolby Digital stream, ES
Analyzer analyzes both the little endian and the big endian formats. For ease of
debugging, ES Analyzer displays information for all the fields of any block for
any audio frame.

When errors are encountered in a stream, ES Analyzer reports the errors and
synchronizes to the next audio frame to continue the analysis.
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ES Analyzer displays the header and audio block information on specific tabs, as
shown. The Header And BSI tab displays the Dolby Digital synchronization and
bit stream information.

The audio controls are only available on the Header and BSI tab.
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Depending on the selection, the Audio Block tab displays information for the
corresponding audio block within the frame.

The lower part of the previous illustration displays the channel-specific
information for the selected audio block, as shown in the following illustration.
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The Coupling information tab distinguishes between the stand-alone and coupled
data for the selected channel. The green band denotes the stand-alone information,
and the blue region denotes the coupled information. The blue region may be
further divided into bands; these appear as solid lines as opposed to the dotted
lines that denote sub-bands.

Explaining the Status Bar
Display

The status bar for Dolby Digital Audio streams displays the following:

Frame number, which is the number of the current frame in the stream.

Bit rate of the Dolby Digital audio stream.

Sampling rate.

Frame size information.

Byte offset in the file, which is the first byte of the Frame header being
currently viewed in both the hexadecimal and decimal formats.
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Working with Program Streams
Program streams are quite similar to MPEG1 System streams in structure. A
Program stream consists of a sequence of packs. Each pack has a header, an
optional system header, and any number of packets. If a system header is not
received in a pack, then the last received header is applicable for the pack. The
system header is sent periodically in the stream to facilitate random access. Each
pack contains any number of packets. Each packet belongs to a particular stream
and has a PID associated with it. If packets of a given PID are concatenated,
you get the embedded PES stream with this PID. The PES stream in turn has
an elementary stream embedded in it.

For more details on Program streams, refer to the ISO/IEC 13818-1 document.

ES Analyzer performs conformance and semantic checks at the program stream
packet level as per the ISO/IEC 13818-1 recommendations. An embedded stream
is checked when you navigate through one; for details, see the Navigating through
Streams section in the Getting Started chapter.

For Program streams, you can:

View pack and system headers, as shown in the previous illustration.

View the program stream map; see the Viewing Program Map section for
details.

View an embedded stream at the PES or the elementary stream level; see the
Understanding Packetized Elementary Streams section for details.
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Perform buffer analysis of the embedded audio/video stream using the STD
model; see the Analyzing Streams chapter for details.

Perform PCR/PTS frequency analysis model; see the Analyzing Streams
chapter for details.

Viewing Pack and System Headers
When navigating through a stream, the current pack is displayed in the header
display area, as shown in the preceding illustration. The pack and system header
fields are displayed for the current packet of the Program stream. The currently
applicable system header is displayed for the packet. The receipt of a system
header in the current pack is indicated by a check mark in the system header group
box. A cross mark indicates that the system header was received earlier.

The list of streams declared in the header is displayed in the elementary stream
list box. It is possible that the stream may contain some PES streams that are not
declared in the System Header. Such streams are added in the tree view when
a packet of the same is encountered.

Viewing the Program Stream Map
The program stream map can be viewed by clicking the stream map icon

(PSMAP) in the tree view window. This pops up the stream map showing the
descriptors for the Program stream and the contained elementary streams. The
descriptors associated with each elementary stream in a program can be viewed in
one of two ways:

By double-clicking the corresponding icon for the stream in the display

By clicking the more details icon shown for the corresponding stream in
the elementary stream listbox
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The form is extended (if not already extended) to add the descriptors display, as
shown in the following illustrations. All descriptors that are received for the
corresponding stream are displayed on tabbed folders. If a descriptor is not
received, its tab will not appear in the descriptor display. The illustrations below
show descriptors for the respective video and audio tabs.

Explaining the Status Bar
Display

The status bar for Program streams displays the following:

Pack number, which is the number of the displayed packet.

Packet number, which is the number of the current packet in the entire stream.

Packet number of SID, which is the number of the current packet taking into
account only packets of the same stream ID (SID).

At GOP level, the location of GOP header/start at PES level and Pack level is
displayed by PES packet number & Pack number respectively.
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At AES & AC3 level, the location of frame header/start at PES level and Pack
level is displayed by PES packet number and Pack number respectively.

Byte offset in the file, which is the first byte of the Pack header being currently
viewed in both the hexadecimal and decimal formats.
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Working with Teletext
Teletext can be incorporated into DVB streams. ES Analyzer allows the associated
data to be analyzed and viewed.

To view the teletext data, navigate to the teletext icon in the Tree View
window.

Initially, the Page Header data will be displayed:
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Using the Next button, details of the page can be viewed in the Data Packet tab.

Other tab pages (Color Map Table, Decoded Display, Decoding Parameters)
provide detailed teletext encoding data. These tabs will only appear as progress is
made through the stream using the Next button and the analyzer detects them.

VBI (Enhanced Teletext Support)
Enhanced teletext support is available (reference: ETSI EN 301-775). The
supported extensions include the following:

VPS (Video Program System)

WSS (Wide Screen Signaling)

Monochrome Data

Note that the associated information screens will only be available for display
where data of the specific type is available in the stream.

Examples of the screens are shown in the following illustrations.
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VPS (Video Program
System)

WSS (Wide Screen
Signaling)
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Monochrome Data
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Advanced Audio Compression
Elementary Stream Analyzer (ES Analyzer) performs off-line stored stream
analysis for MPEG1 Audio, MPEG2 Audio, and Dolby Digital Audio streams, as
well as MPEG1 and MPEG2 video streams. The streams can embedded inside
DVB, ATSC or MPEG1 System streams.

Advanced Audio Compression (AAC) is one of the audio compression
formats defined by the MPEG-2 standard. AAC used to be called NBC
(Non-Backward-Compatible), because it is not compatible with the MPEG-1
audio formats. AAC offers a better compression ratio than MP3 (MPEG-1 Layer
3) and is the state-of-the-art in audio compression technology. It can include up
to 48 audio channels, 15 low frequency enhancement channels, 15 embedded
data streams and has multi-language capability. MPEG formal listening tests
have demonstrated that it can provide slightly better audio quality at 96 kb/s than
layer-3 at 128 kb/s or layer-2 at 192 kb/s.

Due to its high coding efficiency, AAC is a prime candidate for any digital
broadcasting system. The Japanese authorities were the first to decide to use
AAC within practically all-digital audio broadcasting schemes. Because their
first services will start in the year 2000, this decision has already triggered the
development of dedicated AAC decoder chips at a number of manufacturers. Due
to its superior performance, AAC will also play a major role for the delivery of
high-quality music via the Internet. Furthermore, AAC (with some modifications)
is the only high-quality audio-coding scheme used within the MPEG-4 standard.

The AAC bit stream is encoded in either of two formats:

Audio Data Interchange Format (ADIF)

Audio Data Transport Stream Frame (ADTS)

4–70 MTS400 Series Analyzer Applications User Manual



Advanced Audio Compression

The corresponding forms are displayed according to the format of the input bit
stream These forms display the information contained in the fields of the Header
and the Raw Data.
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ADIF Stream Forms
The analyzed information regarding the input ADIF stream is displayed by means
of a property sheet containing three tabs.

The ‘ADIF Header’ tab of the following figure displays the fields of the header.

Figure 4-2: ADIF header Information
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The ‘Raw Data’ tab of the following figure displays the fields in each raw data
block. A slider control helps to navigate through the various raw data blocks. The
information regarding each raw data block is displayed by means of another child
property sheet containing seven tabs (for more information the fields in each tab
(See Figure 4-4.) to (See Figure 4-10.)

Figure 4-3: ADIF raw data Information

Element Color Coding in
the Raw Data Tab

The Element Type (below the slider bar) is color-coded; the key is given on the
right side of the display in the Element Types box. The number displayed in the
Element Type color spot indicates the EIT (element instance tag) of that syntactic
element.

Color Coding of Raw Data
Tabs

The text in the Raw Data tabs is color-coded as follows:

Light Blue Indicates the syntactic element is present and activated in the
raw data.

Dark Blue Indicates that the syntactic element is present, but currently
inactive in the raw data.

Dark Gray Indicates that the syntactic element is not present in the raw
data.

MTS400 Series Analyzer Applications User Manual 4–73



Advanced Audio Compression

Figure 4-4: Single channel element Information

Figure 4-5: Coupling pair element information
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Figure 4-6: Coupling channel element information

Figure 4-7: Low frequency element channel information
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Figure 4-8: Data stream element information

Figure 4-9: Program configuration element information
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Figure 4-10: Fill element information

The ‘Channels’ tab of the following figure displays the configuration of the coded
channels. The physical location of the speakers corresponding to the channels
coded in the stream for standard and non-standard configurations can be displayed.

Figure 4-11: ADIF channels (non-standard) information
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The syntactic element type corresponding to each speaker in the Speaker-Channel
Mapping is denoted by a color-code scheme, the legend for which is given in the
Ch.Element Types box. The number appearing in the color spots denotes the EIT
(element instance tag) of that syntactic element.

Figure 4-12: ADIF channels (standard) information
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ADTS Stream Forms
The analyzed information regarding the input ADTS stream is displayed by means
of a property sheet containing three tabs.

The ‘ADTS Header’ tab of the following figure displays the fields of the header,
while the ‘Raw Data’ tab displays the fields in each raw data block and the
‘Channels’ tab displays the configuration of the coded channels. The content of
the ‘Raw Data’ and ‘Channels’ tabs are identical to that in the ADIF stream.

Figure 4-13: ADTS header information
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Closed Caption Analysis
Closed captions are captions that are hidden in the video signal, invisible without
a special decoder. The place they are hidden is called line 21 of the vertical
blanking interval (VBI).

ES Analyzer allows closed caption data to be analyzed and inspected.

The two options are:

CCA Standalone (Player + CC-EIA608 + CC-EI708 analysis)

Full Elementary Stream Analyzer + CC-EIA608 + CC-EI708 analysis

NOTE. No special installation process is required. The options are dongle
protected/enabled.

The Stand-Alone option has full Closed Caption functionality, but other ES
Analyzer functions are disabled.

XDS analysis is currently disabled. Extended Data Services is a supplementary
data stream existing in Line 21, Field 2. It is used to provide additional data
(primarily content advisory information) on the program being aired (Reference:
EIA-744).

Enabling Closed Caption Analysis
1. Open a stream containing Closed Captions.

2. Expand the navigation tree and open either a VES or a GOP node.

3. Enable Closed Caption Analysis in the Settings menu. A check mark next to
the option indicates that Closed Caption Analysis is enabled.

NOTE. By default, Closed Caption Analysis is enabled. It is recommended that
it be only enabled when required; disabling it will improve the speed of picture
analysis processing.

However, disabling and enabling the Closed Caption Analysis feature should only
be done when a stream is first opened, not during analysis. Opening the feature
during analysis may result in improper analysis.

When Closed Caption Analysis is enabled, the Closed Caption Display tab
will be visible in the Slice and MB GOP tab.

4. Ensure that the Picture Display Settings (Settings > Picture Display…) are as
shown in the following screenshot:
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Display Order of Pictures > Presentation Order

Motion Vector Overlay Colour Selection > White

Selecting Closed Caption Analysis Standard
Two primary forms of Closed Caption Analysis are offered: CC-EIA608 and
CC-EIA708. CC-EIA746 support is also supported in the EIA608 mode.

The selection of CC-EIA608 or CC-EIA708 is made from the Closed Caption
Display tab available in the Slice and MB GOP tab.

NOTE. Whichever standard is selected, no closed caption content will be
displayed until the file has been at least partially analyzed. To start analyzing the
stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

CC-EIA608 Support
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The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA608 Closed Caption Analysis is enabled:

At the top of the display, the LED icons indicate that closed caption data has
been received in the Field and Services sections; green indicates that data has
been received.

If data has been received for the current GOP it should be displayed in the Display
Memory tab and on the picture display:

The remaining tabs (Roll Up, Pop On and Paint On) display various parameters
defining the manner in which the captions will be displayed.

CC-EIA746 Support Associated with CC-EIA608 is CC-EIA746 which supports the transmission of
URLs (Uniform Resource Locators) within the closed caption data.

The URLs transmitted in the T2 closed caption service are parsed, decoded and
displayed in the EIA-746 Data view.

The attributes shown apply to the URL selected from the drop-down list.

The selected URL is fetched and displayed on the default Web browser
installed on the system.
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CC-EIA708 Support

The following dialog box is displayed below the picture display (in the Closed
Caption Display tab) when CC-EIA708 Closed Caption Analysis is enabled:

Details of the fields in the Closed Caption Analysis window are as follows:

Caption Service The service whose details are to be displayed can be selected from the drop-down
list.

Packet Info Sequence No. The sequence number of the packet from which the current service
block has been extracted (for example, Service 1, Service 2, etc).

Packet Size The packet size that has been coded in the packet header.

Bytes Left The number of bytes still to be received.

Block Info Block size The size of the service block.

Bytes Left The number of bytes still to be received.

Active Window The Window ID which is currently the active window.
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Window Identity

W# The buttons in red in the W# column indicated the defined windows in the
received service. The parameters to the right of this column depend on the
selection made here.

Window Text The text shown in the current window.

Window Definition
Parameters

By placing the cursor over the more…field all the parameters related to the
window definition can be viewed.
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Window Style Parameters By placing the cursor over the more…field all the parameters related to the
window styles can be viewed.

Pen Style Parameters By placing the cursor over the more…field all the parameters related to the pen
styles can be viewed.
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Dumping Closed Caption Statistics
Closed Caption Analysis statistics can be written to file for each standard (EIA608
and EIA708).

NOTE. Regardless of which standard is selected, no closed caption statistics can
be dumped until the file has been at least partially analyzed. To start analyzing
the stream, select the GOP And Picture tab and press the Go button.

A sign that closed caption content has been detected during analysis is that the
Video icon in the navigation tree changes to include a CC symbol:

The sequence of actions required for a dump of statistics to be successful is as
follows:

1. The Dump CC Statistics option in the Settings menu will only become
available when analysis (or partial analysis) has established that Closed
Caption data is carried in the stream.

2. A standard must be selected from the Dump CC Statistics option sub-menu,
for example, EIA608.

3. A destination file must be specified for the statistics dump.

4. Further analysis must be carried out to provide data for the statistics dump.

The following paragraphs describe the setup required for each standard; however,
the previous steps must be adhered to for the dump to be successful.

EIA608 Closed Caption
Statistics Dump

1. Select the EIA608 option from the Dump CC Statistics sub-menu.

2. Enable Dump Statistics.
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3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (reports that you set up) can be viewed by selecting View Report.

EIA708 Closed Caption
Statistics Dump

1. Select the EIA708 option from the Dump CC Statistics submenu.

2. Enable Dump Statistics.
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3. Identify a destination file in the Statistics File: field.

4. Enable the parameters to be dumped.

5. Select OK.

Existing reports (that is, reports previously set up) can be viewed by selecting
View Report.
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DVB Subtitle Stream Analysis
DVB Subtitling provides a means of conveying region-based bit-mapped graphics
as MPEG-2 packetized elementary streams (PES). The bit-mapped pixel images
are run-length encoded and transmitted with color look-up tables (CLUT) to
a decoder where the stream is decoded and the subtitle image rendered with the
on-screen display.

When a DVB Subtitle node is revealed and highlighted, the screen shown below
is displayed:

NOTE. Some streams may show subtitle nodes from which the Page View
(described below) cannot display any subtitles.

This is not an error, it is because the stream is too short to carry the requisite data.
If possible, record a longer section of the stream and retry the analysis.

MTS400 Series Analyzer Applications User Manual 4–89



DVB Subtitle Stream Analysis

The working area contains two tabs: DVB Subtitle Data and Page View.
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DVB Subtitle Data Tab
The DVB Subtitle Data tab displays the fields associated with the current display.
Access to two areas of detail is provided by pressing the Default CLUT Table…
and the Show Object… buttons.

Object View The Object View displays a decoded bitmap of the selected object rendered on
a blank screen (that is, with no underlying picture). The fields at the top of the
dialog box, provide the user with the options of changing the decoder type (2-bit,
4-bit or 8-bit), the background color, and the CLUT identity. As described in the
standard, the CLUT is attached to the region, not the object; therefore, the user
can see the bitmap using all of the available CLUTs.
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The Object view is displayed by selecting the Show Object… button on the DVB
Subtitle Data tab.
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CLUT View The Object view is displayed by selecting the Default CLUT table…button on the
DVB Subtitle Data tab.

NOTE. Subtitles in the UK are colored in a limited set, (red, cyan, green,
yellow, white), one for each of four speakers/actors and white for additional
speakers/actors.
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Page View Tab
On the Page view tab, the regions listed in the Page Composition Segment area of
the DVB Subtitle Data tab are rendered on a blank screen (size 720(H) x 576(W)
pixels). The regions and objects are rendered at their actual locations on the blank
screen. The user can select the Decoder Type and Background Color from the
drop-down lists.

NOTE. Background color is not carried in the broadcast. The user can select
a suitable color.
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